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1 Introduzione

1.1 Scopo della Guida operativa
Lo scopo della presente Guida operativa è la descrizione del sistema VLT® Integrated Servo Drive ISD 510/DSD 510.

La presente Guida operativa contiene informazioni su:

Installazione

Messa in funzione

Programmazione

Funzionamento

Ricerca guasti

Assistenza e manutenzione

La presente Guida operativa è concepita per l'uso da parte di personale qualificato. Leggere l'intera Guida operativa per utilizzare il
servosistema in modo sicuro e professionale, e prestare particolare attenzione alle istruzioni di sicurezza e agli avvisi generali.

La presente Guida operativa è parte integrante del servosistema e contiene anche importanti informazioni di manutenzione. Per-
tanto, tenerla sempre a disposizione insieme al servosistema.

La conformità alle informazioni contenute nel manuale è un prerequisito essenziale per:

Funzionamento senza problemi

Riconoscimento delle responsabilità per danni causati dal prodotto

Pertanto, leggere questa Guida operativa prima di lavorare con il sistema VLT® Integrated Servo Drive ISD 510/DSD 510.

1.2 Risorse aggiuntive

Tabella 1: Risorse aggiuntive

Manuale Descrizione

VLT® Integrated Servo Drive Sistema ISD 510, DSD 510
Manuale di funzionamento

Informazioni sull'installazione, la messa in funzione e il funzionamento
del servosistema ISD 510/DSD 510.

Guida alla Progettazione VLT® Servo Drive System
ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô )

Informazioni sulla configurazione del servosistema ISD 510/DSD 510 e
dati tecnici dettagliati.

Guida alla programmazione VLT® Servo Drive System
ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô )

Informazioni sulla programmazione dei servosistemi ISD 510, DSD 510
e MSD 510.

1.3 Copyright
VLTÆ e ISDÆ sono marchi registrati Danfoss.

1.4 Omologazioni e certificazioni
I VLT® Servo Drive System ISD 510, DSD 510, MSD 510 sono conformi alle norme e alle direttive illustrate nel dettaglio in Tabella 2.

Tabella 2: Omologazioni e certificazioni di prodotto e sistema

Certificazione Descrizione

IEC/EN 61800-3 Sistemi motorizzati a velocità regolabile.

Parte 3: Norma di prodotto relativa alla compatibilità elettromagnetica e ai metodi di prova specifici.

IEC/EN 61800-5-1 Sistemi motorizzati a velocità regolabile.

Parte 5-1: Prescrizioni di sicurezza - Sicurezza elettrica, termica ed energetica.

IEC/EN 61800-5-2 Sistemi motorizzati a velocità regolabile.

Parte 5-2: Prescrizioni di sicurezza - Sicurezza funzionale.

IEC/EN 61508-1 Sicurezza funzionale dei sistemi di sicurezza elettrici/elettronici/elettronici programmabili.
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Certificazione Descrizione

Parte 1: Regole generali.

IEC/EN 61508-2 Sicurezza funzionale dei sistemi di sicurezza elettrici/elettronici/elettronici programmabili.

Parte 2: Requisiti per sistemi elettrici/elettronici/elettronici programmabili di sicurezza.

EN ISO 13849-1 Sicurezza del macchinario - Parti dei sistemi di comando legate alla sicurezza.

Parte 1: Principi generali per la progettazione.

EN ISO 13849-2 Sicurezza del macchinario - Parti dei sistemi di comando legate alla sicurezza.

Parte 2: Validazione.

IEC/EN 60204-1 Sicurezza del macchinario - Equipaggiamento elettrico delle macchine.

Parte 1: Regole generali.

IEC/EN 62061 Sicurezza del macchinario - Sicurezza funzionale dei sistemi di comando elettrici, elettronici ed elettronici
programmabili correlati alla sicurezza.

IEC/EN 61326-3-1 Apparecchi elettrici di misura, controllo e laboratorio - Prescrizioni di compatibilità elettromagnetica.

Parte 3-1: Prescrizioni di immunità per sistemi di sicurezza e per apparecchiature destinate a eseguire fun-
zioni di sicurezza (sicurezza funzionale) - Applicazioni industriali generali.

IEC/EN 60529 Gradi di protezione dei contenitori (Codice IP).

UL 508C Standard UL per la sicurezza delle apparecchiature di conversione di potenza.

(Si applica soltanto ai servoazionamenti ISD 510 taglia 1 e 2).

UL 61800-5-1 Sistemi motorizzati a velocità regolabile.

Parte 5-1: Prescrizioni di sicurezza - Sicurezza elettrica, termica ed energetica.

Servoazionamenti ISD 510 taglia 3 e 4 e DSD 510:

MSD 510:

CSA C22.2 N.
274-13 (2013)

Standard che specifica i requisiti per i convertitori di frequenza a velocità regolabile in materia di sicurezza
elettrica, termica ed energetica.

Si applica a ISD 510 taglia 1 e 2.

CSA C22.2 N.
274-17 (2017)

Standard che specifica i requisiti per i convertitori di frequenza a velocità regolabile in materia di sicurezza
elettrica, termica ed energetica.

Si applica a:

ISD 510 taglia 3 e 4

DSD 510

MSD 510

CE
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Certificazione Descrizione

2014/30/UE Direttiva sulla compatibilità elettromagnetica (EMC).

2014/35/UE Direttiva bassa tensione (LVD).

(2011/65/UE)
modificato (UE)
2015/863

Restrizione sull'uso di sostanze pericolose (RoHS).

2006/42/CE Direttiva macchine (MD).

EtherCATÆ Ethernet per la tecnologia di automazione di controllo. Sistema di bus di campo basato su Ethernet.

Ethernet POWER-
LINKÆ

Sistema di bus di campo basato su Ethernet.

PROFINET RT/IRTÆ Sistema di bus di campo basato su Ethernet.

PLCopenÆ Specifiche tecniche. Blocchi funzioni per il controllo del movimento (ex Parte 1 e Parte 2) versione 2.0 17
marzo 2011.

1.5 Aggiornamenti firmware
Possono essere disponibili aggiornamenti per il firmware, il software VLTÆ Servo Toolbox e le librerie PLC. Quando gli aggiornamenti
sono disponibili, è possibile scaricarli dal sito web Danfoss (http://drives.danfoss.com). Utilizzare il software VLTÆ Servo Toolbox e le
librerie PLC per installare il firmware sui servoazionamenti o sul PSM 510 e sul DAM 510.

1.6 Terminologia

Tabella 3: Terminologia

Termine Descrizione

ACM 510 Modulo di condensatori ausiliari

DAM 510 Modulo di accesso decentralizzato che collega i servoazionamenti decentralizzati Danfoss (ISD 510
e DSD 510) al servosistema tramite un cavo ibrido.

DSD 510 Servoazionamento decentralizzato

Componenti del sistema
DSD 510

Include i servoazionamenti DSD 510, PSM 510, DAM 510 e gli ACM 510 ed EXM 510 opzionali.

EXM 510 Modulo di espansione per la suddivisione di moduli di sistema tra due armadi di controllo.

Cavo di alimentazione Cavo ibrido per il collegamento dal DAM 510 al primo servoazionamento.

ISD 510 Integrated Servo Drive (Servoazionamento integrato)

Componenti del sistema
ISD 510

Include i servoazionamenti ISD 510, PSM 510, DAM 510 e gli ACM 510 ed EXM 510 opzionali.

LCP Pannello di controllo locale

Cavo di loop Cavo ibrido per il collegamento dei servoazionamenti in daisy-chain.

PLC Controllore logico programmabile (dispositivo esterno per il controllo del servosistema).

PSM 510 Modulo di alimentazione che genera un'alimentazione da 565–680 V CC.
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Termine Descrizione

Moduli di sistema Include il PSM 510, il DAM 510 e l'ACM 510 opzionale.

VIN PSM Ingresso del PSM 510 (V CA).

VOUT PSM Uscita del PSM 510 (V CC).
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2 Sicurezza

2.1 Simboli di sicurezza
Nella presente guida vengono usati i seguenti simboli:

A V V I S O
Indica una situazione potenzialmente rischiosa che potrebbe causare morte o lesioni gravi.

A T T E N Z I O N E
Indica una situazione potenzialmente rischiosa che potrebbe causare lesioni leggere o moderate. Può anche essere usato per

mettere in guardia da pratiche non sicure.

N O T A
Indica informazioni importanti, incluse situazioni che possono causare danni alle apparecchiature o alla proprietà.

2.2 Importanti avvisi di sicurezza
Le seguenti istruzioni e precauzioni di sicurezza si riferiscono al servosistema ISD 510/DSD 510. Leggere attentamente le istruzioni di
sicurezza prima di iniziare a lavorare con il servosistema o i suoi componenti. Prestare particolare attenzione alle istruzioni di sicur-
ezza nelle relative sezioni del presente manuale.

A V V I S O
SITUAZIONE PERICOLOSA

Se i componenti del sistema ISD 510/DSD 510 o le linee bus non sono collegati correttamente sussiste il rischio di morte, lesioni

gravi o danni all'unità.

Attenersi sempre alle istruzioni contenute nel presente manuale e alle norme di sicurezza nazionali e locali.

A V V I S O
ALTA TENSIONE

Il servosistema contiene componenti che funzionano ad alta tensione quando sono collegati alla rete di alimentazione elettrica.

Sui componenti non sono presenti indicatori che indicano la presenza di alimentazione di rete. Un'installazione, una messa in

funzione o una manutenzione non corrette possono causare morte o gravi lesioni.

L'installazione, la messa in funzione e la manutenzione devono essere eseguite esclusivamente da personale qualificato.

A V V I S O
PERICOLO DI CORRENTI DI DISPERSIONE/MESSA A TERRA

Le correnti di dispersione/messa a terra sono superiori a 3,5 mA. Una messa a terra non appropriata dei servoazionamenti e dei

moduli di sistema ISD 510/DSD 510 può causare morte o lesioni gravi.

Per motivi di sicurezza dell'operatore, utilizzare un installatore elettrico certificato per la corretta messa a terra dell'impianto
in conformità alle norme e direttive elettriche locali e nazionali applicabili e alle istruzioni contenute nel presente manuale.
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A V V I S O
TEMPO DI SCARICA

Il servosistema contiene condensatori del collegamento CC che rimangono carichi per un determinato lasso di tempo dopo che

l'alimentazione di rete è stata disinserita dal modulo di alimentazione (PSM 510). Il mancato rispetto del tempo di attesa indicato

dopo aver disinserito l'alimentazione prima di effettuare lavori di manutenzione o riparazione potrebbe causare lesioni gravi o

mortali.

Per evitare scosse elettriche, scollegare completamente il modulo di alimentazione (PSM 510) dalla rete elettrica e attendere
che i condensatori si scarichino completamente prima di eseguire qualsiasi lavoro di manutenzione o di riparazione sul ser-
vosistema o sui relativi componenti.

Tempo di attesa minimo (minuti)

15

P E R I C O L O

Rischio di scossa elettrica. Può essere presente una tensione pericolosa fino a 15 minuti dopo il disinserimento dell'alimenta-
zione elettrica.

A V V I S O
AVVIO INVOLONTARIO

Il servosistema contiene servoazionamenti, il PSM 510 e il DAM 510, che sono collegati alla rete di alimentazione elettrica e posso-

no iniziare a funzionare in qualsiasi momento per via di un comando del bus di campo, di un segnale di riferimento o dell'elimina-

zione di una condizione di guasto. I servoazionamenti e tutti i dispositivi collegati devono essere in buone condizioni di funziona-

mento, poiché quando l'unità è collegata alla rete di alimentazione elettrica condizioni di funzionamento carenti possono cau-

sare morte, lesioni gravi, danni alle apparecchiature o altri danni materiali.

Adottare misure adeguate per evitare avvii involontari.

A V V I S O
MOVIMENTO INVOLONTARIO

Un movimento involontario può verificarsi quando le modifiche dei parametri vengono effettuate subito, con conseguente ri-

schio di morte, lesioni gravi o danni all'apparecchiatura.

Quando si modificano i parametri, adottare misure adeguate per garantire che movimenti involontari non comportino alcun
pericolo.

A T T E N Z I O N E
PERICOLO DI USTIONI

La superficie dei servoazionamenti può raggiungere temperature superiori a 90 ˚C durante il funzionamento.

Non toccare i servoazionamenti finché non si sono raffreddati.

N O T A
COMPATIBILITÀ RCD

Il servosistema contiene componenti che possono determinare una corrente CC nel conduttore di terra di protezione, che può

provocare il malfunzionamento di qualsiasi dispositivo collegato al sistema.

Se viene usato un dispositivo di protezione a corrente residua (RCD) o di monitoraggio (RCM) per la protezione in caso di
contatto diretto o indiretto, usare un dispositivo RCD o RCM di tipo B sul lato di alimentazione dei componenti del sistema.
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N O T A
COLLEGAMENTO/SCOLLEGAMENTO DEI CAVI IBRIDI

Non collegare/scollegare mai il cavo ibrido ai/dai servoazionamenti quando il servosistema è collegato alla rete o all'alimenta-

zione ausiliaria oppure quando è ancora presente tensione. In caso contrario, sussiste il rischio di danneggiare il circuito elettroni-

co. Prima di scollegare o collegare i cavi ibridi dal/al PSM 510, assicurarsi che l'alimentazione di rete sia scollegata e che sia tras-

corso il tempo di scarica necessario per i condensatori del collegamento CC.

Per evitare scosse elettriche, scollegare completamente il PSM 510 dalla rete elettrica e attendere che trascorra il tempo di
scarica prima di scollegare o collegare i cavi ibridi o di scollegare i cavi dal PSM 510.

2.3 Istruzioni e precauzioni di sicurezza
Rispettare sempre le istruzioni e le precauzioni di sicurezza.

Un trasporto, uno stoccaggio, un montaggio e un'installazione ordinati e corretti, nonché un funzionamento e una manuten-
zione accurati sono essenziali per il funzionamento sicuro e senza problemi del servosistema e dei relativi componenti.

Unicamente il personale adeguatamente formato e qualificato può lavorare sul servosistema e i relativi componenti oppure in
prossimità di esso.

Utilizzare esclusivamente accessori e parti di ricambio approvati da Danfoss.

Rispettare le condizioni ambientali specificate.

Le informazioni contenute nel presente manuale sull'uso dei componenti disponibili sono fornite esclusivamente mediante
esempi applicativi e suggerimenti.

Il tecnico dell'impianto o l'ingegnere di sistema sono personalmente responsabili della verifica dell'idoneità dei componenti for-
niti e delle informazioni riportate nel presente manuale per la specifica applicazione interessata:

Per la conformità alle norme e agli standard di sicurezza rilevanti per l'applicazione specifica.

Per l'attuazione delle misure, delle modifiche e delle estensioni necessarie.

La messa in funzione del servosistema o dei suoi componenti non è consentita fino a quando non è stato accertato che la mac-
china, il sistema o l'impianto in cui sono installati sono conformi alle disposizioni di legge, alle norme di sicurezza e agli standard
previsti per l'applicazione nel paese di utilizzo.

Il funzionamento è consentito solamente in conformità alle norme nazionali EMC per l'applicazione in questione.

Il rispetto dei valori limite specificati dalle normative nazionali è responsabilità del produttore dell'impianto, del sistema o della
macchina.

È obbligatorio rispettare le specifiche, le condizioni di collegamento e le condizioni di installazione contenute nel presente
manuale.

È necessario rispettare le norme e le disposizioni di sicurezza del paese in cui viene utilizzata l'apparecchiatura.

Per proteggere l'utente dalle scosse elettriche e il servosistema dal sovraccarico è obbligatoria la messa a terra di protezione,
che deve essere eseguita in conformità alle normative locali e nazionali.

2.3.1 Sicurezza operativa
Sicurezza operativa

Le applicazioni correlate alla sicurezza sono consentite solamente se sono esplicitamente e inequivocabilmente menzionate nel
presente manuale.

Tutte le applicazioni che possono comportare pericoli per le persone o danni alle cose sono applicazioni correlate alla sicurezza.

Le funzioni di arresto implementate nel software del PLC non disinseriscono l'alimentazione di rete del modulo di alimentazione
(PSM 510). Pertanto, non devono essere utilizzate per la sicurezza elettrica del servosistema.

Il servosistema può essere arrestato con un comando software o con un setpoint a velocità zero; tuttavia, la tensione CC è an-
cora presente sui servoazionamenti e la tensione di rete è ancora presente nel modulo PSM 510. Inoltre, quando arrestato il
sistema viene può ripartire da solo se il circuito è difettoso o dopo l'eliminazione di un sovraccarico temporaneo oppure di un
problema relativo alla tensione di alimentazione o al sistema. Se ai fini della sicurezza personale (ad esempio per il rischio di
lesioni personali causate dal contatto con parti della macchina in movimento in seguito a un avvio involontario) risulta neces-
sario garantire che non avvenga alcun avvio involontario, tali funzioni di arresto non sono sufficienti. In questo caso, assicurarsi
che il servosistema sia staccato dalla rete elettrica ed evitare un avviamento involontario del motore, ad esempio utilizzando la
funzione Safe Torque Off.
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Il servosistema può iniziare a funzionare involontariamente durante la configurazione dei parametri o la programmazione. Se
questo comporta un rischio per la sicurezza personale (ad esempio, rischio di lesioni personali a causa del contatto con parti
della macchina in movimento), impedire l'avviamento involontario del motore, ad esempio utilizzando la funzione Safe Torque
Off o scollegando in modo sicuro i servoazionamenti.

Oltre agli ingressi di tensione di alimentazione L1, L2 ed L3 del PSM 510, il servosistema dispone di altri ingressi per la tensione
di alimentazione, come la tensione ausiliaria esterna. Prima di iniziare i lavori di riparazione, verificare che tutti gli ingressi della
tensione di alimentazione siano stati disattivati e che sia trascorso il tempo di scarica necessario per i condensatori del collega-
mento CC.

2.4 Personale qualificato
L'installazione, la messa in funzione e la manutenzione devono essere eseguite esclusivamente da personale qualificato. Ai fini del
presente manuale e delle istruzioni di sicurezza in esso contenute, con personale qualificato si intende personale formato che è
autorizzato a montare, installare, mettere in funzione, mettere a terra ed etichettare apparecchiature, sistemi e circuiti in conformità
alle norme per la tecnologia della sicurezza e che ha familiarità con i sistemi di sicurezza dell'ingegneria dell'automazione.

Inoltre, il personale deve avere dimestichezza con tutte le istruzioni e le misure di sicurezza descritte in questo manuale. Deve dis-
porre di apparecchiature di sicurezza adeguate e deve essere formato sul primo soccorso.

2.5 Debita cura
L'operatore e/o il costruttore devono garantire che:

Il servosistema e i suoi componenti siano usati solamente come previsto.

I componenti vengano fatti funzionare soltanto in condizioni di funzionamento perfette.

Il manuale di funzionamento sia sempre disponibile nelle vicinanze del servosistema, in forma completa e leggibile.

Il servosistema venga montato, installato, messo in funzione e manutenuto esclusivamente da personale adeguatamente quali-
ficato e autorizzato.

Il personale interessato riceva regolarmente istruzioni su tutte le questioni rilevanti in termini di sicurezza sul lavoro e prote-
zione ambientale, sui contenuti del manuale di funzionamento e sulle istruzioni.

I simboli di identificazione e del prodotto applicati ai componenti, le istruzioni di sicurezza e gli avvisi non siano rimossi e siano
sempre chiaramente leggibili.

Vengano rispettate le norme nazionali e internazionali sul controllo dei macchinari e delle apparecchiature in vigore nel luogo
d'uso del servosistema.

Gli utenti dispongano sempre di tutte le informazioni più aggiornate relative ai rispettivi interessi sul servosistema e sul suo uso
e funzionamento.

2.6 Uso previsto
I componenti del servosistema sono destinati all'installazione in macchine utilizzate in ambienti industriali in conformità alle leggi e
agli standard locali.

N O T A

In ambiente domestico questo prodotto può provocare disturbi radio; in tal caso, possono essere necessarie misure corret-
tive supplementari.

Per garantire che il prodotto venga utilizzato come previsto, prima dell'uso devono essere soddisfatte le seguenti condizioni:

Tutti coloro che utilizzano i prodotti Danfoss in qualsiasi modo devono leggere e comprendere le corrispondenti norme di sicur-
ezza e la descrizione dell'uso previsto.

Non modificare lo stato originale dell'hardware.

Non invertire i prodotti software né modificarne il codice sorgente.

Non installare né far funzionare prodotti danneggiati o guasti.

Assicurarsi che i prodotti siano installati in conformità alle normative menzionate nella documentazione.

Osservare gli intervalli di manutenzione e di assistenza specificati.

Rispettare tutte le misure di protezione.

Montare o installare solamente i componenti descritti nella presente Guida operativa. I dispositivi e le apparecchiature di terzi
possono essere utilizzati soltanto previa consultazione di Danfoss
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2.6.1 Aree di applicazione vietate
Il servosistema non può essere usato nelle seguenti aree di applicazione:

Aree con atmosfere potenzialmente esplosive.

Sistemi mobili o portatili.

Sistemi galleggianti o trasportati dall'aria.

Strutture abitate.

Siti in cui sono presenti materiali radioattivi.

Aree con variazioni di temperatura estreme o in cui possono essere superate le temperature massime nominali.

Sott'acqua.

2.7 Uso improprio prevedibile
Qualsiasi utilizzo non esplicitamente approvato da Danfoss costituisce uso improprio. Ciò vale anche per l'inosservanza delle condi-
zioni di esercizio e delle applicazioni specificate. Danfoss declina ogni responsabilità per danni di qualunque natura imputabili
all'uso improprio.

2.8 Manutenzione e supporto
Contattare il rappresentante dell'assistenza locale per ricevere manutenzione e supporto.
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3 Descrizione del sistema

3.1 Panoramica del sistema ISD 510/DSD 510

AC 400–480 V . . .

ISD 510

UDC + Real-Time Ethernet Bus + STO + UAUX

UDC + Real-Time Ethernet Bus + STO + UAUX

DSD 510

. . .

Status

Hand
On

Off ResetAuto
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Real-Time Ethernet Bus + STO

Illustrazione 1: Panoramica del sistema VLT® Integrated Servo Drive ISD 510/DSD 510.

1 Induttanza della linea CA

Il VLTÆ Servo Drive System ISD 510/DSD 510 è una soluzione di servoazionamenti decentralizzati ad alte prestazioni. In questo siste-
ma decentralizzato, i servoazionamenti ISD 510/DSD 510 vengono azionati in un gruppo CC e controllati da un PLC. La decentraliz-
zazione del convertitore di frequenza offre vantaggi a livello di montaggio, installazione e funzionamento.

I cavi ibridi sono utilizzati per collegare i servoazionamenti ISD 510/DSD 510, rendendo l'installazione rapida e semplice. Questi cavi
ibridi contengono l'alimentazione del collegamento CC, l'Ethernet in tempo reale, UAUX e i segnali STO.

Il sistema ISD 510/DSD 510 è progettato per alloggiare vari servoazionamenti ed è composto da:

VLTÆ Integrated Servo Drive ISDÆ 510.

VLTÆ Decentral Servo Drive DSD 510.

Un'alimentazione elettrica centrale: modulo di alimentazione (PSM 510).

Modulo di accesso decentralizzato (DAM 510).

Modulo di condensatori ausiliari (ACM 510), in opzione.

Modulo di espansione (EXM 510), in opzione.

Infrastruttura di cablaggio.
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Condensatori ciechi

Software

Firmware del servoazionamento

Firmware per PSM 510, DAM 510 e ACM 510

Tool software per PC: VLTÆ Servo Toolbox

Librerie PLC

Libreria dei movimenti Danfossper il sistema ISD 510/DSD 510 per AutomationStudioô .

Libreria dei movimenti Danfossper il sistema ISD 510/DSD 510 per TwinCATÆ 2 e 3.

Libreria dei movimenti Danfossper il sistema ISD 510/DSD 510 per SIMOTION SCOUTÆ e TiA Portal.

I moduli di sistema PSM 510, DAM 510 e ACM 510 sono montati su una piastra posteriore situata nell'armadio di controllo. Il collega-
mento CC e l'alimentazione della tensione di controllo sono integrati nella piastra posteriore. Il sistema di piastra posteriore "click
and lock" consente un montaggio e un'installazione facili.

I servoazionamenti ISD 510 sono convertitori di frequenza autonomi distribuiti, in cui l'elettronica è integrata con il motore nello
stesso involucro. I servoazionamenti DSD 510 sono soluzioni decentralizzate da montare vicino al servomotore.

Esistono due versioni del servoazionamento ISD 510/DSD 510:

Versione ISD 510/DSD 510

Standard Con due connettori ibridi (M23) che collegano i segnali di alimentazione e di comunicazione da un cavo ibrido.

Avanzato Come la versione standard con in più tre interfacce aggiuntive per I/O ed encoder esterni, dispositivi bus di campo e
per il pannello di controllo locale (LCP) da collegare direttamente.

Con la funzionalità Controllo del movimento integrata nel servoazionamento le sequenze di movimento si verificano in maniera
indipendente. In questo modo si riduce la potenza di calcolo del PLC centrale richiesta e si ottiene un sistema estremamente flessi-
bile per il convertitore di frequenza. Danfoss offre librerie per vari PLC programmabili IEC 61131-3. Grazie alle interfacce bus di cam-
po standardizzate e certificate dei dispositivi è possibile utilizzare qualsiasi PLC con funzionalità masterÆ EtherCAT o funzionalità di
gestione dei nodi Ethernet POWERLINKÆ o PROFINETÆ secondo gli standard.

N O T A

I servoazionamenti ISD 510/DSD 510 non possono essere utilizzati in servosistemi di altri produttori senza modificare l'infras-
truttura di cablaggio.

I convertitori di frequenza di altri produttori non possono essere usati nel sistema ISD 510/DSD 510 quando si usano cavi
ibridi Danfoss.

I servoazionamenti ISD 510 di taglia 1 e 2 non possono essere combinati sulla stessa linea con servoazionamenti ISD 510 e
servoazionamenti DSD 510 di taglia 3 e 4.

Possono essere montati o installati solo i componenti descritti nel presente manuale. I dispositivi e le apparecchiature di terzi
possono essere utilizzati soltanto previa consultazione di Danfoss

Contattare Danfoss per ulteriori informazioni.

3.1.1 Esempi applicativi
Esistono numerose potenziali aree di applicazione per il servosistema come nei seguenti esempi.

Macchine per il settore beverage

Etichettatrici

Tappatrici

Riempitrici

Stampaggio a soffiatura di PET

Stampaggio di bottiglie digitale

Macchine confezionatrici per il settore del Food and Beverage
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Avvolgitrici

Saldatrici automatiche per la produzione di sacchetti

Sigillatrici vaschette

Pellicolatrici

Macchine confezionatrici per il settore farmaceutico e industriale:

Pallettizzazione

Coperchiatrici

Incartonatrici

Riempitrici di tubetti

Confezionatrici di blister

Dosatrici di liquidi

Dosatrici di solidi

3.2 VLT® Integrated Servo Drive ISD 510

3.2.1 Panoramica del servoazionamento ISD 510
ISD è l'abbreviazione inglese di servoazionamento integrato, che è un convertitore di frequenza compatto con motore sincrono a
magneti permanenti integrato (PMSM). Ciò significa che l'intero sistema motorizzato composto da motore, sensore di posizione,
freno meccanico ed elettronica di potenza e di controllo è integrato in un alloggiamento. Nell'elettronica del servoazionamento
sono presenti circuiti aggiuntivi, come l'alimentazione a bassa tensione, i driver del bus e la sicurezza funzionale. Tutti i servoaziona-
menti ISD 510 hanno due connettori ibridi (M23) che collegano i segnali di alimentazione e di comunicazione da un cavo ibrido. La
versione avanzata dispone di tre interfacce aggiuntive per encoder o I/O esterni, dispositivi bus di campo e pannello di controllo
locale (LCP) da collegare direttamente.

I LED sulla parte superiore del servoazionamento ISD 510 mostrano lo stato corrente. Il trasferimento dei dati avviene tramite Ether-
net in tempo reale.

1

2

e
3
0
b
e
3
8
5
.1

0

1 LED di funzionamento

2 Connettori
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3.2.2 Dimensioni del motore e della flangia

Tabella 4: Dimensioni del motore e della flangia

Taglia 1,
1,5 Nm

Taglia 2,
2,1 Nm

Taglia 2,
2,9 Nm

Taglia 2,
3,8 Nm

Taglia 3,
5,2 Nm

Taglia 3,
6,0 Nm

Taglia 4,
11,2 Nm

Taglia 4,
13,0 Nm(1)

Dimen-
sione flan-
gia

76 mm 84 mm 110 mm 138 mm –

1 In fase di rilascio

3.2.3 Tipi di servoazionamenti ISD 510

N O T A

Il Configuratore del convertitore di frequenza mostra la configurazione valida delle varianti di servoazionamenti. Vengono
mostrate unicamente le combinazioni valide. Pertanto, non tutte le varianti descritte nel codice tipo sono visibili.

Tabella 5: Codice ISD 510 tipo

1–3 4–6 7 8 9–12 13–14 15–17 18–20 21–22 23–25 26 27–30 31–32 33–35 36 37 38 39–40

ISD 510 T D6 T SX

Tabella 6: Legenda per codice tipo

[01–03] Gruppo prodotti [18–20] Retroazione del converti-
tore di frequenza

[33–35] Velocità del motore

ISD VLTÆ Integrated Servo Drive FRX Resolver N46 Velocità nominale 4600 giri/
min.

[04–06] Variante prodotto FS1 Retroazione monogiro 17
bit

N40 Velocità nominale 4000 giri/
min.

510 ISDÆ 510 FM1 Retroazione multigiro 17
bit

N30 Velocità nominale 3000 giri/
min.

[07] Configurazione hardware [21–22] Sistema bus N29 Velocità nominale 2900 giri/
min.

A Avanzato PL Ethernet POWERLINKÆ N24 Velocità nominale 2400 giri/
min.

S Standard EC EtherCATÆ N20 Velocità nominale 2000 giri/
min.

[08] Coppia del convertitore di
frequenza

PN PROFINETÆ [36] Freno meccanico

T Coppia [23–25] Firmware X Senza freno

[09–12] Coppia SXX Standard B Con freno

01C5 1,5 Nm SC0 Personalizzato [37] Albero motore

02C1 2,1 Nm [26] Sicurezza S Albero liscio standard

02C9 2,9 Nm T Safe Torque Off (STO) K Chiavetta standard

03C8 3,8 Nm [27–30] Dimensione flangia [38] Tenuta motore
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05C2 5,2 Nm F076 76 mm X Senza tenuta

06C0 6,0 Nm F084 84 mm S Con tenuta

11C2 11,2 Nm F108 108 mm [39–40] Rivestimento superficiale

13C0 13,0 Nm(1) F138 138 mm SX Standard

[13–14] Tensione CC [31–32] Tipo di flangia CX Personalizzato

D6 Tensione del collegamento
CC 600 V

SX Standard

[15–17] Contenitore del converti-
tore di frequenza

C0 Personalizzato

E54 IP54

E67 IP67 (albero IP65)

1 In fase di rilascio

3.2.4 Componenti del motore

3.2.4.1 Albero
L'albero trasferisce la forza del motore (coppia) alla macchina accoppiata all'albero. Il materiale dell'albero è C45+C o equivalente
secondo la norma EN 10277-2. A seconda della posizione di montaggio, i servoazionamenti ISD 510 possono essere sigillati da una
tenuta dell'albero (opzionale) per ottenere un grado di protezione IP65 sul lato A del motore (per maggiori informazioni vedere
11.11.1 Gradi di protezione per servoazionamento ISD 510).

3.2.4.2 Freno (opzionale)
Il freno di stazionamento meccanico opzionale è un freno a disco singolo. La funzione di arresto di emergenza può essere avviata al
massimo una volta ogni tre minuti e fino a 2000 volte in totale, a seconda del carico.

La coppia di mantenimento effettiva è:

Taglia 1: 2,5 Nm

Taglia 2: 5,3 Nm

Taglia 3: 14,5 Nm

Taglia 4: 25 Nm

Si tratta di un freno di stazionamento che funziona secondo il principio fail-safe chiuso quando non c'è corrente. È alimentato
dall'alimentazione ausiliaria a 24 V CC. In questo modo è possibile mantenere il carico a basso gioco quando non è presente cor-
rente.

Dati elettrici: consumo di potenza

Taglia 1: 1,5 W

Taglia 2: 1,8 W

Taglia 3: 3,5 W

Taglia 4: 5 W

N O T A

Non utilizzare impropriamente il freno di stazionamento come freno di esercizio, perché ciò provoca maggiore usura con
conseguente guasto precoce.

L'utilizzo dei servoazionamenti ISD 510 con i freni può ridurre il numero di convertitori di frequenza consentiti, a seconda
della lunghezza totale di ogni linea ibrida.
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3.2.4.3 Raffreddamento
I servoazionamenti ISD 510 si raffreddano autonomamente. Il raffreddamento (dispersione del calore) avviene principalmente attra-
verso la flangia, con una piccola quantità dispersa dall'alloggiamento.

3.2.4.4 Protezione termica
I sensori termici monitorano la temperatura massima consentita dell'avvolgimento motore e spengono il motore se viene superato
il limite di 150 °C. Sono presenti anche nel convertitore di frequenza per proteggere l'elettronica dalle sovratemperature. Un mes-
saggio di errore viene inviato via Ethernet in tempo reale al PLC di livello superiore e viene visualizzato anche sull'LCP.

3.2.4.5 Dispositivi di retroazione integrati
Il dispositivo di retroazione integrato misura la posizione del rotore. Sono disponibili tre varianti di retroazione:

Resolver

Encoder monogiro 17 bit BiSS-B

Encoder multigiro 17 bit BiSS-B

Dati/Tipo Resolver Encoder monogiro Encoder multigiro

Segnale Sen/cos BiSS-B BiSS-B

Precisione ±10 arcmin ±1,6 arcmin ±1,6 arcmin

Risoluzione 14 bit 17 bit 17 bit

Numero massimo di giri – – 4096 (12 bit)

3.2.5 Componenti del convertitore di frequenza

3.2.5.1 Connettori sui servoazionamenti ISD 510
Questa sezione descrive nel dettaglio tutte le possibili connessioni per i servoazionamenti standard e avanzati.

Sui servoazionamenti ISD 510 sono presenti cinque connettori.

1

2

3
8

4
56

7

e
3

0
b

e
3

8
6

.1
0

Illustrazione 2: Connettori sul servoazionamento ISD 510

Tabella 7: Connettori sul servoazionamento ISD 510

Connettore Descrizione

X1 Connettore M23 per l'ingresso del cavo di alimentazione o di loop ibrido

X2 Connettore M23 per uscita del cavo di loop ibrido o cavo di estensione per bus di campo
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Connettore Descrizione

X3 (solo versione avanzata) Connettore M8 per cavo Ethernet (minimo CAT5, schermato)

X4 (solo versione avanzata) Connettore M12 per I/O e/o cavo encoder (schermato)

X5 (solo versione avanzata) Connettore M8 per cavo LCP (schermato)

N O T A

Informazioni dettagliate su ciascuno dei connettori sono disponibili in 11.8 Connettori sul servoazionamento ISD 510/DSD
510.

3.3 VLT® Decentral Servo Drive DSD 510

3.3.1 Panoramica del servoazionamento DSD 510
DSD è l'abbreviazione di servoazionamento decentralizzato, che è un servoazionamento da montare vicino al servomotore. In ques-
to modo, il servomotore non ha alcun impatto sul servoazionamento DSD 510 dal punto di vista termico.

Il servoazionamento DSD 510 amplia la scelta di un sistema di servoazionamento decentralizzato. Fornisce una potenza nominale
fino a 4,5 kW e può essere utilizzato con un'ampia gamma di servomotori a magneti permanenti e di encoder di retroazione del
motore.

I LED sulla parte superiore del servoazionamento DSD 510 mostrano lo stato corrente. Il trasferimento dei dati avviene tramite
Ethernet in tempo reale.

3.3.2 Tipi di servoazionamenti DSD 510

N O T A

Il Configuratore del convertitore di frequenza mostra la configurazione valida delle varianti di servoazionamenti. Vengono
mostrate unicamente le combinazioni valide. Pertanto, non tutte le varianti descritte nel codice tipo sono visibili.

Tabella 8: Codice tipo DSD 510

1–3 4–6 7 8–12 13–14 15–17 18–20 21–22 23–25 26 27–28 29–30 31–38 39–40

DSD 510 C08A0 D6 E67 SXX T F2 XXXXXXXX

Tabella 9: Legenda per codice tipo

[01–03] Gruppo prodotti [18–20] (contin-
ua)

Retroazione del convertitore di frequenza (con-
tinua)

DSD VLTÆ Decentral Servo Drive FHD HIPERFACE DSL()

[04–06] Variante prodotto [21–22] Sistema bus

510 DSD 510 PL Ethernet POWERLINKÆ

[07] Configurazione hardware EC EtherCATÆ

A Avanzato PN PROFINETÆ

S Standard [23–25] Firmware

[08–12] Corrente nominale SXX Standard

C08A0 8,0 Arms [26] Sicurezza

[13–14] Tensione CC T Safe Torque Off (STO)
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D6 Tensione del collegamento CC 600 V [27–28] Taglia frame

[15–17] Grado di protezione F2 (F2) Taglia frame 2

E67 IP67 [29–30] Collegamento del motore

[18–20] Retroazione del convertitore di frequenza S1 (S1) Versione spina singola lato motore

FXX Senza retroazione/Sensorless() S2 (S2) versione spina doppia lato motore

FRX Resolver [31–38] Riservato

FS1 BiSS retroazione monogiro 17 bit – Riservato

FM1 BiSS retroazione multigiro 17 bit [39–40] Rivestimento superficiale

FE1 EnDat 2.1 SX Standard

FE2 EnDat 2.2 CX Personalizzato

FHF HIPERFACE

In fase di rilascio

3.3.3 Connettori sui servoazionamenti DSD 510
I servoazionamenti DSD 510 hanno gli stessi connettori X1-X5 dei servoazionamenti ISD 510 (vedere 3.2.5.1 Connettori sui servoa-
zionamenti ISD 510). Oltre ai connettori X1-X5 i servoazionamenti DSD 510 hanno due connettori aggiuntivi: X6 e X7.

X6X7

e
3
0
b
g
8
2
9
.1

0

Illustrazione 3: Connettori X6 e X7 sul servoazionamento DSD 510

Tabella 10: Connettori sul servoazionamento DSD 510

Connettore Descrizione

X6 Connettore di potenza motore M23 a 8 poli

X7 Connettore di retroazione del motore M23 a 17 poli

La lunghezza massima del cavo dal DSD 510 al motore è 5 m.

N O T A

I servoazionamenti DSD 510 sono disponibili con versione a spina singola per le specifiche HIPERFACE DSL, EnDat 2.2 e sen-
sorless. Questa spina è destinata a un cavo ibrido che contiene sia il cavo motore sia quello di retroazione.

Tutte le altre specifiche utilizzano la versione a doppia spina con cavi motore e di retroazione separati.
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3.4 Modulo di alimentazione (PSM 510)

3.4.1 Panoramica
PSM è l'abbreviazione di Power Supply Module (Modulo di alimentazione) che fornisce l'alimentazione elettrica al servosistema. Il
PSM 510 fornisce una tensione di alimentazione CC e garantisce un'uscita ad alta densità. Il collegamento CC e la tensione 24/48 V
CC sono distribuiti attraverso il backlink nelle piastre posteriori a tutti i moduli di sistema. Il PSM 510 può essere controllato tramite
bus di campo basato su Ethernet.

I LED sul lato anteriore del PSM 510 mostrano lo stato operativo e gli avvisi.

N O T A

I moduli di sistema sono progettati per l'uso all'interno di un armadio di controllo. Se si utilizza la funzione STO, l'armadio
deve presentare almeno un grado di protezione IP54.

Il PSM 510 possiede un grado di protezione IP20 secondo la norma IEC/EN 60529 (eccetto i connettori, che sono IP00).

Il PSM 510 può essere danneggiato se esposto ai fluidi.

Tutti i cavi di potenza sono collegati al PSM 510; pertanto, è necessario almeno un PSM 510 per ogni sistema.

Il PSM 510 svolge anche funzioni di manutenzione, come la misurazione della tensione, ed è raffreddato da un ventilatore interno.

Il PSM 510 è disponibile in tre taglie di potenza e fornisce una potenza in uscita di 10 kW, 20 kW o 30 kW con una capacità di sovrac-
carico del 200% per tre secondi. Per ottenere un potenza di uscita di fino a 60 kW, è possibile utilizzare due moduli PSM 510 in
parallelo.

Un esempio di codice tipo per il PSM 510 è: MSD510PSM510F2P10C0D6E20PLSXXXXXXXXXXXXX.
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Illustrazione 4: PSM 510
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1 Piastra posteriore

2 Connettore di ingresso da 24/48 V

3 Fissacavo e schermatura

4 Connettori: I/O, STO, relè ed Ethernet

5 LED di funzionamento

6 Connettore LCP

7 Vite PE

8 Connettore di alimentazione di rete CA

9 Connettore per resistore di frenatura interno/ester-
no

3.5 Modulo di accesso decentralizzato (DAM 510)

3.5.1 Panoramica
DAM è l'abbreviazione di Decentral Access Module (Modulo di accesso decentralizzato). Il DAM 510 è un'interfaccia/gateway cen-
trale per il servosistema decentralizzato. Viene utilizzato per collegare il VLTÆ Integrated Servo Drives ISD 510 e il VLTÆ Decentral
Servo Drives DSD 510 di Danfoss ai servosistemi tramite un cavo di alimentazione ibrido.

Il DAM 510 fornisce i servoazionamenti decentralizzati con il collegamento CC, UAUX, STO e bus di campo basato su Ethernet tramite
il cavo di alimentazione ibrido. Il DAM 510 fornisce funzioni come:

Protezione da sovracorrente del cavo ibrido

Protezione da sovratensione

Circuito di ricarica del collegamento CC

Collegamento dell'encoder esterno

Buffer di capacità del collegamento CC per i servoazionamenti decentralizzati

Il DAM 510 può essere controllato tramite bus di campo basato su Ethernet.

I LED sul lato anteriore del DAM 510 mostrano lo stato operativo e gli avvisi.

N O T A

I moduli di sistema sono progettati per l'uso all'interno di un armadio di controllo. Se si utilizza la funzione STO, l'armadio
deve presentare almeno un grado di protezione IP54.

Il DAM 510 possiede un grado di protezione IP20 secondo la norma IEC/EN 60529 (eccetto i connettori, che sono IP00).

Il DAM 510 può essere danneggiato se esposto a fluidi.

Un esempio di codice tipo per il modulo DAM 510 è: MSD510DAM510F1C015AD6E20PLSXXXXXXXXXXXXX.
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Illustrazione 5: DAM 510

1 Connettori: STO, Ethernet ed encoder esterno

2 LED di funzionamento

3 Connettore LCP

4 Vite PE

5 Connettori: UDC, AUX, STO di uscita ed Ethernet

3.6 Modulo di condensatori ausiliari (ACM 510)

3.6.1 Panoramica
ACM è l'abbreviazione di Auxiliary Capacitors Module (Modulo di condensatori ausiliari). L'ACM 510 può essere collegato al sistema
ISD 510 per immagazzinare energia, consentendo un arresto controllato della macchina in situazioni di emergenza.

N O T A

L'ACM 510 possiede un grado di protezione IP20 secondo la norma IEC/EN 60529 (eccetto i connettori, che sono IP00).

L'ACM 510 può essere danneggiato se esposto a fluidi.

Un esempio di codice tipo per il modulo ACM 510 è: MSD510ACM510F1E00C8D6E20PLSXXXXXXXXXXXXX.
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LINK/ACT

DEV

STATUS ACM

Illustrazione 6: ACM 510

1 Connettori: I/O, relè ed Ethernet

2 LED di funzionamento

3 Connettore LCP

4 Vite PE

3.7 Modulo di espansione EXM 510
L'EXM 510 supporta la configurazione modulare della macchina suddividendo i moduli di sistema in due armadi di controllo. La
lunghezza massima del cavo tra i moduli EXM 510 è di 5 m.

Vedere 5.13 Collegamento del modulo di espansione EXM 510 per ulteriori informazioni.
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Illustrazione 7: EXM 510

1 Piastra di schermatura EMC

2 Piastra posteriore

3 Vite PE

4 Connettore di espansione

N O T A

I moduli di sistema sono progettati per l'uso all'interno di un armadio di controllo. Se si utilizza la funzione STO, l'armadio
deve presentare almeno un grado di protezione IP54.

L'EXM 510 ha un grado di protezione IP20 secondo la norma IEC/EN 60529.

L'EXM 510 può essere danneggiato se esposto a fluidi.

Un esempio di codice tipo per l'EXM 510 è:

MSD510EXM510F1C062AD6E20XXXXXXXXXXXXXXXX
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3.8 Pannello di Controllo Locale (LCP)

3.8.1 Panoramica del Pannello di controllo locale
L'LCP è l'interfaccia grafica utente che può essere collegata al PSM 510, al DAM 510 e all'ACM 510 per scopi diagnostici e operativi
utilizzando un cavo opzionale (cavo di estensione da M8 a LCP D-SUB). L'LCP è disponibile in opzione e può anche essere collegato
ai servoazionamenti della versione avanzata utilizzando lo stesso cavo opzionale.

Il display LCP offre all'operatore una rapida visualizzazione dello stato dei servoazionamenti ISD 510/DSD 510, a seconda del dispo-
sitivo a cui è collegato e mostra i parametri e gli allarmi/errori. Inoltre, può essere utilizzato per la messa in funzione e la ricerca
guasti. Infine, può essere impiegato per eseguire semplici funzioni, ad esempio attivare e disattivare le linee di uscita del Modulo di
accesso decentralizzato.

L'LCP può essere montato sul lato anteriore dell'armadio di controllo e poi collegato ai moduli tramite cavi SUB-D.

3.8.2 Layout del Pannello di controllo locale
Il pannello di controllo locale è diviso in quattro gruppi funzionali:

A: Area di visualizzazione

B: Tasti del menu Display

C: Tasti di navigazione e spie luminose (LED)

D: Tasti di funzionamento e ripristino

Per regolare il contrasto del display, premere il tasto [Status] e i tasti [▵]/[▿].

3.8.2.1 A: Area di visualizzazione
I valori nell'area di visualizzazione variano a seconda se l'LCP p collegato a un servoazionamento Danfoss o un modulo di sistema.

L'area di visualizzazione si attiva quando il servoazionamento o il modulo cui è collegato riceve potenza dall'alimentazione di rete,
da un morsetto del bus CC o da UAUX.
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Illustrazione 8: Area di visualizzazione quando è collegato a un servoazionamento ISD 510

1 Coppia effettiva

2 Temperatura del modulo convertitore
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Illustrazione 9: Area di visualizzazione quando è collegato a PSM 510 e DAM 510

1 Tensione di linea UAUX

2 Temperatura scheda di alimentazione

3 UDC effettivo (corrente)

4 Consumo di potenza

5 UDC effettivo (tensione)
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Illustrazione 10: Area di visualizzazione quando è collegato all'ACM 510

1 Temperatura scheda di alimentazione

2 Banco di condensatori di temperatura 1

3 Banco di condensatori di temperatura 2

4 Tensione di linea UAUX

5 UDC effettivo (tensione)

3.8.2.2 B: Tasti del menu Display
I tasti menu sono utilizzati per l'accesso ai menu, per la programmazione parametri, per commutare tra le varie modalità visualizza-
zione dello stato durante il funzionamento normale e per la visualizzazione dei dati del log guasti.

Tabella 11: Tasti del menu Display

Tasto Funzione

6 Status Mostra le informazioni sul funzionamento.

7 Quick Menu Permette di accedere ai parametri.

8 Main Menu Permette di accedere ai parametri.

9 Alarm Log Mostra gli ultimi 10 allarmi.

3.8.2.3 C: Tasti di navigazione e spie luminose (LED)
I tasti di navigazione vengono utilizzati per spostare il cursore dei display e fornire il controllo nel funzionamento in modalità locale.
In quest'area sono presenti anche tre LED di stato.
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Tabella 12: Tasti di navigazione

Tasto Funzione

10 Back Consente di tornare al passaggio o all'elenco precedente nella struttura del menu.

11 Cancel Annulla l'ultima modifica o l'ultimo comando, purché non venga modificata la modalità visualizza-
zione.

12 Info Premere per una definizione della funzione visualizzata.

13 Tasti di naviga-
zione

Usare i quattro tasti di navigazione per spostarsi tra le voci del menu.

14 OK Utilizzare per accedere ai gruppi di parametri o per abilitare una selezione.

Tabella 13: Spie luminose (LED)

LED Colore Funzione

15 Acceso Verde Il LED On (Acceso) si accende quando il servoazionamento o il modulo a cui è collegato ricevono l'ali-
mentazione da UAUX.

16 Warn Giallo Quando sono soddisfatte le condizioni per l'avviso, si accende il LED giallo Warn (Avviso) e sul display
appare il testo che illustra il problema.

17 Alarm Rosso Una condizione di guasto provoca il lampeggiamento in rosso del LED Alarm (Allarme) e la visualizza-
zione di un testo relativo all'allarme.

3.8.2.4 D: Tasti di funzionamento e ripristino
I tasti di funzionamento si trovano nella parte inferiore dell'LCP.

Tabella 14: Tasti di funzionamento e ripristino

Tasto Funzione

18 Hand on Abilita il servoazionamento ISD 510/DSD 510 o il PSM 510 collegati da controllare tramite l'LCP.

È possibile passare dalla modalità Hand On alla modalità Auto On e viceversa soltanto in alcuni stati (per mag-
giori informazioni vedere la Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotionô ).

19 Spento Pone il servoazionamento ISD 510/DSD 510 nello stato Switch on Disabled (Attiva Disabilitato) e il PSM 510 nello
stato Standby (Standby).

Questo funziona solamente in modalità Hand On.

La modalità Off (Spento) consente il passaggio dalla modalità Hand On alla modalità Auto On.

20 Auto On Pone il sistema in modalità di funzionamento remoto.

In modalità Auto On, il dispositivo viene controllato dal bus di campo (PLC). È possibile passare dalla modalità
Auto On alla modalità Hand On e viceversa soltanto quando il convertitore di frequenza si trova nello stato
Switch on Disabled (Attiva Disabilitato) e/o il PSM 510 si trova nello stato Standby.

21 Ripristino Ripristina il servoazionamento ISD 510/DSD 510 o il PSM 510 dopo aver eliminato un guasto.

Il ripristino è possibile soltanto in modalità Hand On.
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3.9 Cavi

3.9.1 Cavo ibrido
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Illustrazione 11: Cavo di loop ibrido

I cavi ibridi preconfigurati vengono utilizzati per collegare i servoazionamenti ISD 510/DSD 510 al modulo di accesso decentralizza-
to (DAM 510).

Esistono due tipi di cavi ibridi, disponibili con connettori M23 sia angolati che diritti:

Cavo di alimentazione per il collegamento del primo servoazionamento ISD 510/DSD 510 di un gruppo al punto di collegamen-
to sul modulo di accesso decentralizzato (DAM 510).

Cavo di loop per il collegamento dei servoazionamenti ISD 510/DSD 510 in daisy-chain nell'applicazione.

Entrambi questi cavi sono forniti da Danfoss e sono disponibili in varie lunghezze. Per maggiori informazioni vedere la Guida alla
Progettazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

Entrambe le estremità del cavo di loop sono dotate di connettori M23.

Il cavo di alimentazione è dotato di un connettore M23 all'estremità di uscita per il collegamento al primo servoazionamento ISD
510/DSD 510. All'estremità d'ingresso presenta un capocorda; i connettori sono montati sui corrispondenti morsetti del modulo di
accesso decentralizzato (DAM 510).

Tabella 15: Cavi ibridi

Tipo di cavo Schermati/Non
schermati

Note

Cavo di alimentazione Schermati Cavo ibrido (schermo totale con bus di campo aggiuntivo e schermo della sezione
di sicurezza).

Cavo di loop

N O T A

I cavi ibridi sono disponibili in due sezioni trasversali: 2,5 mm2 (15 A) e 4 mm2 (25 A per CE e UL, 20 A per CSA).

Per maggiori informazioni vedere la Guida alla Progettazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT®
Flexmotionô ).
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VLT® ISD 510 Hybrid xxxx Cable

Length: xxxx

Ordering no. 175Gxxxx

1 7 5 G 8 9 X X

Specification no. 175Rxxxx Rev. xxx

Signal rating Ethernet: 2 x 2 x AWG24 300V

Production: dd.mm.yyyy

Power rating: 5 x 2.5mm2    1000V 15A
Signal rating: 2 x 0.5mm2     300V 

Illustrazione 12: Esempio di targa per cavo ibrido
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1 Tipo di cavo

2 Codice dell'ordine

3 Revisione delle specifiche

4 Data di produzione

5 Lunghezza

6 Potenza nominale

7 Grado del segnale

8 Grado del segnale per Ethernet

9 Codice a barre

10 Logo del produttore

3.9.1.1 Raggio di piegatura minimo per cavo ibrido
Il numero massimo di cicli di piegatura è di 5 milioni a 7,5 x diametro del cavo (15,6 mm).

Permanentemente flessibile: 12 x diametro del cavo

Permanentemente installato: 5 x diametro del cavo

3.9.2 Cavo motore e di retroazione
Per collegare il servoazionamento DSD 510 a un motore PM vengono utilizzati cavi motore e di retroazione preconfigurati. En-
trambe le estremità del cavo sono dotate di connettori M23.

Questi cavi sono forniti da Danfoss e sono disponibili in lunghezze di 2,5 m e 5 m (per maggiori informazioni vedere la Guida alla
Progettazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô )).

La lunghezza massima tra il DSD 510 e il motore è 5 m.

Sono disponibili diversi tipi di cavi a seconda della variante di retroazione e del motore utilizzato. Consultare le seguenti tabelle per i
dettagli sulle abbreviazioni utilizzate nelle descrizioni.

Tabella 16: Tipi di cavo motore e di retroazione

Numero d'ordine Descrizione

175G8945 Cavo motore DSD M01 CT01 2,5 m O

175G8946 Cavo motore DSD M01 CT01 5,0 m O

175G8947 Cavo di retroazione DSD M01 CT03 RES 2,5 m GN

175G8948 Cavo di retroazione DSD M01 CT03 RES 5,0 m GN

175G8949 Cavo di retroazione DSD M01 CT04 ENC 2,5 m GN

175G8950 Cavo di retroazione DSD M01 CT04 ENC 5,0 m GN

Tabella 17: Tipi di connettore (CT)

Tipo Variante Descrizione

CT0 – M23

CT0 1 Motore standard con HIPERFACE DSL

CT0 2 Riservato

CT0 3 Resolver M23

CT0 4 Encoder M23

Tabella 18: Configurazione motore/cavo

M01 Piedinatura AKM

M02 –
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Tabella 19: Colori del cavo

OR Arancione

GN Verde

3.9.2.1 Raggio di piegatura minimo per cavo motore
Il numero massimo di cicli di piegatura è di 5 milioni a 7,5 x diametro del cavo (14,8 mm).

Permanentemente flessibile: 10 x diametro del cavo

Permanentemente installato: 5 x diametro del cavo

3.9.2.2 Raggio di piegatura minimo per cavo di retroazione
Il numero massimo di cicli di piegatura è di 5 milioni a 7,5 x diametro del cavo (11,7 mm).

Permanentemente flessibile: 7,5 x diametro del cavo

Permanentemente installato: 5 x diametro del cavo

3.9.3 Cavo dell'encoder e/o I/O
Questo cavo collega l'I/O e/o l'encoder al servoazionamento ISD 510/DSD 510 (connettore X4). Il cavo non è incluso con i servoazio-
namenti.

I cavi dell'encoder e/o I/O con connettori M12 possono essere utilizzati per il sistema ISD 510/DSD 510 se sono conformi al fattore di
forma definito nella norma IEC 61076-2-101.

3.9.4 Cavo di estensione bus di campo
Lunghezza dei cavi: 2 m

Lunghezza massima fino alla porta successiva: 100 m

Se questo cavo non viene utilizzato, montare il tappo cieco M23 sul connettore femmina X2 sull'ultimo servoazionamento ISD
510/DSD 510 nell'applicazione.

3.9.5 Cavo LCP
Il cavo LCP collega l'LCP al servoazionamento avanzato ISD 510/DSD 510 e ai moduli di sistema tramite un connettore M8.

È possibile acquistare il cavo LCP presso Danfoss (vedere la Guida alla Progettazione VLT® Servo Drive System ISD 510, DSD 510,
MSD 510 (VLT® Flexmotionô ) per maggiori informazioni sui numeri d'ordine).

3.10 Disposizione e instradamento dei cavi
I servoazionamenti ISD 510/DSD 510 sono interconnessi da cavi di loop ibridi. Un cavo di alimentazione ibrido con connettori a
rilascio rapido consente di fornire la tensione di alimentazione dal modulo di accesso decentralizzato (DAM 510) al primo servoazio-
namento.

Instradamento nelle catene portacavi

Il cavo ibrido è compatibile con le catene portacavi e, quindi, adatto all'impiego in sistemi in movimento. Il numero di cicli di piega-
tura dipende dalle singole condizioni e deve quindi essere determinato in anticipo per ogni applicazione. Per maggiori informazioni
vedere 3.9.1 Cavo ibrido.

3.10.1 Sistema di cablaggio standard per due linee
Questo sistema di cablaggio è per due linee, senza ridondanza per i servoazionamenti ISD 510/DSD 510 in un'applicazione. Per ogni
linea aggiuntiva di servoazionamenti è necessario un DAM 510 supplementare. Per i sistemi di cablaggio con una sola linea è neces-
sario solo un DAM 510.

N O T A

Per il cablaggio senza ridondanza vedere la Guida alla Progettazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotionô ).
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Illustrazione 13: Sistema di cablaggio standard per due linee

1 Cavo di alimentazione M23

2 Cavo di loop M23

3 Induttanza della linea CA

3.11 Software
Il software per il servosistema comprende:

Il firmware del ISD 510/DSD 510 che è già installato sul dispositivo.

Il firmware dei moduli di sistema già installato sui moduli.

Un pacchetto di librerie PLC per Automation Studioô  per il funzionamento dei servoazionamenti ISD 510/DSD 510 e dei moduli
di sistema (per maggiori informazioni vedere 6.10.2 Creazione di progetti Automation Studio™).

Una libreria PLC per TwinCATÆ 2 e 3 per il funzionamento dei servoazionamenti ISD 510/DSD 510 e dei moduli di sistema (per
maggiori informazioni vedere 6.11.2 Creazione di un progetto TwinCAT®).

Una libreria PLC per SIMOTION SCOUTÆ per il funzionamento dei servoazionamenti ISD 510/DSD 510 e dei moduli di sistema
(vedere 6.13.3 Creazione di un progetto SIMOTION SCOUT®).

Una libreria PLC per il Portale TIA per il funzionamento dei servoazionamenti ISD 510/DSD 510 e dei moduli di sistema.

VLTÆ Servo Toolbox: Uno strumento software basato su PC Danfoss per la messa in funzione e il debugging dei dispositivi.

3.12 Bus di campo
Il servosistema presenta un'architettura di sistema aperta realizzata tramite comunicazione veloce basata su Ethernet (100BASE-T). Il
sistema supporta i bus di campo EtherCATÆ, Ethernet POWERLINKÆ e PROFINETÆ. Per maggiori informazioni vedere la Guida alla pro-

grammazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).
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In ambienti produttivi la comunicazione con i dispositivi avviene sempre tramite un PLC che funge da master. I servoazionamenti
ISD 510/DSD 510 e i moduli di sistema possono essere controllati con questi metodi di comunicazione:

Utilizzando le librerie VLTÆ Servo Motion (disponibili per TwinCATÆ, Automation Studioô , SIMOTION SCOUTÆ e TiA Portal).

Utilizzando la funzionalità dell'asse NC di TwinCATÆ (soltanto ISD 510/DSD 510).

Utilizzando lo standard CANopenÆ CiA DS 402 tramite lettura e scrittura su oggetti.

Utilizzando la classe di applicazione 1 (AC1) e 4 (AC4), soltantoÆ PROFINET.

È possibile far funzionare i servoazionamenti ISD 510/DSD 510 e i moduli di sistema con i seguenti tempi di ciclo.

Bus di campo EtherCATÆ ed Ethernet POWERLINKÆ:

400 µs e relativi multipli (per esempio 800 µs e 1200 µs).

500 µs e relativi multipli (per esempio 1 ms).

Bus di campo PROFINETÆ

500 µs e relativi multipli (per esempio 1 ms).

Quando il tempo di ciclo è un multiplo di 400 µs e 500 µs, si utilizza la base temporale di 500 µs.

I servoazionamenti ISD 510/DSD 510 e i moduli di sistema sono certificati per i bus di campo secondo le regole e le normative corris-
pondenti. I servoazionamenti sono conformi al profilo del convertitore di frequenza CANopenÆ CiA DS 402.

3.12.1 EtherCAT®
I servoazionamenti ISD 510/DSD 510 e i moduli di sistema supportano i seguenti protocolli EtherCATÆ:

CANopen over EtherCATÆ (CoE)

File Access over EtherCATÆ (FoE)

Ethernet over EtherCATÆ (EoE)

I servoazionamenti ISD 510/DSD 510 e i moduli di sistema supportano orologi distribuiti. Per compensare il guasto di una sezione
del cavo di comunicazione nel sistema, è disponibile una ridondanza del cavo per tutti i bus di campo. Per maggiori informazioni
vedere la Guida alla Progettazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).
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Illustrazione 14: Assegnazione della porta EtherCATô  per il servoazionamento ISD 510/DSD 510

X1 Passacavo ibrido M23 per il modulo di accesso de-
centralizzato (DAM 510) o il servoazionamento prec-
edente.

X2 Passacavo ibrido M23 per il servoazionamento suc-
cessivo.

X3 Passacavo Ethernet M8 per altri slave EtherCATÆ, ad
esempio encoder EtherCATÆ.

Il connettore è disponibile soltanto sui servoaziona-
menti avanzati.
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Illustrazione 15: Assegnazione della porta EtherCATô  per il modulo di accesso decentralizzato (DAM 510)

X1 Passacavo RJ45 per lo slave precedente.

X2 Cavo di alimentazione ibrido da RJ45 a M23 per il
primo servoazionamento ISD 510/DSD 510.

X3 Passacavo RJ45 per il PLC (ridondanza del cavo) o
slave successivo.
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Illustrazione 16: Assegnazioneô  della porta EtherCAT per il modulo di alimentazione di potenza (PSM 510), il modulo di condensatori ausiliari

(ACM 510) e i servoazionamenti ISD 510/DSD 510

X1 Passacavo RJ45 per il PLC o slave precedente.

X2 Passacavo RJ45 per il PLC (ridondanza del cavo) o slave successivo.

3.12.2 Ethernet POWERLINK®
I servoazionamenti ISD 510/DSD 510 e i moduli di sistema sono certificati secondo DS 301 V1.1.0 e supportano le seguenti caratter-
istiche:

Funge da nodo controllato

Può essere utilizzato come stazione multiplexata

Supporta la comunicazione incrociata

È supportata la ridondanza ad anello per la ridondanza dei media

Non sono assegnate porte specifiche per Ethernet POWERLINKÆ.

3.12.3 PROFINET®
I moduli di servoazionamento ISD 510/DSD 510 e i moduli di sistema supportano PROFINETÆ classe di conformità C secondo le
norme IEC 61158-5-10:2014, IEC 61158-6-10:2014, IEC 61784-2:2014 e IEC 61784-5-3:2013. Tutti i componenti del sistema (servoazio-
namenti e moduli di sistema) fungono da dispositivi I/O nella rete PROFINETÆ.

Sono supportate le seguenti funzioni:

Dispositivo-I/O - Dispositivo controllato da un controllore I/O

Configurazione del modulo dinamico

Classe di carico netto II

Ridondanza ad anello (MRP) come client

I dispositivi del bus di campo PROFINETÆ sono sempre collegati come componenti di rete tramite interruttori integrati nel dispositi-
vo del bus di campo. Sono presenti due porte sui servoazionamenti ISD 510/DSD 510: PSM 510 e ACM 510. Sono presenti tre porte
su DAM 510. Ne possono essere utilizzate solo due per il protocollo IRT (Isocrono in tempo reale), mentre tutte e tre possono essere
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utilizzate per il protocollo RT (Tempo reale). Se si ordina il DAM 510 con IRT, sulla porta X3 OUT verrà montato un coperchio RJ45.
Rimuovere questo coperchio per consentire l'uso della porta X3 OUT necessaria per la commutazione al protocollo RT.

Il sistema di cablaggio per l'utilizzo di più moduli DAM 510 in una singola applicazione è mostrato in Illustrazione 17.
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Illustrazione 17: Sistema di cablaggio per più moduli DAM 510

1 Induttanza della linea CA

2 Cavo del cliente

3 Cavo di estensione bus di campo
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4 Installazione meccanica

4.1 Elementi forniti
Gli elementi forniti per i servosistemi ISD 510/DSD 510 sono:

Servoazionamenti ISD 510/DSD 510

Modulo di alimentazione (PSM 510) comprensivo di connettori

Modulo di accesso decentralizzato (DAM 510) comprensivo di connettori

Modulo condensatori ausiliari (ACM 510), comprensivo di connettori, in opzione

Modulo di espansione (EXM 510), in opzione.

Pannello di Controllo Locale (LCP), in opzione

La presente Guida operativa

Cavo di alimentazione (ibrido)

Cavo di loop (ibrido)

Cavo LCP, in opzione

Cavo di estensione bus di campo, in opzione

Tappi ciechi per connettori M8, M12 e M23

L'unità di imballo dipende dal numero di servoazionamenti forniti. Conservare l'imballo da utilizzare in caso di restituzione del pro-
dotto.

4.2 Trasporto
Utilizzare sempre mezzi di trasporto e mezzi di sollevamento con capacità di carico sufficiente per il trasporto dei componenti
del servosistema.

Evitare vibrazioni durante il trasporto.

Evitare urti e colpi violenti.

4.3 Ispezione alla consegna
Procedura

Dopo aver ricevuto il prodotto, controllare immediatamente se gli elementi forniti corrispondono ai documenti di spedi-
zione. Danfoss non accetta reclami per difetti segnalati successivamente.

In caso di danno da trasporto visibile, presentare immediatamente un reclamo al vettore di consegna.

In caso di difetti visibili o consegna incompleta, presentare immediatamente un reclamo al rappresentante Danfoss respon-
sabile.

4.4 Misure di sicurezza durante l'installazione
Durante l'installazione attenersi sempre alle istruzioni di sicurezza contenute nel presente manuale. Prestare particolare attenzione
a garantire che i seguenti punti siano sempre rispettati:

L'installazione deve essere eseguita esclusivamente da personale qualificato.

L'installazione deve essere eseguita con la dovuta cura e attenzione.

Rispettare tutte le norme di sicurezza e le misure di protezione e tenere in considerazione le condizioni ambientali.

Leggere e comprendere il manuale.

4.5 Ambiente di installazione

4.5.1 Panoramica
L'installazione deve garantire le seguenti condizioni ambientali per consentire un funzionamento sicuro ed efficiente del sistema
ISD 510/DSD 510.

Contattare Danfoss se non è possibile rispettare queste condizioni ambientali.
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4.5.2 Servoazionamento ISD 510/DSD 510
L'intervallo di temperatura ambiente consentito per il funzionamento e i livelli di vibrazione non devono essere superati. (Ve-
dere 11.10.1 Servoazionamento ISD 510/DSD 510.)

L'umidità relativa ammissibile è del 3-93%, senza condensa.

Deve essere disponibile una ventilazione illimitata.

La struttura di montaggio deve essere adatta all'applicazione, ad esempio, sufficientemente rigida e in grado di sopportare tem-
perature superiori a 90 °C.

4.5.3 Moduli di sistema
Le condizioni ambientali per PSM 510, DAM 510 e ACM 510 sono:

L'intervallo di temperatura ambiente consentito per il funzionamento e i livelli di vibrazione non devono essere superati (vedere
11.10.2 Moduli di sistema).

L'umidità relativa ammissibile è del 5-93%, senza condensa.

Lo spazio minimo necessario al di sopra e al di sotto dei moduli di sistema è descritto nel dettaglio in 4.7.3 Requisiti di spazio per
i moduli di sistema.

4.6 Preparativi per l'installazione

4.6.1 Servoazionamento ISD 510/DSD 510
Effettuare i seguenti preparativi per garantire che il servosistema possa essere installato in modo affidabile ed efficace.

Montare sempre gli accoppiamenti e altri componenti di trasferimento in conformità alle norme locali.

Procedura

Prevedere una disposizione di montaggio adatta per l'applicazione Questa dipende dal tipo, dal peso e dalla taglia di po-
tenza dei servoazionamenti ISD 510/DSD 510.

Per i servoazionamenti ISD 510, inserire la flangia del motore a filo con la superficie di montaggio prima di fissare il servoa-
zionamento. Il disallineamento abbrevia la durata dei cuscinetti e dei componenti di accoppiamento e riduce il trasferimen-
to di calore dal servoazionamento.

Per i servoazionamenti DSD 510, inserire il lato inferiore del DSD 510 sulla superficie di montaggio prima di fissare il servoa-
zionamento. Il disallineamento riduce il trasferimento di calore dal servoazionamento.

Garantire la protezione dei contatti secondo le norme locali se durante il funzionamento si prevedono superfici calde.

Collegare a terra il servoazionamento.

4.6.2 Moduli di sistema
Effettuare i seguenti preparativi per garantire che il servosistema possa essere installato in modo affidabile ed efficace.

Montare i moduli di sistema sempre in conformità alle norme locali.

Procedura

Prevedere una disposizione di montaggio adatta per l'applicazione a seconda del tipo e del peso dei moduli.

Per evitare disallineamenti, assicurarsi che le piastre posteriori siano perfettamente livellate.

Per garantire un raffreddamento sufficiente, prestare attenzione ai requisiti minimi di spazio specificati.

Collegare a terra i moduli.
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4.6.3 Schemi di perforazione
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Illustrazione 18: Schemi di perforazione per moduli di sistema da 50 mm e 100 mm

4.7 Procedura di installazione

4.7.1 Requisiti di spazio per il servoazionamento ISD 510
Il servoazionamento ISD 510 ha bisogno di spazio per il cavo ibrido oltre che per le proprie dimensioni.

4.7.1.1 Distanza minima per il connettore dritto M23 su ISD 510 mostra il connettore dritto installato su servoazionamento ISD 510
di taglia 2.

4.7.1.2 Distanza minima per il connettore angolato M23 su ISD 510 mostra il connettore angolato installato su servoazionamento
ISD 510 di taglia 2.

Le illustrazioni mostrano la distanza minima tra il servoazionamento e l'oggetto successivo, oltre al raggio di curvatura minimo con-
sentito (Rmin) per il cavo installato in modo permanente. Per l'installazione del cavo prevedere l'altezza del connettore più ulteriori
30 mm per il cavo.

La distanza minima viene misurata dall'alloggiamento elettronico, in quanto è la stessa per tutte le varianti di motore.

4.7.1.1 Distanza minima per il connettore dritto M23 su ISD 510
La distanza minima per il connettore diritto si calcola come segue:

0,5 x diametro del cavo + altezza del connettore + Rmin = 7,8 mm + 112 mm + 78 mm = 197,8 mm ≈ 200 mm
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Illustrazione 19: Distanza minima per il connettore dritto M23

4.7.1.2 Distanza minima per il connettore angolato M23 su ISD 510
La distanza minima per il connettore angolato si calcola come segue:

0,5 x diametro del cavo + lunghezza del connettore misurata nell'alloggiamento elettrico + Rmin = 7,8 mm + 51,4 mm + 78 mm =
137,8 mm ≈ 140 mm
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Illustrazione 20: Distanza minima per il connettore angolato M23

4.7.2 Requisiti di spazio per il servoazionamento DSD 510
Il servoazionamento DSD 510 ha bisogno di spazio per il cavo ibrido oltre che per le proprie dimensioni.

4.7.2.1 Distanza minima per il connettore dritto M23 su DSD 510 mostra il connettore dritto installato su un servoazionamento DSD
510.

4.7.2.2 Distanza minima per il connettore angolato M23 su DSD 510 mostra il connettore angolato installato su un servoazionamen-
to DSD 510.

Le illustrazioni mostrano la distanza minima tra il servoazionamento e l'oggetto successivo, oltre al raggio di curvatura minimo con-
sentito (Rmin) per il cavo installato in modo permanente. Per l'installazione del cavo prevedere l'altezza del connettore più ulteriori
30 mm per il cavo.
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4.7.2.1 Distanza minima per il connettore dritto M23 su DSD 510
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Illustrazione 21: Distanza minima per il connettore dritto M23

4.7.2.2 Distanza minima per il connettore angolato M23 su DSD 510
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Illustrazione 22: Distanza minima per il connettore angolato M23

4.7.3 Requisiti di spazio per i moduli di sistema
I moduli possono essere montati uno accanto all'altro, ma richiedono uno spazio minimo nella parte superiore e inferiore per il raf-
freddamento.
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Illustrazione 23: Spazio minimo necessario nella parte superiore e inferiore

AQ262449648484it-000201 / 175R113554 | Danfoss A/S © 2020.10

Installazione meccanica

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



1.

2.

3.

-

-

-

-

60 

[2.36]

60 

[2.36]

101

[3.98]

106

[4.17]

e
3

0
b

g
8

2
1

.1
0

Illustrazione 24: Spazio minimo necessario sui lati

4.7.4 Supporti e utensili necessari per l'installazione
Per l'installazione dei servoazionamenti ISD 510 sono necessari utensili adatti alle viti di fissaggio (non in dotazione).

4.7.5 Istruzioni di installazione per il servoazionamento ISD 510

4.7.5.1 Panoramica
I servoazionamenti ISD 510 vengono forniti con un tappo di protezione per il trasporto M23. Il tappo cieco M23 utilizzato per la
protezione IP deve essere ordinato separatamente. La versione avanzata del servoazionamento ISD 510 viene fornita inoltre con
tappi ciechi M8 e M12, che impediscono la contaminazione del servoazionamento e sono necessari per ottenere il relativo grado di
protezione IP. Inserire sempre questi tappi se il connettore non viene utilizzato.

N O T A

Assicurarsi che la superficie della macchina a contatto con la flangia del servoazionamento non sia verniciata per garantire
un buon rendimento termico dello stesso. Anche il contatto di superficie deve garantire una sufficiente protezione di messa
a terra.

4.7.5.2 Serraggio del servoazionamento ISD 510
Osservare le seguenti istruzioni di installazione per garantire un'installazione affidabile ed efficace del servoazionamento ISD 510.
Procedura

Controllare la superficie opposta a quella del montaggio del motore e assicurarsi che abbia una sufficiente capacità di dis-
persione del calore. La superficie non deve assolutamente essere verniciata.

Rimuovere il tappo terminale di protezione dall'albero.

Fissare il servoazionamento con quattro viti utilizzando i quattro appositi fori di montaggio presenti nell'unità della mac-
china, come mostrato in figura.

Utilizzare sempre i fori di montaggio previsti nella flangia di montaggio per fissare il servoazionamento.

Non modificare i fori di montaggio.

Utilizzare sempre tutti i quattro fori di montaggio. Il motore può funzionare in modo irregolare se vengono utilizzati
meno fori di montaggio.
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Illustrazione 25: Montaggio dei servoazionamenti ISD 510 di taglia 1, 1,5 Nm, taglia 2, 2,9 Nm, taglia 2, 3,8 Nm, taglia 3 e taglia 4.
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Illustrazione 26: Montaggio dei servoazionamenti ISD 510 taglia 2, 2,1 Nm.

4.7.5.3 Accoppiamento del servoazionamento ISD 510
Osservare i seguenti avvisi di sicurezza prima di accoppiare il servoazionamento ISD 510.

N O T A

Non lavorare l'albero.

Non usare il servoazionamento ISD 510 se l'albero non corrisponde alla disposizione di accoppiamento.
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N O T A
NON USARE UNA FORZA ECCESSIVA DURANTE LA PROCEDURA DI MONTAGGIO:

Non superare i limiti di vibrazione specificati.

Non superare le forze consentite specificate.

Procedura

Allineare il set di serraggio all'asse del servoazionamento ISD 510.

Inserire l'albero nel set di serraggio.

Avvitare il set di serraggio.

4.7.5.4 Coppie di serraggio per viti di fissaggio
Serrare sempre le viti in modo uniforme e procedendo a croce.

Taglia del servoazionamento Tipo di filettatura/

dimensione del foro

Lunghezza massima della filettatura Coppia di serraggio

Taglia 1, 1,5 Nm Ø 5,8 mm – 5 Nm

Taglia 2, 2,1 Nm Passo M6 1 mm 23 mm 6 Nm

Taglia 2, 2,9 Nm Ø 7 mm – 6 Nm

Taglia 2, 3,8 Nm Ø 7 mm – 6 Nm

Taglia 3, 5,2 Nm Ø 9 mm – 14 Nm

Taglia 3, 6,0 Nm Ø 9 mm – 14 Nm

Taglia 4, 11,2 Nm Ø 11 mm – 28 Nm

Taglia 4, 13,0 Nm In fase di rilascio – In fase di rilascio

N O T A

Le viti di fissaggio non sono fornite in dotazione e devono essere scelte in base ai fissaggi della macchina.

4.7.6 Istruzioni di installazione per il servoazionamento DSD 510

4.7.6.1 Serraggio del servoazionamento DSD 510
Osservare le seguenti istruzioni di installazione per garantire un'installazione affidabile ed efficace del servoazionamento DSD 510.
Procedura

Controllare la superficie di montaggio e assicurarsi che disponga di una sufficiente capacità di dispersione del calore. La
superficie non deve assolutamente essere verniciata.

Praticare i fori per il montaggio del DSD 510 (vedere 11.3.3 Dimensioni del servoazionamento DSD 510).

Montare il DSD 510 sulla piastra di montaggio con viti M5.

La coppia di serraggio è 3 Nm

Utilizzare sempre tutti i quattro fori di montaggio.
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Illustrazione 27: Montaggio del servoazionamento DSD 510

4.7.7 Istruzioni di installazione per i moduli di sistema

N O T A

Montare il modulo di sistema con la massima potenza di uscita accanto al PSM 510. Montare i restanti moduli di sistema
secondo un ordine decrescente della potenza di uscita.

Procedura

Praticare i fori per il montaggio della piastra posteriore come da schema di foratura (vedere 4.6.3 Schemi di perforazione).

Collegare le piastre posteriori e il cappuccio terminale tramite il metodo "Click and Lock".
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Illustrazione 28: Collegamento delle piastre posteriori

1 Cappuccio terminale della piastra posteriore
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4.

Montare le piastre posteriori sulla piastra di montaggio nell'armadio di controllo con viti M5 con un diametro minimo della
testa o della rondella pari a 9,5 mm. La coppia di serraggio è 3 Nm.
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Illustrazione 29: Montaggio delle piastre posteriori nell'armadio di controllo

Far scorrere il modulo sulla portante posizionata sul fondo della piastra posteriore.
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Premere il primo modulo sul connettore di backlink nella parte superiore della piastra posteriore.
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Illustrazione 30: Pressione del modulo sul connettore di backlink

Per fissare il modulo, tirare verso il basso il morsetto di fissaggio ([1] in Illustrazione 31) nella parte superiore della piastra
posteriore.
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Illustrazione 31: Tirare verso il basso il morsetto di fissaggio nella parte superiore della piastra posteriore
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

Ripetere i passaggi 4, 5 e 6 per i moduli rimanenti, assicurandosi che il labbro sul lato sinistro del secondo modulo sia all'in-
terno della scanalatura di guida sul lato destro del primo modulo (([1] in Illustrazione 32).

1

e
3

0
b

g
8

2
2

.1
0

Illustrazione 32: Scanalatura di guida
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5 Installazione elettrica

5.1 Avvisi per l'installazione elettrica
Durante l'installazione elettrica, oltre alle informazioni contenute nel presente manuale, osservare le norme locali e nazionali perti-
nenti.

A V V I S O
PERICOLO DI CORRENTI DI DISPERSIONE/MESSA A TERRA

Le correnti di dispersione/messa a terra sono superiori a 3,5 mA. Una messa a terra non appropriata dei servoazionamenti e dei

moduli di sistema ISD 510/DSD 510 può causare morte o lesioni gravi.

Per motivi di sicurezza dell'operatore, utilizzare un installatore elettrico certificato per la corretta messa a terra dell'impianto
in conformità alle norme e direttive elettriche locali e nazionali applicabili e alle istruzioni contenute nel presente manuale.

A V V I S O
ALTA TENSIONE

Il servosistema contiene componenti che funzionano ad alta tensione quando sono collegati alla rete di alimentazione elettrica.

Sui componenti non sono presenti indicatori che indicano la presenza di alimentazione di rete. Un'installazione, una messa in

funzione o una manutenzione non corrette possono causare morte o gravi lesioni.

L'installazione, la messa in funzione e la manutenzione devono essere eseguite esclusivamente da personale qualificato.

A V V I S O
ALTA TENSIONE

Sui connettori è presente una tensione potenzialmente letale che può provocare lesioni gravi o mortali.

Prima di lavorare sui connettori di alimentazione (scollegando o collegando il cavo), scollegare il PSM 510 dalla rete e attend-
ere la fine del tempo di scarica.

5.2 Condizioni ambientali elettriche
Per consentire un funzionamento sicuro ed efficace del servosistema è necessario rispettare le seguenti condizioni ambientali elet-
triche:

Solamente per l'impiego in impianti di messa a terra di alimentazione TN-S, TN-C, TN-CS, TT (non con messa a terra angolare)

Corrente di cortocircuito potenziale: 5 kA

Classe di protezione I

Rete di alimentazione trifase con messa a terra, 400-480 V CA ±10%

Frequenza trifase 44–66 Hz

Linee trifase e linea PE

Alimentazione esterna per tensione ausiliaria, 24-48 V CC (PELV) ±10%

Induttanza CA (vedere 5.10.1 Induttanza della linea CA)

Osservare le disposizioni di legge nazionali.

La corrente di dispersione è superiore a 3,5 mA.

N O T A
COMPATIBILITÀ RCD

Il servosistema contiene componenti che possono determinare una corrente CC nel conduttore di terra di protezione, che può

provocare il malfunzionamento di qualsiasi dispositivo collegato al sistema.

Se viene usato un dispositivo di protezione a corrente residua (RCD) o di monitoraggio (RCM) per la protezione in caso di
contatto diretto o indiretto, usare un dispositivo RCD o RCM di tipo B sul lato di alimentazione dei componenti del sistema.
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N O T A

Il PSM 510, il DAM 510 e l'ACM 510 (opzionale) devono essere montati in un armadio di controllo.

5.3 Installazioni conformi ai requisiti EMC
Per ottenere un'installazione conforme ai requisiti EMC, seguire le istruzioni fornite in 5.4.2 Messa a terra per l'installazione con-
forme ai requisiti EMC e i passaggi definiti per il collegamento dei servoazionamenti ISD 510/DSD 510, del PSM 510, del DAM 510 e
dell'ACM 510.

5.4 Messa a terra

5.4.1 Messa a terra per la sicurezza elettrica
Collegare a terra i servoazionamenti DSD 510 con il conduttore PE del cavo di alimentazione. Sulla parte anteriore e posteriore
del servoazionamento DSD 510 è presente una vite PE dedicata.

X6X7
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0b

h5
72

.1
0

1

Illustrazione 33: Messa a terra del servoazionamento DSD 510

1 Vite PE

Assicurarsi che il frame della macchina disponga di un adeguato collegamento elettrico sui servoazionamenti ISD 510 e
DSD 510:

Per ISD 510: utilizzare la superficie della flangia sul lato anteriore. per il collegamento PE.

Per DSD  510: utilizzare la vite PE mostrata in Illustrazione 33.

Per i servoazionamenti ISD 510/DSD 510, garantire una sezione trasversale minima del filo di terra di almeno 10 mm2 (minimo
70 °C, Cu) o due fili di terra separati, entrambi conformi alle regole di dimensionamento. Per ulteriori informazioni consultare la
norma EN/IEC 61800-5-1.

Usare un filo di terra dedicato per l'alimentazione di ingresso e i cavi di controllo.

Non collegare a terra i moduli in daisy-chain.

Tenere i fili di terra quanto più corti possibile.

Attenersi ai requisiti di cablaggio contenuti nel presente manuale.

Per i moduli di sistema:

Per soddisfare i requisiti CE, garantire una sezione trasversale minima del filo di terra di almeno 16 mm2 (minimo 70 °C, Cu).

Per soddisfare i requisiti UL, garantire una sezione trasversale minima del filo di terra di almeno 6 AWG (minimo 60 °C, Cu).

Se si utilizza un modulo PSM 510 con 10 kW è possibile ridurre la sezione trasversale dei cavi:

10 mm2 (minimo 70 °C, Cu) per soddisfare i requisiti CE

8 AWG (minimo 60 °C, Cu) per soddisfare i requisiti UL

AQ262449648484it-000201 / 175R1135 | 63Danfoss A/S © 2020.10

Installazione elettrica

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



•

•

•

5.4.2 Messa a terra per l'installazione conforme ai requisiti EMC
Stabilire il contatto elettrico tra lo schermo del cavo e il contenitore usando la piastra di schermatura I/O di ogni modulo.
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Illustrazione 34: Schermatura del cavo sulla parte superiore dei moduli di sistema

1 Cavo

2 Pressacavo

3 Piastra di schermatura I/O
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Illustrazione 35: Schermatura del cavo sulla parte inferiore dei moduli di sistema

1 Pressacavo

2 Piastra di schermatura metallica EMC

3 Vite PE

Utilizzare un cavo con una schermatura ad alta copertura per ridurre le oscillazioni transitorie da scoppio.

Non utilizzare schermi attorcigliati per collegare la schermatura. Si consiglia un collegamento dei fili a 360°.
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N O T A
COLLEGAMENTO EQUIPOTENZIALE

Esiste il rischio di oscillazioni transitorie da scoppio quando il potenziale di terra tra il servosistema e la macchina è diverso.
Installare i cavi di equalizzazione tra essi. La sezione trasversale dei cavi consigliata è 16 mm2.

N O T A
INTERFERENZA EMC

Utilizzare cavi schermati per i cavi di controllo e cavi separati per i cavi di alimentazione e di controllo. Il mancato isolamento
dei cavi di alimentazione e di controllo può provocare un comportamento inatteso e prestazioni ridotte.

Assicurare una distanza minima di 200 mm tra i cavi di segnale e di potenza.

Soltanto cavi trasversali a 90°.

5.5 Requisiti dell'alimentazione di rete
Assicurarsi che l'alimentazione presenti le seguenti proprietà:

Impianto di messa a terra dell'alimentazione TN-S, TN-C, TN-CS, TT (non con messa a terra angolare).

Corrente di cortocircuito potenziale: 5 kA.

Classe di protezione I.

Rete di alimentazione trifase a terra, 400-480 V CA ±10%.

Linee trifase e linea PE.

Frequenza trifase: 44–66 Hz

Corrente di ingresso massima per un PSM 510 a 30 kW: 55 Arms

5.5.1 Fusibili

N O T A

Utilizzare fusibili sul lato di alimentazione del modulo di alimentazione PSM 510 conformi ai requisiti CE e UL (vedere la
Tabella 20).

Quando si utilizzano due moduli PSM 510, ogni PSM 510 deve disporre di un proprio set di fusibili dedicati.

Tabella 20: Fusibili

Modello e potenza nominale Conformità CE (IEC 60364) Conformità UL (NEC 2014)

Tipo di fusibile massimo Tipo di fusibile massimo

PSM 510 (10 kW) gG 25 A 30 A (soltanto classe T o J)

PSM 510 (20 kW) gG 50 A 50 A (soltanto classe T o J)

PSM 510 (30 kW) gG 63 A 80 A (soltanto classe T o J)

5.5.2 Interruttori
Per soddisfare i requisiti CE utilizzare un interruttore di tipo B o C con una capacità pari a 1,5 volte la corrente nominale di PSM 510.

N O T A

Gli interruttori non sono consentiti negli impianti dove è richiesto il C-UL. Sono consentiti solamente i fusibili raccomandati
da UL.
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5.6 Requisiti per l'alimentazione ausiliaria
Alimentare il modulo di alimentazione (PSM 510) con un'alimentazione elettrica con un campo di uscita di 24-48 V CC ±10%. L'on-
dulazione in uscita dell'unità di alimentazione elettrica deve essere inferiore a 250 mVpp. Utilizzare esclusivamente unità di alimenta-
zione conformi alla specifica PELV. Consultare la Guida alla Progettazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotionô ) per gli schemi a chiocciola della potenza nominale.

N O T A

Utilizzare esclusivamente unità di alimentazione conformi alla specifica PELV.

Utilizzare un'alimentazione con marchio CE secondo le norme EN 61000-6-2 ed EN 61000-6-4 o simili per uso industriale.

Il circuito secondario deve essere alimentato da una sorgente esterna isolata.

L'unità di alimentazione esterna deve essere dedicata al servosistema ISD 510/DSD 510, ossia l'alimentazione è utilizzata esclusiva-
mente per alimentare il PSM 510. La lunghezza massima del cavo tra l'unità di alimentazione e il PSM 510 è 3 m.

5.6.1 Fusibili
Per proteggere il cablaggio a 24-48 V CC si raccomanda l'uso di fusibili certificati UL.

Tabella 21: Fusibili

Conformità CE (IEC 60364) Conformità UL (NEC 2014)

Tipo di fusibile massimo Tipo di fusibile massimo

50 A(1) 63 A(2)

1 Se la corrente massima è inferiore, è possibile utilizzare un fusibile con corrente nominale inferiore. Grado dei fusibili IEC: secondo il 100% della
corrente massima. Utilizzare un fusibile a tempo di ritardo classificato in base alla tensione CC in uso.

2 Se la corrente massima è inferiore, è possibile utilizzare un fusibile con corrente nominale inferiore. Grado dei fusibili UL: secondo il 125% della
corrente massima. Utilizzare un fusibile a tempo di ritardo classificato in base alla tensione CC in uso.

5.7 Requisiti dell'alimentazione di sicurezza
Alimentare la linea STO con un'alimentazione a 24 V CC con le seguenti proprietà:

Intervallo di uscita: 24 V CC ±10%

Corrente massima: 1 A

Utilizzare un'unità di alimentazione a 24 V con marchio CE per uso industriale. Assicurarsi che l'alimentazione soddisfi le specifiche
PELV e venga utilizzata soltanto per l'ingresso di sicurezza del sistema.

È possibile utilizzare un'alimentazione comune per l'alimentazione ausiliaria e di sicurezza, a condizione che l'unico punto di colle-
gamento dei due circuiti sia vicino all'alimentazione, al fine di evitare interferenze dovute a una generale caduta di tensione. La
lunghezza massima del cavo tra l'unità di alimentazione da 24 V e il servosistema è di 3 m.

L'alimentazione di sicurezza può essere collegata in loop dal PSM 510 agli altri moduli di sistema, ad eccezione dell'ACM 510 (cavo
non in dotazione). Per ulteriori informazioni vedere il 8.6 Installazione.

N O T A

Garantire un isolamento rinforzato tra i segnali di sicurezza e gli altri segnali, le alimentazioni (alimentazione di rete) e le parti
conduttive esposte.
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5.8 Requisiti UL

N O T A

La protezione da cortocircuito allo stato solido integrata non fornisce una protezione del circuito di derivazione, che deve
quindi essere assicurata in conformità al Codice Elettrico Nazionale/Codice Elettrico Canadese ed eventuali ulteriori codici
locali.

L'unità è adatta per l'uso su un circuito in grado di fornire non oltre 5000 ampere rms simmetrici, 480 V massimo quando è
protetta da fusibili da 80 A di classe J o T.

Per soddisfare le normative UL (Underwriters Laboratories), utilizzare un cavo di rame omologato UL con una resistenza ter-
mica minima di 60 °C. Utilizzare esclusivamente fili di classe 1. Per il PSM 510 da 30 kW e l'EXM 510 utilizzare una resistenza
termica massima di 75 °C.

È necessaria una protezione da sovracorrente del circuito di comando.

5.9 Collegamento del servoazionamento ISD 510/DSD 510

5.9.1 Avvisi di installazione elettrica per il servoazionamento ISD 510/DSD 510

A V V I S O
ALTA TENSIONE

Sui connettori è presente una tensione potenzialmente letale che può provocare lesioni gravi o mortali.

Prima di lavorare sui connettori di alimentazione o di segnale (scollegando o collegando il cavo) oppure prima di eseguire
lavori di manutenzione, scollegare il modulo di alimentazione (PSM 510) dalla rete e attendere il tempo di scarica.

A V V I S O
TEMPO DI SCARICA

Il servosistema contiene condensatori del collegamento CC che rimangono carichi per un determinato lasso di tempo dopo che

l'alimentazione di rete è stata disinserita dal modulo di alimentazione (PSM 510). Il mancato rispetto del tempo di attesa indicato

dopo aver disinserito l'alimentazione prima di effettuare lavori di manutenzione o riparazione potrebbe causare lesioni gravi o

mortali.

Per evitare scosse elettriche, scollegare completamente il modulo di alimentazione (PSM 510) dalla rete elettrica e attendere
che i condensatori si scarichino completamente prima di eseguire qualsiasi lavoro di manutenzione o di riparazione sul ser-
vosistema o sui relativi componenti.

Tempo di attesa minimo (minuti)

15

5.9.2 Istruzioni generali per l'installazione dei cavi
Evitare la tensione meccanica per tutti i cavi, soprattutto per quanto riguarda l'ampiezza di movimento del servoazionamento in-
stallato.

Fissare tutti i cavi in conformità con le normative e a seconda delle condizioni in loco. Assicurarsi che i cavi non possano allentarsi,
anche dopo un funzionamento prolungato.

Se non si utilizzano i connettori X3, X4 e X5, montare sempre il relativo tappo cieco.

N O T A

Non collegare o scollegare mai i cavi ibridi da o verso il servoazionamento quando è presente la tensione di alimentazione. In
caso contrario, sussiste il rischio di danneggiare il circuito elettronico. Osservare il tempo di scarica dei condensatori del col-
legamento CC.

Non forzare il collegamento né il montaggio dei connettori: un collegamento errato causa danni permanenti agli stessi.
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Tabella 22: Coppie di serraggio

Connettore Coppia di serraggio [Nm]

M8 0,2

M12 0,4

M23 0,8

5.9.3 Collegamento dei cavi ibridi
Procedura

Allineare il connettore femmina del cavo di alimentazione M23 al connettore d'ingresso maschio (X1) del primo servoazio-
namento ISD 510/DSD 510.

Ruotare completamente l'anello filettato del passacavo in senso antiorario. Utilizzare la marcatura OPEN come riferimento
per il passacavo.

Assicurarsi che la marcatura OPEN sul passacavo sia rivolta verso il servoazionamento.

Premere il connettore sull'alloggiamento elettronico del servoazionamento fino a coprire completamente la tenuta del
connettore.

Serrare il passacavo del cavo di alimentazione M23 ruotando l'anello filettato in senso orario per estrarlo dall'area piana
intorno alla marcatura OPEN.
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Illustrazione 36: Collegamento del cavo di alimentazione M23

Per aggiungere altri servoazionamenti in daisy-chain, collegare il connettore maschio del cavo ad anello al connettore fem-
mina (X2) del primo servoazionamento.

Collegare il connettore femmina del cavo di loop al connettore maschio (X1) del servoazionamento successivo, e così via.

Serrare gli anelli filettati manualmente come descritto nel passaggio 5.
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11.



Assicurarsi che non sia presente alcuna tensione meccanica sui cavi.
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Illustrazione 37: Aggiunta dei servoazionamenti ISD 510 in daisy-chain

1 Connettore maschio X1

2 Connettore femmina X2

3 Tappo cieco in metallo M23

Avvitare il tappo cieco in metallo M23 al connettore di uscita femmina M23 inutilizzato (X2) sull'ultimo servoazionamento
del servosistema

Serrare il tappo cieco in metallo fino a coprire la tenuta del connettore.
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Illustrazione 38: Installazione del tappo cieco M23
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A T T E N Z I O N E
RISCHIO DI LESIONI E/O DI DANNI ALLE APPARECCHIATURE

Il mancato utilizzo del tappo cieco in metallo M23 può causare lesioni all'operatore e/o danni al servoaziona-

mento ISD 510/DSD 510.

Montare sempre il tappo cieco in metallo M23 come descritto ai passaggi 10 e 11.

N O T A

È disponibile anche una versione angolata del connettore M23. La procedura per il collegamento del con-
nettore angolato M23 è identica a quella per il connettore dritto.

5.9.4 Scollegamento dei cavi ibridi
Procedura

Scollegare il modulo di alimentazione (PSM 510) dalla sua fonte di alimentazione elettrica (rete elettrica e UAUX).

Attendere che trascorra il tempo minimo di scarica.

Rimuovere il connettore del cavo di alimentazione dal modulo di accesso decentralizzato (DAM 510).

Ruotare l'anello filettato sul connettore del cavo di alimentazione del servoazionamento in senso antiorario fino a quando
la marcatura OPEN sul passacavo non è rivolta verso il servoazionamento.

Estrarre il connettore dall'alloggiamento elettronico.

Per i connettori X1 e X2 sono previsti tappi ciechi di protezione. Installare i tappi ciechi dopo aver rimosso il rispettivo con-
nettore.

5.9.5 Collegamento dei cavi alle porte X3, X4 e X5

5.9.5.1 Raccomandazioni per l'instradamento dei cavi
Evitare la tensione meccanica per tutti i cavi, soprattutto per quanto riguarda l'ampiezza di movimento del servoazionamento in-
stallato.

Fissare tutti i cavi in conformità con le normative e a seconda delle condizioni in loco. Assicurarsi che i cavi non possano allentarsi,
anche dopo un funzionamento prolungato.
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5.9.5.2 Collegamento dei cavi encoder e/o I/O alla porta X3
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Illustrazione 39: Collegamento del cavo encoder e/o I/O

Procedura

Allineare il connettore sul cavo (non in dotazione) con il connettore contrassegnato con X4 sul servoazionamento.

Premere il connettore sull'alloggiamento elettronico del servoazionamento e serrare l'anello filettato ruotandolo in senso
orario. La coppia di serraggio massima è 0,4 Nm.
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5.9.5.3 Collegamento del cavo LCP alla porta X5
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Illustrazione 40: Collegamento del cavo LCP

Procedura

Allineare il connettore sul cavo LCP (non in dotazione) con il connettore LCP contrassegnato con X5 sul servoazionamento
ISD 510/DSD 510.

Premere il connettore sull'alloggiamento elettronico del servoazionamento e serrare l'anello filettato ruotandolo in senso
orario. La coppia di serraggio massima è 0,2 Nm.

Il cavo LCP può essere ordinato come accessorio.
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5.9.5.4 Collegamento del terzo cavo per dispositivo Ethernet alla porta X3
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Illustrazione 41: Collegamento del terzo cavo del dispositivo Ethernet

Procedura

Allineare il connettore sul cavo con il connettore Ethernet contrassegnato X3 sul servoazionamento ISD 510/DSD 510.

Premere il connettore sull'alloggiamento elettronico del servoazionamento e serrare l'anello filettato ruotandolo in senso
orario. La coppia di serraggio massima è 0,2 Nm.

5.9.6 Scollegamento dei cavi dalle porte X3, X4 e X5
Allentare l'anello filettato del connettore ruotandolo in senso antiorario.

Scollegare il cavo dal servoazionamento.

Per i connettori X3, X4 e X5 sono forniti in dotazione tappi ciechi di protezione, che vanno installati dopo aver rimosso il
rispettivo connettore.

5.10 Collegamento al modulo di alimentazione PSM 510

5.10.1 Induttanza della linea CA
È obbligatorio l'utilizzo di un'induttanza della linea CA trifase (vedere 5.10.1.1 Collegamento di un PSM 510 all'induttanza CA e
5.10.1.2 Collegamento di due moduli PSM 510 all'induttanza CA).

Tabella 23: Caratteristiche dell'induttanza della linea per un PSM 510

Modello Minimo Irms [A] Urms [V] Induttanza [mH]

PSM 510 (10 kW) 20 500 Minimo: 0,47

Massimo: 1,47

PSM 510 (20 kW) 40 500 Minimo: 0,47

Massimo: 1,47

PSM 510 (30 kW) 60 500 0,47 ±10%
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Se vengono installati due moduli PSM 510 in parallelo, utilizzare un'induttanza CA come specificato nella Tabella 24. Vedere 5.10.1.2
Collegamento di due moduli PSM 510 all'induttanza CA per ulteriori informazioni.

Tabella 24: Caratteristiche dell'induttanza della linea per due PSM 510 installati in parallelo.

Modello Minimo Irms [A] Urms [V] Induttanza [mH]

PSM 510 (2 x 30 kW) 125 500 0,24 ±10%

Danfoss consiglia di montare l'induttanza di linea CA vicino al PSM 510.

La lunghezza massima del cavo dipende dalla sezione trasversale e dalla tensione e corrente necessarie al collegamento CC.

Se le induttanze della linea CA sono montate lontano dal PSM 510, la distanza massima del cavo è di 5 m.

5.10.1.1 Collegamento di un PSM 510 all'induttanza CA
Collegare il PSM 510 al sistema di distribuzione con l'induttanza CA corretta per le taglie di potenza dello stesso.
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SVS ST
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LINK/ACT
X1
X2

LCP LCP
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NET ST
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LINK/ACT
X1
X2
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Illustrazione 42: Collegamento di un PSM 510 all'induttanza CA

5.10.1.2 Collegamento di due moduli PSM 510 all'induttanza CA
Collegare i moduli PSM 510 alla stessa induttanza CA come mostrato in Illustrazione 43.

Assicurarsi che l'induttanza impiegata sia della dimensione corretta in base alla potenza combinata dei moduli PSM 510.

Quando si utilizzano due moduli PSM 510, il cablaggio tra l'induttanza di linea CA e ciascun PSM 510 deve essere della stessa lun-
ghezza, con una tolleranza di 0,5 m.

Collegare ogni PSM 510 direttamente all'induttanza CA. Non è consentito il cablaggio in parallelo.
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Illustrazione 43: Collegamento di due moduli PSM 510 all'induttanza CA

5.10.1.3 Collegamento di due moduli PSM 510 all'induttanza CA con ripartizione del sistema
Collegare i moduli PSM 510 alla stessa induttanza CA indipendentemente dalla posizione di carico (ad esempio prima o dopo la
ripartizione del sistema) come mostrato in Illustrazione 44.

Assicurarsi che l'induttanza impiegata sia della dimensione corretta in base alla potenza combinata dei moduli PSM 510.

Quando si utilizzano due moduli PSM 510, il cablaggio tra l'induttanza di linea CA e ciascun PSM 510 deve essere della stessa lun-
ghezza, con una tolleranza di 0,5 m.

Collegare ogni PSM 510 direttamente all'induttanza CA. Non è consentito il cablaggio in parallelo.
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Illustrazione 44: Collegamento di due moduli PSM 510 all'induttanza CA con ripartizione del sistema

Se si utilizzano due bobine di induttanza CA (una per ciascun PSM 510) ed entrambi i moduli PSM 510 sono montati sullo stesso lato
della ripartizione del sistema, la configurazione è consentita con un declassamento pari alla tolleranza della bobina di induttanza CA
rapportata a 60 kW. Ad esempio, il 10% di declassamento è pari a 54 kW.

Se si utilizzano due bobine di induttanza CA (una per ciascun PSM 510) e si monta un modulo PSM 510 prima e uno dopo la riparti-
zione, i carichi devono essere bilanciati in modo uniforme. In caso contrario, il declassamento di entrambi i moduli PSM 510 è pari
alla tolleranza dell'induttanza CA. Ad esempio, una tolleranza 10% + 10% significa -20% di declassamento.

Se si utilizzano due bobine di induttanza CA (una per ciascun PSM 510) e si monta un modulo PSM 510 prima e uno dopo la riparti-
zione con metà dei carichi impostati prima e metà dopo la ripartizione del sistema, l'impostazione è consentita con un declassa-
mento pari alla tolleranza della bobina di induttanza CA rapportata a 60 kW. Ad esempio, il 10% di declassamento è pari a 54 kW.

N O T A

Ulteriori informazioni sul modulo EXM 510 e il cablaggio sono disponibili in 11.9.13 Connettore del modulo di espansione.

5.10.2 Collegamento dei cavi sul modulo di alimentazione PSM 510

5.10.2.1 Collegamento dei cavi sulla parte superiore del modulo di alimentazione PSM 510
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Illustrazione 45: Connettori sulla parte superiore di PSM 510
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a.

b.

4.

1 Connettore Ethernet di ingresso (X1 IN)

2 Connettore Ethernet di uscita (X2 OUT)

3 Connettore di ingresso da 24/48 V (INPUT 24/48 V)

4 Connettore STO di ingresso (STO PSM)

5 Connettore STO di uscita (STO PSM)

6 Connettore I/O (I/O PSM)

7 Connettore per relè (REL PSM)

Procedura

Collegare il cavo Ethernet dal PLC al connettore di ingresso Ethernet (X1 IN) [1].

Collegare il cavo Ethernet dal connettore di uscita Ethernet (X2 OUT) [2] al modulo successivo.

Inserire i fili nel connettore di ingresso da 24/48 V (INPUT 24/48 V).

Inserire il connettore di ingresso da 24/48 V [3].

Inserire i fili nel connettore di ingresso STO (STO PSM).

Inserire il connettore di ingresso STO [4].

Inserire i fili nel connettore di uscita STO (STO PSM).

Inserire il connettore di uscita STO [5].

Se sono necessari ulteriori I/O, inserire i fili nel connettore I/O, quindi inserire il connettore (I/O PSM) [6].

Se è necessario un relè, inserire i fili nel connettore per relè, quindi inserire il connettore (REL PSM) [7].

5.10.2.2 Collegamento dei cavi sulla parte inferiore del modulo di alimentazione PSM 510
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Illustrazione 46: Connettori sulla parte inferiore di PSM 510

1 Supporto per il connettore del resistore di frenatura
interno quando non in uso

2 Connettore di alimentazione di rete CA

3 Viti PE

4 Connettore per resistore di frenatura interno/ester-
no

Procedura

Inserire i fili nel connettore di alimentazione di rete CA.

Inserire il connettore di alimentazione di rete CA [2].

Se è necessario un resistore di frenatura esterno:

Scollegare il connettore del resistore di frenatura interno [4] e al suo posto inserire il connettore del freno esterno.

Collegare il connettore del resistore di frenatura interno nel supporto del connettore del freno interno [1].

Collegare il PSM 510 al PE con una delle viti PE anteriori [3] e un conduttore PE. La coppia di serraggio è 3 Nm.

AQ262449648484it-000201 / 175R1135 | 77Danfoss A/S © 2020.10

Installazione elettrica

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



1.

2.

3.

4.

5.11 Collegamento del modulo di accesso decentralizzato (DAM 510)

5.11.1 Collegamento dei cavi sulla parte superiore del modulo di accesso decentralizzato DAM 510
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Illustrazione 47: Connettori sulla parte superiore di DAM 510

1 Connettore Ethernet di ingresso (X1 IN)

2 Connettore Ethernet di uscita (X3 OUT)

3 Connettore STO di ingresso (STO DAM)

4 Connettore STO di uscita (STO DAM)

5 Connettore per encoder esterno (E DAM)

Procedura

Collegare il cavo Ethernet dall'uscita del modulo precedente al connettore di ingresso (X1 IN) [1].

Inserire i fili dall'uscita STO del modulo precedente nel connettore di ingresso 24 V (ingresso STO), vedere 11.9.9.2.1 Con-
nettori STO sulla parte superiore di DAM 510.

Inserire il connettore di ingresso 24 V (connettore STO IN (STO DAM)) [3] nel DAM 510.

Se necessario, collegare il connettore per encoder esterno [5].

5.11.2 Collegamento del cavo di alimentazione
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Illustrazione 48: Connettori sulla parte inferiore del DAM 510

1 Connettore Ethernet

2 Connettore AUX

3 Connettore STO di uscita

4 Connettore UDC
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Illustrazione 49: Cavo di alimentazione

1 Area schermata

2 UDC+ (nero, 2,5 mm2/4 mm2)

3 UDC– (grigio, 2,5 mm2/4 mm2)

4 STO+ (rosa, 0,5 mm2)

5 STO– (grigio, 0,5 mm2)

6 AUX+ (rosso, 2,5 mm2)

7 AUX– (blu, 2,5 mm2)

8 Ethernet/bus di campo (verde, connettore RJ45)

9 PE (giallo/verde, 2,5 mm2/4 mm2, capocorda a force-
lla)
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Illustrazione 50: Collegamento del cavo di alimentazione

1 Viti PE per cavo di alimentazione

2 Connettore bus

3 Pressacavo per cavo di alimentazione

4 Pressacavo per cavo STO

5 Piastra EMC

6 Vite per piastra EMC

Procedura
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Inserire i fili nei connettori UDC, AUX e STO.

Fissare il cavo di alimentazione con i pressacavi [3], assicurandosi che la zona schermata sia posizionata esattamente sotto
questi ultimi.

Fissare il cavo STO con il pressacavo [4], assicurandosi che la zona schermata sia posizionata esattamente sotto quest'ulti-
mo.

Inserire i connettori del cavo di alimentazione nella rispettiva morsettiera sul DAM 510.

Serrare la vite sulla piastra EMC [6]. La coppia di serraggio è 3 Nm.

Inserire il connettore bus RJ45 [2].

Collegare il DAM 510 al PE con una delle viti PE anteriori [1] e un conduttore PE. La coppia di serraggio è 3 Nm.

5.12 Collegamento del modulo di condensatori ausiliari ACM 510
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Illustrazione 51: Connettori sulla parte superiore di ACM 510

1 Connettore Ethernet di ingresso (X1 IN)

2 Connettore Ethernet di uscita (X2 OUT)

3 Connettore I/O (I/O ACM)

4 Connettore per relè (REL ACM)

Procedura

Collegare il cavo Ethernet dall'uscita del modulo di sistema precedente al connettore di ingresso (X1 IN) [1].

Se sono necessari ulteriori I/O, inserire i fili nel connettore I/O (I/O ACM), quindi inserire il connettore [3].

Se è necessario un relè, inserire i fili nel connettore per relè (REL ACM), quindi inserire il connettore [4].

Collegare l'ACM 510 al PE con una delle viti PE anteriori [5] e un conduttore PE. La coppia di serraggio è 3 Nm.

5.13 Collegamento del modulo di espansione EXM 510
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Illustrazione 52: Cavo del modulo di espansione

1 24/48 V

2 GND

3 Terra funzionale

4 CC-

5 CC-

6 CC+

7 CC+

8 Area schermata

AQ262449648484it-000201 / 175R113580 | Danfoss A/S © 2020.10

Installazione elettrica

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



1.

2.

3.

4.

5.

6.

-

-

e3
0b

h3
92

.1
1

1

23

4

5

6

7

Illustrazione 53: Collegamento del modulo di espansione EXM 510

1 Vite per piastra di schermatura EMC

2 Vite PE

3 Cavi CC

4 Cavo di terra funzionale

5 Cavo GND

6 Cavo da 24/48 V

7 Pressacavo

N O T A

Se si utilizzano due connettori di backlink separati (collegati tramite una o due coppie di moduli EXM 510), le due barre di
messa a terra devono essere collegate anche insieme con una sezione trasversale dei cavi da 16 mm2 (6 AWG).

Per le sezioni trasversali dei cavi vedere 11.9.13.1 Sezioni trasversali dei cavi per EXM 510.

Procedura

Inserire i fili [3], [4], [5] e [6] nel connettore di espansione.

Fissare i cavi CC [3] con il pressacavo [7], assicurandosi che l'area schermata sia posizionata esattamente sotto il pressacavo.

Fissare i cavi [4], [5] e [6] con i pressacavi [7].

Inserire i connettori nella piastra posteriore.

Serrare la vite sulla piastra di schermatura EMC [1]. La coppia di serraggio è 3 Nm.

Collegare l'EXM 510 al PE utilizzando una vite PE [2] e un conduttore PE. La coppia di serraggio è 3 Nm.

5.14 Collegamento del resistore di frenatura sul PSM 510
Il PSM 510 è collegato al resistore di frenatura interno come mostrato in Illustrazione 54.

In alternativa, il PSM 510 può essere collegato a un resistore di frenatura esterno. In questo caso, il resistore di frenatura interno del
PSM 510 deve rimanere scollegato e il connettore può essere posizionato nel supporto del connettore dello stesso resistore di fre-
natura interno.

Non è consentito installare resistori di frenatura in parallelo o in serie.
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Illustrazione 54: Collegamento del resistore di frenatura interno su un PSM 510

1 Resistore di frenatura interno

Quando si utilizzano due moduli PSM 510, collegare ogni PSM 510 al proprio resistore di frenatura interno come mostrato in Illustra-
zione 55 (impostazioni di fabbrica).

Configurazioni alternative consentite per due moduli PSM 510:

Un PSM 510 è collegato al resistore di frenatura interno e l'altro è collegato a un resistore di frenatura esterno.

Entrambi i moduli PSM 510 sono collegati a un resistore di frenatura esterno. In questo caso, il resistore di frenatura interno del
PSM 510 deve rimanere scollegato e il connettore può essere posizionato nel supporto del connettore dello stesso resistore di
frenatura interno (vedere 5.10.2.2 Collegamento dei cavi sulla parte inferiore del modulo di alimentazione PSM 510).

Non è consentito installare resistori di frenatura in parallelo o in serie.
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Illustrazione 55: Collegamento del resistore di frenatura su due moduli PSM 510 in parallelo

1 Resistore di frenatura interno
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6 Messa in funzione

6.1 Avvisi per la messa in funzione

A V V I S O
AVVIO INVOLONTARIO

Il servosistema contiene servoazionamenti, il PSM 510 e il DAM 510, che sono collegati alla rete di alimentazione elettrica e posso-

no iniziare a funzionare in qualsiasi momento per via di un comando del bus di campo, di un segnale di riferimento o dell'elimina-

zione di una condizione di guasto. I servoazionamenti e tutti i dispositivi collegati devono essere in buone condizioni di funziona-

mento, poiché quando l'unità è collegata alla rete di alimentazione elettrica condizioni di funzionamento carenti possono cau-

sare morte, lesioni gravi, danni alle apparecchiature o altri danni materiali.

Adottare misure adeguate per evitare avvii involontari.

6.2 Lista di controllo prima della messa in funzione
Completare sempre questi controlli prima della prima messa in funzione e prima di avviare il funzionamento dopo lunghi tempi di
fermo o di stoccaggio.
Procedura

Controllare che tutti i connettori filettati dei componenti meccanici ed elettrici siano serrati correttamente.

Controllare che sia assicurata la libera circolazione dell'aria di raffreddamento (aspirazione e uscita).

Controllare che i collegamenti elettrici siano corretti.

Assicurarsi che siano presenti protezioni di contatto per le parti rotanti e le superfici che possono surriscaldarsi.

Se si utilizza la funzionalità STO, eseguire il test di messa in funzione del sistema di sicurezza funzionale (vedere 8.8 Test di
messa in funzione).

6.3 Assegnazione ID EtherCAT®
EtherCATÆ non richiede alcuna assegnazione speciale dell'ID (indirizzo IP). L'assegnazione speciale dell'ID è necessaria solamente se
si utilizza la comunicazione indiretta tramite il software VLTÆ Servo Toolbox.

6.4 Assegnazione ID Ethernet POWERLINK®

6.4.1 Panoramica
La comunicazione con il master Ethernet POWERLINKÆ non deve essere attiva quando si utilizza il VLTÆ Servo Toolbox per assegnare
gli ID ai dispositivi. L'assegnazione ID tramite il VLTÆ Servo Toolbox è possibile solamente quando viene utilizzata la comunicazione
aciclica Ethernet POWERLINKÆ. Se la comunicazione aciclica Ethernet POWERLINKÆ è già iniziata, spegnere e riaccendere per arrest-
arla.

Scollegare il PLC, spegnere e riaccendere prima di impostare gli ID. In alternativa, nell'interfaccia POWERLINKÆ, riavviare il PLC in

Service Mode (Modalità manutenzione) mentre il parametro Basic Ethernet in Service Mode (Ethernet di base in modalità di funziona-
mento) è impostato su Basic Ethernet enabled (Ethernet di base abilitato).

6.4.2 Assegnazione ID al singolo dispositivo
Quando si assegna un ID a un singolo dispositivo, utilizzare la finestra Device Information (Informazioni sul dispositivo) in VLTÆ Servo

Toolbox (per maggiori informazioni vedere la Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510
(VLT® Flexmotionô )).

È possibile effettuare l'impostazione di un ID per un dispositivo solamente tramite l'LCP.

6.4.2.1 Impostazione dell'ID del nodo direttamente su un servoazionamento o sui moduli di siste-
ma
Tutti i parametri relativi all'IP si trovano nel gruppo di parametri 12-0* IP Settings (Impostazioni IP). In base allo standard Ethernet
POWERLINKÆ, l'indirizzo IP è impostato su 192.168.100.xxx. L'ultimo numero è il valore nel parametro 12-60 Node ID (ID nodo). Per il

parametro 12-02 Subnet Mask (Subnet mask), l'indirizzo IP è impostato su 255.255.255.0 e non può essere modificato.
Procedura

Collegare l'LCP al servoazionamento o al modulo di sistema per il quale occorre modificare Node ID (ID Nodo).

Premere il tasto Hand On per più di 1 s per utilizzare l'LCP come interfaccia di controllo.
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Premere il pulsante Main Menu, quindi scorrere fino al sottomenu 12-** Ethernet e premere OK.

Scorrere fino al sottomenu 12-6* Ethernet POWERLINK e premere OK.

Modificare l'ID del nodo PSM 510/DAM 510 con il valore desiderato (1-239).

Premere OK per confermare la selezione e attendere il completamento della procedura di assegnazione dell'ID.

Spegnere e riaccendere per garantire che tutte le modifiche dell'ID siano effettive e operative nel bus di campo.

6.4.2.2 Impostazione dell'ID del nodo per un singolo servoazionamento tramite il modulo di ali-
mentazione (PSM 510) o il modulo di accesso decentralizzato (DAM 510) tramite LCP
È inoltre possibile modificare il Node ID (ID nodo) di un servoazionamento quando l'LCP è collegato a PSM 510 o DAM 510. Questa
funzionalità si trova nel gruppo di parametri 54-** ID Assignment (Assegnazione ID) nel sottogruppo 54-1* Manual (Manuale).
Procedura

Collegare l'LCP al PSM 510/DAM 510, che è collegato ai servoazionamenti e ai moduli di sistema per i quali occorre modifi-
care il Node ID (ID nodo).

Premere il tasto Hand On per più di 1 s per utilizzare l'LCP come interfaccia di controllo di PSM 510/DAM 510.

Premere il pulsante Main Menu (Menu principale), quindi scorrere fino al sottomenu 12-** Ethernet e premere OK.

Scorrere fino al sottomenu 12-6* Ethernet POWERLINK e premere OK.

Modificare l'ID del nodo PSM 510/DAM 510 con il valore desiderato (1-239) premendo il tasto OK.

Tornare in Main Menu (Menu principale) e selezionare il parametro 54-** ID Assignment (Assegnazione ID).

Selezionare il parametro 54-1* Manual (Manuale).

Soltanto PSM 510: nel parametro 54-01 Epl id assignment line (Linea di assegnazione dell'id Epl) selezionare la porta Ethernet
X1 o X2. Il PSM 510 assegna gli ID al dispositivo selezionato tramite la porta selezionata e la rete di bus di campo. Sulla porta
DAM 510, X2 verrà utilizzato automaticamente.

Selezionare il parametro 54-12 Epl ID assignment start id (ID iniziale per l'assegnazione dell'ID Epl), quindi selezionare un
valore valido (1–239). Il valore sarà assegnato al dispositivo nell'indice di posizione specificato. Il PSM 510/DAM 510 collega-
to all'LCP è in posizione 0 e il primo dispositivo raggiungibile sulla porta selezionata è l'indice di posizione 1 e così via.

Selezionare il parametro 54-14 Manual Epl ID assignment start (Avvio assegnazione manuale dell'ID Epl) e cambiare lo stato
da [0] ready (pronto) a [1] start (avvio).

Premere OK per confermare la selezione e attendere il completamento della procedura di assegnazione dell'ID.

Verificare che l'assegnazione dell'ID sia stata completata correttamente utilizzando i parametri:

Parametro 54-15 Epl ID assignment state (Stato dell'assegnazione dell'ID Epl)

Parametro 54-16 Epl ID assignment error code (Codice di errore di assegnazione dell'ID Epl)

Parametro 54-17 Epl ID assignment device count (Numero di dispositivi per l'assegnazione dell'ID Epl)

Spegnere e riaccendere per garantire che tutte le modifiche dell'ID siano effettive e operative nel bus di campo.

Se si verifica un errore durante l'assegnazione dell'ID, l'errore rilevato viene visualizzato sull'LCP. Possono essere segnalati i seguenti
errori:

Stato NMT non valido

Commento non valido

Porta Ethernet non valida

ID nodo non valido

Assegnazione ID non riuscita

Indirizzo MAC duplicato

Versione SW non valida

Assegnazione incompleta

Nessun dispositivo trovato

Errore interno

6.4.3 Assegnazione ID a più dispositivi
Quando si assegna un ID a più dispositivi (ad esempio quando si imposta una nuova rete), utilizzare il sottostrumento VLTÆ Servo

Toolbox DAM ID assignment (Assegnazione ID DAM) (per maggiori informazioni vedere la Guida alla programmazione VLT® Servo
Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô )).

L'impostazione contemporanea degli ID di tutti i servoazionamenti collegati a un modulo di accesso decentralizzato (DAM 510) o a
un modulo di alimentazione (PSM 510) può essere effettuata anche tramite l'LCP quando è collegato al DAM 510/PSM 510.
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6.4.3.1 Impostazione degli ID del nodo di tutti i servoazionamenti e dei moduli di sistema su una
linea di modulo di accesso decentralizzato (DAM 510)/modulo di alimentazione (PSM 510)
L'assegnazione automatica dell'ID PSM 510/DAM 510 viene utilizzata per l'impostazione automatica degli Node IDs (ID nodo) su tutti
i servoazionamenti e moduli di sistema per una linea PSM 510/DAM 510 specificata. Questa funzionalità si trova nel gruppo di para-
metri 54- ** ID Assignment (Assegnazione ID) nel sottogruppo 54-0* Automatic (Automatica).
Procedura

Collegare l'LCP al PSM 510/DAM 510, che è collegato ai servoazionamenti e ai moduli di sistema per i quali occorre modifi-
care il Node ID (ID nodo).

Premere il tasto Hand On per più di 1 s per utilizzare l'LCP come interfaccia di controllo di PSM 510/DAM 510.

Premere il pulsante Main Menu (Menu principale), quindi scorrere fino al sottomenu 12-** Ethernet e premere OK.

Scorrere fino al sottomenu 12-6* Ethernet POWERLINK e premere OK.

Modificare l'ID del nodo PSM 510/DAM 510 con il valore desiderato (1-239) premendo il tasto OK.

Tornare in Main Menu (Menu principale) e selezionare il parametro 54-** ID Assignment (Assegnazione ID).

Selezionare il parametro 54-0* Automatic (Automatica).

Soltanto PSM 510: nel parametro 54-01 Epl id assignment line (Linea di assegnazione dell'id Epl) selezionare la porta Ethernet
X1 o X2. Il PSM 510 assegna gli ID al dispositivo selezionato tramite la porta selezionata e la rete di bus di campo. Sulla porta
DAM 510, X2 verrà utilizzato automaticamente.

Selezionare il parametro 54-02 Epl ID assignment start id (ID iniziale per l'assegnazione dell'ID Epl), quindi selezionare un
valore valido (1–239). Il valore sarà assegnato al dispositivo nell'indice di posizione specificato. Il PSM 510/DAM 510 collega-
to all'LCP è in posizione 0 e il primo dispositivo raggiungibile sulla porta selezionata è l'indice di posizione 1 e così via.

Selezionare il parametro 54-03 Automatic Epl ID assignment start (Avvio assegnazione ID Epl automatica) e cambiare lo stato
da [0] ready (pronto) a [1] start (avvio).

Premere OK per confermare la selezione e attendere il completamento della procedura di assegnazione dell'ID.

Verificare che l'assegnazione dell'ID sia stata completata correttamente utilizzando i parametri:

Parametro 54-04 Epl ID assignment state (Stato dell'assegnazione dell'ID Epl)

Parametro 54-05 Epl ID assignment error code (Codice di errore di assegnazione dell'ID Epl)

Parametro 54-06 Epl ID assignment device count (Numero di dispositivi per l'assegnazione dell'ID Epl)

Spegnere e riaccendere per garantire che tutte le modifiche dell'ID siano effettive e operative nel bus di campo.

Se si verifica un errore durante l'assegnazione dell'ID, l'errore rilevato viene visualizzato sull'LCP. Possono essere segnalati i seguenti
errori:

Stato NMT non valido

Commento non valido

Porta Ethernet non valida

ID nodo non valido

Assegnazione ID non riuscita

Indirizzo MAC duplicato

Versione SW non valida

Assegnazione incompleta

Nessun dispositivo trovato

Errore interno

6.5 Assegnazione ID PROFINET®
Ciascun dispositivo PROFINETÆ ha bisogno di un nome di dispositivo e un indirizzo IP. L'indirizzo IP e il nome del dispositivo sono
assegnati dal controllore I/O quando viene stabilita la connessione con il dispositivo I/O. 

L'assegnazione dell'indirizzo IP è necessaria anche quando si utilizza la comunicazione indiretta tramite il software VLTÆ Servo Tool-

box (per maggiori informazioni vedere la Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT®
Flexmotionô )).

L'indirizzo IP e il nome del dispositivo possono essere assegnati anche tramite PRONETA, uno strumento gratuito di supporto
nell'analisi e nella configurazione delle reti PROFINETÆ.

6.6 Tempo di accensione
Il tempo massimo di accensione per i moduli di sistema è pari a 15 s. Tale durata corrisponde al tempo che intercorre tra l'alimenta-
zione del sistema con la tensione ausiliaria e la completa inizializzazione del modulo.
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Il tempo di accensione riportato è indicativo. Lo stato esatto del modulo è visibile tramite la parola di stato.

N O T A

Non azionare alcun modulo di sistema finché non sono tutti accesi correttamente.

Se si montano due moduli PSM 510 in parallelo, accendere entrambi contemporaneamente (con un ritardo massimo di un
secondo).

6.7 Tempo di carica del modulo di sistema
Il tempo di carica del sistema è determinato dal tempo di carica più lungo di ogni singolo modulo di sistema.

Lo stato esatto di ciascun modulo è visibile tramite la parola di stato.

N O T A

Non azionare i moduli di sistema né i convertitori di frequenza decentralizzati fino a quando non sono completamente cari-
chi. Attendere che PSM 510, DAM 510 e ACM 510 si trovino nello stato Operation enabled (Funzionamento abilitato) prima di
impostare ISD 510/DSD 510 nello stato Operation enabled (Funzionamento abilitato).

Tabella 25: Tempo di carica del collegamento CC (UDC) per PSM 510, DAM 510 e ACM 510

Specifica Unità PSM 510 DAM 510 ACM 510

Tempo di carica UDC s 2,0 2,0 3,5

6.8 Accensione del sistema ISD 510/DSD 510
Completare il cablaggio del servosistema prima di applicare la tensione ai servoazionamenti ISD 510/DSD 510. Questo cablaggio
fornisce la tensione di alimentazione e i segnali di comunicazione per il servosistema. Si tratta di un requisito fondamentale per il
funzionamento dei servoazionamenti ISD 510/DSD 510.

È possibile accendere il servosistema in due modi:

Se il modulo di alimentazione (PSM 510) è alimentato con rete elettrica, STO e UAUX, viene stabilita la comunicazione con il con-
trollore interno PSM 510 e il collegamento CC e UAUX sono automaticamente inviati tramite il backlink al DAM 510 e poi tras-
messi ai servoazionamenti collegati.

Se il modulo di alimentazione (PSM 510) è alimentato solo da UAUX, allora il PSM 510, il DAM 510 e le unità di controllo del
servoazionamento sono in funzione.

6.8.1 Procedura per l'accensione del sistema ISD 510/DSD 510
Procedura

Inserire l'alimentazione UAUX per consentire la comunicazione con PSM 510, DAM 510 e i servoazionamenti ISD 510/DSD
510.

Accendere la rete.

Impostare PSM 510 sullo stato Normal operation (Funzionamento normale).

Impostare DAM 510 sullo stato Normal operation (Funzionamento normale).

A questo punto PSM 510, DAM 510 e i servoazionamenti ISD 510/DSD 510 sono pronti per il funzionamento.

6.9 Librerie
Le librerie fornite per il sistema ISD 510 possono essere utilizzate in:

TwinCATÆ V2 e V3

SIMOTION SCOUTÆ V5.2:

C240 a partire da V4.4

D410-2 a partire da V4.4

D425-2 a partire da V4.4

D435-2 a partire da V4.4

D445-2 a partire da V4.4
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D455-2 a partire da V4.4

P320 a partire da V4.4

Ambiente Automation Studioô  (versione 3.0.90 e 4.x, piattaforma supportata SG4) per integrare facilmente la funzionalità senza
la necessità di uno speciale tempo di ciclo del movimento sul controllore.

TiA a partire da V15

I blocchi funzioni forniti sono conformi allo standard PLCopenÆ. Non è necessario conoscere la comunicazione del bus di campo
sottostante e/o il profilo CiA DS 402 CANopenÆ.

La libreria contiene:

Blocchi funzioni per il controllo e il monitoraggio dei servoazionamenti ISD 510/DSD 510 e dei moduli di sistema.

Blocchi funzioni per tutti i comandi di movimento disponibili dei servoazionamenti ISD 510/DSD 510.

Blocchi funzioni per il controllo e il monitoraggio di PSM 510, DAM 510 e ACM 510.

Blocchi funzioni e strutture per la creazione di profili Basic CAM (CAM di base).

Blocchi funzioni e strutture per la creazione di profili Labeling CAM (CAM di etichettatura).

6.10 Programmazione con Automation Studio™

6.10.1 Requisiti per la programmazione con Automation Studio™
I seguenti file sono necessari per integrare i servoazionamenti ISD 510/DSD 510 e i moduli di sistema in un progettoô  Automation
Studio:

Pacchetto di librerie per il servosistema ISD 510: Danfoss_VLT_ServoMotion_V_x_y_z.zip

XDD file (Descrizione del dispositivo XML) per il servoazionamento ISD 510 standard: 0x0300008D_ISD510_S.xdd

XDD file (Descrizione del dispositivo XML) per il servoazionamento ISD 510 avanzato: 0x0300008D_ISD510_A.xdd

XDD file (Descrizione del dispositivo XML) per il servoazionamento DSD 510 standard: 0x0300008D_DSD510_S.xdd

XDD file (Descrizione del dispositivo XML) per il servoazionamento DSD 510 avanzato: 0x0300008D_DSD510_A.xdd

XDD file (Descrizione del dispositivo XML) per il modulo di alimentazione (PSM 510): 0x0300008D_PSM.xdd

XDD file (Descrizione del dispositivo XML) per il modulo di accesso decentralizzato (DAM 510): 0x0300008D_DAM.xdd

XDD file (Descrizione del dispositivo XML) per il modulo di condensatori ausiliari (ACM 510): 0x0300008D_ACM.xdd

6.10.2 Creazione di progetti Automation Studio™
Le procedure descritte in questo capitolo si applicano alle versioni 3.0.90 e V4.x di Automation Studioô  se non diversamente specifi-
cato.

Le informazioni su come installare Automation Studioô  sono riportate nel dettaglio nella guida Automation Studioô . Aprire B&R
Help Explorer e passare a [Automation software → Software Installation → Automation Studio].

Le informazioni su come creare un progetto Automation Studioô  sono riportate nel dettaglio nella guida Automation Studioô .

V3.0.90:

Aprire B&R Help Explorer e passare a [Automation Software → Getting Started → Creating programs with Automation Studio →
First project with X20 CPU].

V4.x:

Aprire B&R Help Explorer e passare a [Automation Software → Getting Started → Creating programs with Automation Studio →
Example project for a target system with CompactFlash].

6.10.3 Inclusione delle librerie di servoazionamento in un progetto Automation Studio™
Procedura

In Logical View (Vista logica), aprire la voce di menu [File → Import...].

Nella finestra successiva, selezionare il file Danfoss_VLT_ServoMotion_V_x_y_z.zip (in base alla posizione sul disco rigido).

Fare clic su Open (Apri).

Assegnare le librerie alla CPU nella finestra successiva.
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Fare clic su Finish (Fine). A questo punto le librerie sono integrate nel progetto Automation Studioô .

Durante l'integrazione viene creata una nuova cartella contenente le librerie ISD:

DDS_Drive

Contiene unità organizzative del programma (POU) definite da PLCopenÆ (nome che inizia con MC_) e POU defi-
nite da Danfoss (nome che inizia con DD_). Le POU Danfoss forniscono funzionalità aggiuntive per l'asse.

È possibile combinare POU definite da PLCopenÆ con POU definite da Danfoss.

I nomi delle POU destinate al servoazionamento finiscono tutti con _DDS.

DDS_PSM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di alimenta-
zione (PSM).

I nomi delle POU destinate al PSM terminano tutti con _PSM.

DDS_DAM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di accesso
decentralizzato (DAM).

I nomi delle POU destinate al DAM terminano tutti con _DAM.

DDS_ACM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per l'Auxiliary Capacitors
Module (ACM).

I nomi delle POU destinate all'ACM terminano tutti con _ACM.

DDS_BasCam

Contiene POU per la creazione di CAM di base.

DDS_LabCam

Contiene POU per la creazione di CAM di etichettatura.

DDS_Intern

Contiene POU che sono necessarie internamente per le librerie.

Non utilizzare queste POU nelle applicazioni.

Quando si integra il pacchetto DDS_Drive, alcune librerie standard vengono integrate automaticamente, a meno che non
facciano già parte del progetto.

e
3

0
b

g
3

3
7

.1
0

Illustrazione 56: Librerie standard
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N O T A

Non rimuovere queste librerie, in caso contrario le librerie di servoazionamento Danfoss non funzioneranno.

6.10.4 Costanti all'interno della libreria DDS_Drive
All'interno della libreria sono definiti i seguenti elenchi di costanti:

Danfoss_VLT_ServoMotion

Contiene le informazioni sulla versione della libreria.

DDS_AxisErrorCodes

Costanti per i codici di errore dell'asse.

È possibile leggere i codici di errore usando il blocco funzioni MC_ReadAxisError_DDS e/o DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals

Costanti per i segnali di traccia dell'asse.

Da utilizzare con il blocco funzioni DD_Trace_DDS.

DDS_BasCam

Costanti per la creazione di CAM di base.

DDS_CamParsingErrors

Costanti per l'analisi dei problemi di un CAM.

Il motivo dell'errore viene fornito dal blocco funzioni MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants

Costanti per gli errori all'interno delle POU.

Il motivo viene fornito in un output ErrorInfo.ErrorID disponibile in tutte le POU.

DDS_Intern

Costanti necessarie internamente per la libreria.

Non sono destinate all'uso in un'applicazione.

DDS_LabCam

Costanti per la creazione di CAM di etichettatura.

DDS_SdoAbortCodes

Costanti per errori di lettura e scrittura dei parametri.

Il motivo viene fornito in un output AbortCode (Codice di annullamento) disponibile in alcune POU.

PSM_ErrorCodes

Costanti per i codici di errore del modulo di alimentazione (PSM 510).

È possibile leggere i codici di errore usando il blocco funzioni DD_ReadPsmError_PSM e/o DD_ReadPsmWarning_PSM.

PSM_TraceSignals

Costanti per i segnali di traccia del modulo di alimentazione (PSM 510).

Da utilizzare con il blocco funzioni DD_Trace_PSM.

DAM_ErrorCodes

Costanti per i codici di errore del modulo di accesso decentralizzato (DAM 510).

È possibile leggere i codici di errore usando il blocco funzioni DD_ReadDamError_DAM e/o DD_ReadDamWarning_DAM.

DAM_TraceSignals

Costanti per i segnali di traccia del modulo di accesso decentralizzato (DAM 510).

Da utilizzare con il blocco funzioni DD_Trace_DAM.

ACM_ErrorCodes
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Costanti per i codici di errore dell'Auxiliary Capacitors Module (ACM 510).

È possibile leggere i codici di errore usando il blocco funzioni DD_ReadAcmError_ACM e/o DD_ReadAcmWarning_ACM.

ACM_TraceSignals

Costanti per i segnali di traccia dell'Auxiliary Capacitors Module (ACM 510).

Da utilizzare con il blocco funzioni DD_Trace_ACM.

6.10.5 Creazione di un'istanza AXIS_REF_DDS in Automation Studio™
Procedura

Creare un'istanza del blocco funzioni AXIS_REF_DDS (situato nella cartella DDS_Drive) per ogni servoazionamento da con-
trollare o monitorare. 

Per creare un collegamento al servoazionamento fisico, collegare ogni istanza di AXIS_REF_DDS a un servoazionamento fisi-
co. In questo modo si ottiene la rappresentazione logica di un servoazionamento fisico.

Aprire Logical View (Vista logica).

Inizializzare ogni istanza con il proprio numero di nodo e il nome dello slot a cui è collegata (per esempio, IF3).

Inizializzare ogni istanza di un convertitore di frequenza con il proprio DriveType (Tipo di convertitore).

Esempio

Illustrazione 57: Creazione di un istanza di AXIS_REF_DDS e impostazione dei valori iniziali

6.10.6 Creazione di un'istanza PSM_REF in Automation Studio™
Procedura

Creare un'istanza del blocco funzioni PSM_REF (situato nella cartella DDS_PSM) per ogni modulo di alimentazione da con-
trollare o monitorare. 

Per creare un collegamento con il PSM fisico, collegare ciascuna istanza di PSM_REF a un PSM fisico. In questo modo si ot-
tiene la rappresentazione logica di un PSM fisico.

Aprire Logical View (Vista logica).

Inizializzare ogni istanza con il proprio numero di nodo e il nome dello slot a cui è collegata (per esempio, IF3).

6.10.7 Creazione di un'istanza DAM_REF in Automation Studio™
Procedura

Creare un'istanza del blocco funzioni DAM_REF (situato nella cartella DDS_DAM) per ogni modulo di accesso decentralizza-
to (DAM) da controllare o monitorare. 

Per creare un collegamento con il DAM fisico, collegare ciascuna istanza di DAM_REF a un DAM fisico. In questo modo si
ottiene la rappresentazione logica di un DAM fisico.

Aprire Logical View (Vista logica).

Inizializzare ogni istanza con il proprio numero di nodo e il nome dello slot a cui è collegata (per esempio, IF3).
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6.10.8 Creazione di un'istanza ACM_REF in Automation Studio™
Procedura

Creare un'istanza del blocco funzioni ACM_REF (situato nella cartella DDS_ACM) per ogni modulo di condensatori ausiliari
(ACM) da controllare o monitorare. 

Per creare un collegamento con l'ACM fisico, collegare ciascuna istanza di ACM_REF a un ACM fisico. In questo modo si
ottiene la rappresentazione logica di un ACM fisico.

Aprire Logical View (Vista logica).

Inizializzare ogni istanza con il proprio numero di nodo e il nome dello slot a cui è collegata (per esempio, IF3).

6.10.9 Importazione di un servoazionamento in Automation Studio™

N O T A

Per ciascun servoazionamento fisico, aggiungere una voce a Physical View (Vista fisica) di Automation Studioô .

6.10.9.1 Versione V3.0.90
Procedura

Selezionare la voce di menu [Tools → Import Fieldbus Device...].

Selezionare il file XDD (ad esempio, 0x0300008D_ISD510_S.xdd o 0x0300008D_ISD510_A.xdd) nella propria posizione sul dis-
co rigido. Questa importazione deve essere effettuata soltanto una volta per progetto. Il dispositivo diventa così noto per
Automation Studioô .

Aggiungere quindi il servoazionamento all'interfaccia Ethernet POWERLINKÆ del controllore in Physical View (Vista fisica):

Fare clic con il tasto destro del mouse sul controllore in Physical View (Vista fisica) e selezionare [Open POWERLINK].

Fare clic con il tasto destro del mouse sull'interfaccia e selezionare Insert (Inserisci).

Nella finestra Select controller module (Seleziona il modulo del controllore), selezionare il servoazionamento nel gruppo
POWERLINK Devices (Dispositivi POWERLINK).

Fare clic su Next (Avanti).

Nella finestra successiva, inserire il numero di nodo del servoazionamento.

e3
0b
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13

.1
0

Illustrazione 58: Aggiunta di un servoazionamento al progetto in V3.0.90

6.10.9.2 Versione V4.x
Procedura

Selezionare la voce di menu [Tools → Import Fieldbus Device...].
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Selezionare il file XDD (ad esempio, 0x0300008D_ISD510_S.xdd o 0x0300008D_ISD510_A.xdd) nella propria posizione sul dis-
co rigido. Il dispositivo diventa così noto per Automation Studioô .

Aggiungere quindi il servoazionamento all'interfaccia Ethernet POWERLINKÆ del controllore in Physical View (Vista fisica):

Selezionare la voce di menu [Open → System Designer] per mostrare il System Designer (Progettista del sistema).

Per aggiungere un modulo hardware a Physical View (Vista fisica) o System Designer (Progettista del sistema), selezio-
nare il servoazionamento nel gruppo POWERLINK nella toolbox Hardware Catalog (Catalogo Hardware).

Trascinare il modulo selezionato nella posizione desiderata per collegarlo al modulo hardware, all'interfaccia di rete o
allo slot selezionato.

Per cambiare il numero di nodo, fare clic con il tasto destro del mouse sul dispositivo e selezionare [Node Number →
Change Node Number].
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Illustrazione 59: Aggiunta di un servoazionamento al progetto in V4.x

6.10.10 Importazione di PSM 510, DAM 510 e ACM 510 in Automation Studio™

N O T A

Per ogni modulo di alimentazione (PSM 510), modulo di accesso decentralizzato (DAM 510) e modulo di condensatori ausi-
liari (ACM 510) fisico aggiungere una voce a Physical View (Vista fisica) di Automation Studioô .

6.10.10.1 Versione V3.0.90
Procedura

Selezionare la voce di menu [Tools → Import Fieldbus Device...].

Selezionare il file XDD per il PSM 510, DAM 510 o ACM 510 dalla propria posizione sul disco rigido. Questa importazione
deve essere effettuata soltanto una volta per progetto. Il dispositivo diventa così noto per Automation Studioô .

Modulo di alimentazione (PSM 510): 0x0300008D_PSM.xdd

Modulo di accesso decentralizzato (DAM 510): 0x0300008D_DAM.xdd

Modulo di condensatori ausiliari ACM 510: 0x0300008D_ACM.xdd

A questo punto aggiungere il PSM 510, DAM 510 o ACM 510 all'interfaccia Ethernet POWERLINKÆ del controllore in Physical

View (Vista fisica):

Fare clic con il tasto destro del mouse sul controllore in Physical View (Vista fisica) e selezionare [Open POWERLINK].

Fare clic con il tasto destro del mouse sull'interfaccia e selezionare Insert... (Inserisci...).

Nella finestra Select controller module (Seleziona il modulo del controllore), selezionare il PSM 510, il DAM 510 o
l'ACM 510 nel gruppo POWERLINK Devices (Dispositivi POWERLINK).

Fare clic su Next (Avanti).

Nella finestra successiva, inserire il numero di nodo del PSM 510, del DAM 510 o dell'ACM 510.
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Illustrazione 60: Un servoazionamento PSM 510, un servoazionamento DAM 510 e due servoazionamenti ISD 510 aggiunti

nell'interfaccia Ethernet POWERLINKÆ in V3.0.90

6.10.10.2 Versione V4.x
Procedura

Selezionare la voce di menu [Tools → Import Fieldbus Device...].

Selezionare il file XDD per il PSM 510, DAM 510 o ACM 510 dalla propria posizione sul disco rigido. Il dispositivo diventa così
noto per Automation Studioô .

Modulo di alimentazione (PSM 510): 0x0300008D_PSM.xdd

Modulo di accesso decentralizzato (DAM 510): 0x0300008D_DAM.xdd

Modulo di condensatori ausiliari ACM 510: 0x0300008D_ACM.xdd

A questo punto aggiungere il PSM 510, DAM 510 o ACM 510 all'interfaccia Ethernet POWERLINKÆ del controllore in Physical

View (Vista fisica):

Selezionare la voce di menu [Open → System Designer] per mostrare il System Designer (Progettista del sistema).

Per aggiungere un modulo hardware a Physical View (Vista fisica) o System Designer (Progettista del sistema), selezio-
nare PSM 510, DAM 510, o ACM 510 nel gruppo POWERLINK nella toolbox Hardware Catalog (Catalogo Hardware).

Trascinare il modulo selezionato nella posizione desiderata per collegarlo al modulo hardware, all'interfaccia di rete o
allo slot selezionato.

Per cambiare il numero di nodo, fare clic con il tasto destro del mouse sul dispositivo e selezionare [Node Number →
Change Node Number].

PSM: Danfoss _VLT_R_PSM

DAM: Danfoss _VLT_R_DAM

ACM: Danfoss _VLT_R_ACM
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Illustrazione 61: Un servoazionamento PSM 510, un servoazionamento DAM 510 e due servoazionamenti ISD 510 aggiunti

nell'interfaccia Ethernet POWERLINKKÆ in V4.x

6.10.11 Configurazione e mappatura I/O
Procedura

Parametrizzare la configurazione I/O dei servoazionamenti ISD 510/DSD 510 in modo che la libreria abbia accesso a tutti gli
oggetti necessari.

Fare clic con il tasto destro del mouse sulla voce del servoazionamento ISD 510/DSD 510 e selezionare Open I/O Config-

uration (Apri la configurazione I/O) in V3.0.90 e Configuration (Configurazione) in V4.x.

Nella sezione Channels (Canali) modificare la Cyclic transmission (Trasmissione ciclica) dei seguenti oggetti:

Tutti i sottoindici dell'oggetto 0x5050 (Lib pdo rx_I5050 ARRAY[]) in Write (Scrivi).

Tutti i sottoindici dell'oggetto 0x5051 (Lib pdo tx_I5051 ARRAY[]) in Read (Leggi).
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Parametrizzare la configurazione I/O del modulo di alimentazione (PSM 510), del modulo di accesso decentralizzato (DAM
510) e del modulo di condensatori ausiliari (ACM 510) in modo che la libreria abbia accesso a tutti gli oggetti necessari.

Fare clic con il tasto destro del mouse sulla voce PSM/DAM/ACM e selezionare Open I/O Configuration (Apri la configura-
zione I/O) in V3.0.90 e Configuration (Configurazione) in V4.x.

Nella sezione Channels (Canali) modificare la Cyclic transmission (Trasmissione ciclica) dei seguenti oggetti:

Tutti i sottoindici dell'oggetto 0x5050 (Lib pdo rx_I5050 ARRAY[]) in Write (Scrivi).

Tutti i sottoindici dell'oggetto 0x5051 (Lib pdo tx_I5051 ARRAY[]) in Read (Leggi).

Queste impostazioni configurano la comunicazione ciclica con il dispositivo. Questi parametri sono necessari per il funzio-
namento della libreria.

N O T A

È possibile usare la funzione copia e incolla per applicare la stessa configurazione di I/O a più dispositivi dello stes-
so tipo.

Impostare Module supervised (Modulo supervisionato) su off (disattivato) per i servoazionamenti e il PSM/DAM/ACM. Il para-
metro si trova nella configurazione I/O del dispositivo.
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Illustrazione 62: Configurazione I/O di un dispositivo ISD 510
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Illustrazione 63: Mappatura I/O dopo una configurazione corretta

Mappare gli ingressi e le uscite dell'istanza del blocco funzioni AXIS_REF_DDS e dei punti di dati fisici del servoazionamento
ISD 510 (qui myAxis è un'istanza di AXIS_REF_DDS):
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Illustrazione 64: Mappatura I/O di un servoazionamento ISD 510

Mappare gli ingressi e le uscite dell'istanza dei blocchi funzioni PSM_REF, DAM_REF e ACM_REF e di conseguenza dei punti
di dati fisici del PSM/DAM/ACM.

6.10.12 Impostazione del tempo di ciclo PLC
Il tempo di ciclo minimo è 400 µs. I dispositivi del servosistema possono eseguire tempi di ciclo Ethernet POWERLINKÆ in multipli di
400 µs e 500 µs. I dispositivi vengono parametrizzati automaticamente dal PLC all'avviamento, a seconda della configurazione
Ethernet POWERLINKÆ dell'interfaccia fisica. È possibile accedere alla configurazione Ethernet POWERLINKÆ facendo clic con il tasto

destro del mouse su [CPU → Open IF3 POWERLINK Configuration] in Physical View (Vista fisica) per V3.0.90 o su [PLK → Configura-
tion] per V4.x.

N O T A

Assicurarsi che i tempi di ciclo dell'attività del programma PLC ed Ethernet POWERLINKÆ siano gli stessi. In caso contrario, i
dati potrebbero andare persi e le prestazioni potrebbero risultare compromesse.
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Illustrazione 65: Finestra di configurazione Ethernet POWERLINK<Æ per parametrizzare il tempo di ciclo Ethernet POWERLINKÆ

Procedura per l'impostazione del tempo PLC in Automation Studioô

Fare clic con il tasto destro del mouse su [CPU → Open Software Configuration] per V3.0.90 e su [CPU → Configuration →
Timing] per V4.x in Physical View (Vista fisica).

Assicurarsi che il tempo di ciclo PLC sia lo stesso del tempo di ciclo Ethernet POWERLINKÆ.

6.10.13 Collegamento al PLC
Le informazioni su come collegarsi al PLC sono riportate nel dettaglio nella guida Automation Studioô .

Versione V3.0.90:

Aprire B&R Help Explorer (Guida Explorer B&R) e passare a [Automation Software → Getting Started → Creating programs with Auto-
mation Studio → First project with X20 CPU → Configure online connection].

Versione V4.x:

Aprire B&R Help Explorer (Guida Explorer B&R) e passare a [Automation Software → Getting Started → Creating programs in Auto-
mation Studio → Example project for a target system with CompactFlash].

6.11 Programmazione con TwinCAT®

6.11.1 Requisiti per la programmazione con TwinCAT®
Per integrare i servoazionamenti ISD 510/DSD 510 e i PSM 510, DAM 510 o ACM 510 in un progetto TwinCATÆ sono necessari i se-
guenti file:

Libreria del servosistema ISD 510: Danfoss_VLT_ServoMotion_V_x_y_z.lib

File ESI (informazioni slave EtherCATÆ) per il servoazionamento ISD 510 standard: Danfoss_ISD510_S.xml

File ESI (informazioni slave EtherCATÆ) per il servoazionamento ISD 510 avanzato: Danfoss_ISD510_A.xml

File ESI (informazioni slave EtherCATÆ) per il servoazionamento DSD 510 standard: Danfoss_DSD510_S.xml

File ESI (informazioni slave EtherCATÆ) per il servoazionamento DSD 510 avanzato: Danfoss_DSD510_A.xml

File ESI (informazioni slave EtherCATÆ) per il modulo di alimentazione: Danfoss_PSM510.xml

File ESI (informazioni slave EtherCATÆ) per il modulo di accesso decentralizzato: Danfoss_DAM510.xml

File ESI (informazioni slave EtherCATÆ) per il modulo di condensatori ausiliari: Danfoss_ACM510.xml

6.11.2 Creazione di un progetto TwinCAT®
Le informazioni su come installare TwinCATÆ sono disponibili nel Sistema informativo Beckhoff (https://infosys.beckhoff.com/).
Aprire il sistema informativo e selezionare [TwinCAT 2 → TwinCAT Quick Start → Installation].

Le informazioni su come creare un progetto TwinCATÆ sono disponibili nel Sistema informativo Beckhoff (https://infosys.beckh-
off.com/). Aprire il sistema informativo e selezionare [TwinCAT 2 → TwinCAT Quick Start oppure TwinCAT 2 → TX1200 TwinCAT PLC
→ TwinCAT PLC Control].

6.11.3 Inclusione di una libreria TwinCAT® in un progetto TwinCAT®
Procedura

Nella scheda Resources (Risorse) di TwinCATÆ PLC Control, aprire Library Manager (Manager libreria).

Nell'area in alto a sinistra della finestra Library Manager (Manager libreria), fare clic con il tasto destro del mouse e selezio-
nare Additional Library... (Libreria aggiuntiva...).
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Selezionare il file Danfoss_VLT_ServoMotion_V_x_y_z (in base alla posizione nel disco rigido).

Fare clic su Open (Apri). A questo punto le librerie sono integrate nel progetto TwinCATÆ PLC control.
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Illustrazione 66: Library Manager dopo aver incluso la libreria ServoMotion

All'interno della libreria le POU sono organizzate in cartelle:

DDS_Drive

Contiene unità organizzative del programma (POU) definite da PLCopenÆ (nome che inizia con MC_) e POU defi-
nite da Danfoss (nome che inizia con DD_). Le POU Danfoss forniscono funzionalità aggiuntive per l'asse.

È possibile combinare POU definite da PLCopenÆ con POU definite da Danfoss.

I nomi delle POU destinate ai servoazionamenti finiscono tutti con _DDS.

DDS_PSM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di alimenta-
zione (PSM 510).

I nomi delle POU destinate al PSM 510 terminano tutti con _PSM.

DDS_DAM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di accesso
decentralizzato (DAM 510).

I nomi delle POU destinate al DAM 510 terminano tutti con _DAM.

DDS_ACM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per l'Auxiliary Capacitors
Module (ACM 510).

I nomi delle POU destinate all'ACM 510 terminano tutti con _ACM.

DDS_BasCam

Contiene POU per la creazione di CAM di base.

DDS_LabCam

Contiene POU per la creazione di CAM di etichettatura.

DDS_Intern

Contiene POU che sono necessarie internamente per le librerie.

Non utilizzare queste POU nelle applicazioni.

Quando si integra la libreria VLT® Integrated Servo Drive, alcune librerie standard vengono integrate automaticamente, a
meno che non facciano già parte del progetto.
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N O T A

Non rimuovere queste librerie, in caso contrario le librerie DDS non funzioneranno.

6.11.4 Costanti all'interno della libreria DDS_Drive
All'interno della libreria sono definiti i seguenti elenchi di costanti:

Danfoss_VLT_ServoMotion

Contiene le informazioni sulla versione della libreria.

DDS_AxisErrorCodes

Costanti per i codici di errore dell'asse.

È possibile leggere i codici di errore usando il blocco funzioni MC_ReadAxisError_DDS e/o DD_ReadAxisWarning_DDS.

DDS_AxisTraceSignals

Costanti per i segnali di traccia dell'asse.

Da utilizzare con il blocco funzioni DD_Trace_DDS.

DDS_BasCam

Costanti per la creazione di CAM di base.

DDS_CamParsingErrors

Costanti per l'analisi dei problemi di un CAM.

Il motivo dell'errore viene fornito dal blocco funzioni MC_CamTableSelect_DDS.

DDS_FB_ErrorConstants

Costanti per gli errori all'interno delle POU.

Il motivo viene fornito in un output ErrorInfo.ErrorID disponibile in tutte le POU.

DDS_Intern

Costanti necessarie internamente per la libreria.

Non sono destinate all'uso in un'applicazione.

DDS_LabCam

Costanti per la creazione di CAM di etichettatura.

DDS_SdoAbortCodes

Costanti per errori di lettura e scrittura dei parametri.

Il motivo viene fornito in un output AbortCode (Codice di annullamento) disponibile in alcune POU.

PSM_ErrorCodes

Costanti per i codici di errore del modulo di alimentazione (PSM 510).

È possibile leggere i codici di errore usando il blocco funzioni DD_ReadPsmError_PSM e/o DD_ReadPsmWarning_PSM.

PSM_TraceSignals

Costanti per i segnali di traccia del modulo di alimentazione (PSM 510).

Da utilizzare con il blocco funzioni DD_Trace_PSM.

DAM_ErrorCodes

Costanti per i codici di errore del modulo di accesso decentralizzato (DAM 510).

È possibile leggere i codici di errore usando il blocco funzioni DD_ReadDamError_DAM e/o DD_ReadDamWarning_DAM.

DAM_TraceSignals

Costanti per i segnali di traccia del modulo di accesso decentralizzato (DAM 510).

Da utilizzare con il blocco funzioni DD_Trace_DAM.

ACM_ErrorCodes
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Costanti per i codici di errore dell'Auxiliary Capacitors Module (ACM 510).

È possibile leggere i codici di errore usando il blocco funzioni DD_ReadAcmError_ACM e/o DD_ReadAcmWarning_ACM.

ACM_TraceSignals

Costanti per i segnali di traccia dell'Auxiliary Capacitors Module (ACM 510).

Da utilizzare con il blocco funzioni DD_Trace_ACM.

6.11.5 Creazione di un'istanza AXIS_REF_DDS in TwinCAT®
Procedura

Creare un'istanza di un blocco funzioni AXIS_REF_DDS (situato nella cartella DDS_Drive) per il servoazionamento ISD 510 da
controllare o monitorare.

Ripetere il passaggio 1 per ogni servoazionamento supplementare.

Esempio
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Illustrazione 67: Creazione di un'istanza di AXIS_REF_DDS

6.11.6 Creazione di un'istanza PSM_REF in TwinCAT®
Procedura

Creare un'istanza del blocco funzioni PSM_REF (situato nella cartella DDS_PSM) per ogni modulo di alimentazione da con-
trollare o monitorare.

Ripetere il passaggio 1 per ogni PSM 510 supplementare.

6.11.7 Creazione di un'istanza DAM_REF in TwinCAT®
Procedura

Creare un'istanza del blocco funzioni DAM_REF (situato nella cartella DDS_DAM) per ogni modulo di accesso decentralizza-
to (DAM) da controllare o monitorare.

Ripetere il passaggio 1 per ogni DAM 510 supplementare.

6.11.8 Creazione di un'istanza ACM_REF in TwinCAT®
Procedura

Creare un'istanza del blocco funzioni ACM_REF (situato nella cartella DDS_ACM) per ogni modulo di condensatori ausiliari
da controllare o monitorare.

Ripetere il passaggio 1 per ogni ACM 510 supplementare.

6.11.9 Aggiunta di un progetto PLC a TwinCAT® System Manager
Per creare un collegamento tra il progetto TwinCATÆ PLC Control e TwinCATÆ System Manager, collegare il progetto salvato, soprat-
tutto gli ingressi e le uscite, a TwinCATÆ System Manager:

Procedura
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Per aggiungere informazioni sul progetto in TwinCATÆ System Manager, fare doppio clic su PLC-Configuration (Configura-

zione-PLC) e selezionare Append PLC project... (Aggiungi progetto PLC...).

Nella finestra Insert IEC 1131 Project (Inserisci il progetto IEC 1131), selezionare il file di informazioni sul progetto in base alla
posizione sul disco rigido. Il file ha lo stesso nome del progetto PLC, ma con l'estensione .tpy.

Fare clic su Open (Apri).

6.11.10 Importazione dei dispositivi in TwinCAT®
La seguente procedura è un esempio di come importare un servoazionamento ISD 510 in TwinCATÆ.

Procedura

Copiare il file ESI Danfoss ISD 510 S.xml nella cartella TwinCAT Installation Folder\Io\EtherCAT (Cartella d'installazione di Twin-
CAT\Io\EtherCAT) sul disco rigido. Questa operazione deve essere effettuata soltanto una volta per progetto. Il TwinCATÆ

System Manager cerca automaticamente i file ESI in questa posizione sul disco rigido durante l'avviamento.

Per aggiungere un master EtherCATÆ, fare clic con il tasto destro del mouse su [I/O-Configuration → I/O Devices] e selezio-

nare Append Device... (Aggiungi dispositivo...).

Nella seguente finestra, selezionare [EtherCAT → EtherCAT] e fare clic su OK.
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Illustrazione 68: Aggiunta di un master EtherCAT al progetto

Selezionare Device 1 (EtherCAT) (Dispositivo 1 (EtherCAT)) e selezionare il Network Adapter (Adattatore di rete) corretto a
destra della finestra nella scheda Adapter (Adattatore).

Per aggiungere un modulo di alimentazione, fare clic con il tasto destro del mouse su Device1 (EtherCAT) (Dispositivo 1
(EtherCAT)) e selezionare Append Box... (Aggiungi casella...).

Nella finestra Insert EtherCAT Device (Inserisci dispositivo EtherCAT), selezionare [Danfoss GmbH → VLTÆ FlexMotion → VLTÆ

Power Supply Module PSM 510] e fare clic su OK.

Per aggiungere un modulo di accesso decentralizzato, fare clic con il tasto destro del mouse su Device1 (EtherCAT) (Disposi-
tivo 1 (EtherCAT)) e selezionare Append Box... (Aggiungi casella...).

Nella finestra Insert EtherCAT Device (Inserisci dispositivo EtherCAT), selezionare [Danfoss GmbH → VLTÆ FlexMotion → VLTÆ

Decentral Access Module] e fare clic su OK.

Per aggiungere un modulo di condensatori ausiliari, fare clic con il tasto destro del mouse su Device1 (EtherCAT) (Dispositivo
1 (EtherCAT) e selezionare Append Box... (Aggiungi casella...).

Nella finestra Insert EtherCAT Device (Inserisci dispositivo EtherCAT), selezionare [Danfoss GmbH → VLTÆ FlexMotion → VLTÆ

Auxiliary Capacitors Module] e fare clic su OK.

Per aggiungere un servoazionamento nel modulo di accesso decentralizzato DAM 510, fare clic con il tasto destro del
mouse su Box 1 (VLT® Decentral Access Module) (Casella 1 (VLT® Decentral Access Module)) e selezionare Append Box... (Ag-
giungi casella...).

AQ262449648484it-000201 / 175R1135 | 101Danfoss A/S © 2020.10

Messa in funzione

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



12.



Nella finestra Insert EtherCAT Device (Inserisci dispositivo EtherCAT), selezionare [Danfoss GmbH → VLTÆ FlexMotion →

VLTÆISD 510 Integrated Servo Drive Standard] e fare clic su OK.
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Illustrazione 69: Aggiunta del servoazionamento al progetto
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Illustrazione 70: TwinCAT System Manager dopo l'integrazione del progetto PLC e l'aggiunta di un modulo di accesso decen-

tralizzato e di due servoazionamenti ISD 510

Rispondere con No alla domanda se il servoazionamento viene utilizzato come asse NC. Se il servoazionamento deve invece
essere utilizzato come asse NC, vedere 6.11.15 Configurazione come asse NC TwinCAT®

N O T A

Aggiungere una voce nel master EtherCATÆ del TwinCAT System Manager per ciascun servoazionamento fisico,
PSM 510, DAM 510 e ACM 510. Aggiungere il servoazionamento alla linea DAM 510 corretta.

6.11.11 Configurazione e mappatura I/O
Quando si collegano più servoazionamenti ISD 510/DSD 510, collegare la porta C (X2) del precedente servoazionamento alla porta A
(X1) del servoazionamento successivo. Eseguire anche l'assegnazione delle porte per il modulo di accesso decentralizzato (DAM
510).

Se la configurazione hardware è già presente, la funzione Scan devices (Scansiona i dispositivi) di TwinCATÆ System Manager può
essere utilizzata per aggiungere automaticamente i dispositivi collegati per la configurazione nell'ordine corretto.
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Utilizzando TwinCATÆ System Manager, configurare il servoazionamento ISD 510/DSD 510 in modo che la mappatura PDO corris-
ponda ai requisiti della libreria.

Procedura (esempio per un servoazionamento ISD 510)

Fare clic sulla voce del servoazionamento ISD 510.

Selezionare la scheda Slots (Slot) a destra nella finestra.

Rimuovere la configurazione PDO corrente selezionando la voce Module 1 (CSV PDO) (Modulo 1 (CSV PDO)) nella casella
Slot.

Fare clic su X.

Selezionare Library PDO (Libreria DOP) nella casella Module (Modulo).

Fare clic su <.
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Illustrazione 71: Servoazionamento ISD 510 con la configurazione I/O corretta

6.11.12 Collegamento delle variabili di ingresso e di uscita ai punti di dati fisici
Utilizzare TwinCATÆ System Manager per collegare le variabili di ingresso e uscita del programma PLC a ingressi e uscite fisici del
dispositivo. In questo modo si garantisce che la libreria abbia accesso a tutti gli oggetti necessari.

A V V I S O

Ripetere i passaggi 2-22 per Box 1 (VLTÆ Power Supply Module) e l'istanza myPSM.

Ripetere i passaggi 2-22 per Box 2 (VLTÆ Decentral Access Module) e l'istanza myDAM.

Procedura

Selezionare Library TxPDO (Libreria TxPDO) tramite il menu [I/O-Configuration → I/O Devices → Device1 (EtherCAT) → Box
1 (VLT Decentral Access Module) → Drive 1 (VLT ISD 510 Integrated Servo Drive) → Module 1 (Library PDO) → Library
TxPDO].

Selezionare tutte le voci da Lib pdo tx1 a Lib pdo tx9 a destra della finestra.

e3
0b

h5
19

.1
0

Illustrazione 72: Collegamento degli ingressi e delle uscite ai punti di dati fisici

Fare clic con il tasto destro del mouse e selezionare Change Multi Link... (Cambia il collegamento multiplo...).
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Nella finestra Attach Variable 36.0 Byte(s) (Input) (Associa la variabile 36,0 Byte (Ingresso)), selezionare [PLC-Configuration →
MyFirstFlexMotionProject → Standard → .myAxis.TPDO]. Assicurarsi che l'opzione Matching Size (Dimensione corrispon-
dente) sia selezionata nella finestra Attach Variable (Associa variabile).

Fare clic su OK.

Fare clic sulla libreria RxPDO tramite il menu [I/O-Configuration → I/O Devices → Device1 (EtherCATô ) → Box1 (VLTô  De-
central Access Module) → Drive2 (VLTô  ISD 510 Integrated Servo Drive) → Module1 (Library PDO) → Library RxPDO].

Selezionare tutte le voci da Lib pdo rx1 a Lib pdo rx9 a destra della finestra.

Fare clic con il tasto destro del mouse e selezionare Change Multi Link... (Cambia il collegamento multiplo...).

Nella finestra Attach Variable 36.0 Byte(s) (Output) (Associa la variabile 36,0 Byte (Uscita)), selezionare [PLC-Configuration →
MyFirstIsd510Project → Standard → .myAxis.RPDO].

Fare clic su OK.

Fare clic con il tasto destro del mouse su WcState (StatoWc) tramite il menu [I/O-Configuration → I/O Devices → Device1
(EtherCATô ) → Box1 (VLTô  Decentral Access Module) → Drive2 (VLTô  ISD 510 Integrated Servo Drive) → WcState] e sele-
zionare Change Link... (Cambia collegamento...).

Nella finestra Attach Variable State (Input) (Associa variabile di stato (Ingresso)), selezionare [PLC-Configuration → MyFirst-
Isd510Project → Standard → .myAxis.WcState].

Fare clic su OK.

Fare clic con il tasto destro del mouse su State (Stato) tramite il menu [I/O-Configuration → I/O Devices → Device1 (Ether-
CATô ) → Box1 (VLTô  Decentral Access Module) → Drive2 (VLTô  ISD 510 Integrated Servo Drive) → InfoData] e selezionare
Change Link...(Cambia collegamento...).

Nella finestra Attach Variable State (Input) (Associa variabile di stato (Uscita)), selezionare [PLC-Configuration → MyFirst-
Isd510Project → Standard → .myAxis.State].

Fare clic su OK.

Fare clic con il tasto destro del mouse su netId tramite il menu [I/O-Configuration → I/O Devices Device1 (EtherCAT→) →
Box1 (VLTÆ Decentral Access Module) → Drive2 (VLT→ ISD 510 Integrated Servo Drive) → InfoData → AdsAddr] e selezio-

nare Change Link... (Cambia collegamento...).

Nella finestra Attach Variable netId (Input) (Associa variabile netId (Ingresso)), selezionare [PLC-Configuration → MyFirst-
Isd510Project → Standard → .myAxis.AmsNetId].

Fare clic su OK.

Fare clic con il tasto destro del mouse su Port (Porta) tramite [I/O-Configuration → I/O Devices → Device1 (EtherCAT→) →
Box1 (VLT→ Decentral Access Module) → Drive2 (VLT→ ISD 510 Integrated Servo Drive) → InfoData → AdsAddr] e selezio-
nare Change Link... (Cambia collegamento...).

Nella finestra Attach Variable port (Input) (Associa variabile porta (Ingresso)), selezionare [PLC-Configuration → MyFirst-
Isd510Project → Standard → .myAxis.NodeNumber].

Fare clic su OK.

6.11.13 Ritrasferimento delle mappature nel programma PLC
Per ritrasferire le mappature nel programma PLC, selezionare Activate Configuration... (Attiva configurazione...) nella voce di menu
Actions (Azioni).

Dopo l'installazione in TwinCATÆ PLC Control, la configurazione TwinCATÆ avviene conformemente all'Illustrazione 73 (qui myAxis e

mySecondAxis sono istanze di AXIS_REF_DDS, myPSM è un'istanza di PSM_REF e myDAM è un'istanza di DAM_REF). Gli indirizzi effetti-
vi possono essere diversi.
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Illustrazione 73: Configurazione di TwinCATÆ Mappatura I/O di due servoazionamenti, un PSM 510 e un DAM 510

N O T A

Collegare il PSM 510, il DAM 510 e l'ACM 510 a un'unità SYNC e i servoazionamenti ISD 510/DSD 510 a un'altra unità. In ques-
to modo la comunicazione con il PSM 510 e il DAM 510 è protetta contro le interruzioni se l'alimentazione UAUX dei servoa-
zionamenti viene disinserita a causa di un errore.

6.11.14 Impostazione del tempo di ciclo PLC in TwinCAT® PLC Control
Il tempo di ciclo minimo è 400 µs. I dispositivi ISD 510 possono eseguire tempi di ciclo EtherCATÆ in multipli di 400 µs o 500 µs. I
dispositivi vengono parametrizzati automaticamente dal PLC all'avviamento, a seconda della configurazione EtherCATÆ dell'inter-
faccia fisica. Per accedere al tempo di base del sistema, selezionare [SYSTEM-Configuration → Real-Time Settings] in TwinCATÆ Sys-
tem Manager. I multipli di questo tempo di base possono quindi essere utilizzati come tempi di ciclo EtherCATÆ.

N O T A

Impostare il tempo di ciclo dell'attività del programma PLC in modo che sia lo stesso del tempo di ciclo EtherCATÆ. In caso
contrario, i dati potrebbero andare persi e le prestazioni potrebbero risultare compromesse.

Procedura

Fare doppio clic su Task configuration (Configurazione dell'attività) nella scheda Resources (Risorse).
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Assicurarsi che il tempo di ciclo PLC sia lo stesso del tempo di ciclo EtherCATÆ.
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Illustrazione 74: Configurazione dell'attività per parametrizzare il tempo di ciclo PLC

N O T A

Dopo aver modificato il tempo di ciclo dell'attività in TwinCAT® PLC Control, eseguire un ReScan della config-
urazione PLC all'interno del TwinCAT® System Manager per aggiornare le impostazioni. In seguito, attivare la
configurazione nel PLC.

6.11.15 Configurazione come asse NC TwinCAT®
I servoazionamenti possono essere utilizzati con la funzionalità NC integrata di TwinCATÆ. Ogni operazione relativa al PSM 510 e al
DAM 510 deve essere effettuata come descritto in 6.11.2 Creazione di un progetto TwinCAT®.
Procedura

Oltre al file Danfoss_VLT_ServoMotion_V_x_y_z.lib, comprende anche il file TcMC2.lib.

Creare un'istanza di AXIS_REF (invece di AXIS_REF_DDS) per ogni servoazionamento ISD 510/DSD 510 utilizzato come asse
NC.

Aggiungere il progetto PLC in TwinCATÆ System Manager, importare i dispositivi e aggiungerli a TwinCATÆ; tuttavia, nell'ul-

timo passaggio, alla domanda se il servoazionamento viene utilizzato come asse NC rispondere con Yes (Sì). A questo punto
viene creata automaticamente un'attività NC.

6.11.15.1 Configurazione I/O dei servoazionamenti utilizzati come assi NC
In TwinCATÆ System Manager selezionare una configurazione I/O diversa per i servoazionamenti usati come assi NC.

Procedura

In base al modo di funzionamento da utilizzare, selezionare lo slot CSP PDO o CSV PDO. Per impostazione predefinita è map-
pato e preselezionato CSV PDO. Mappare le seguenti variabili se è necessario il servoazionamento VLT® Integrated Servo
Drive per lavorare con CSP PDO:

Nella scheda Settings (Impostazioni) dell'asse NC, selezionare [NC-Configuration → NC-Task 1 SAF → Axes → Axis 1].
Fare clic sul pulsante Link To (all Types)... (Collegamento a (tutti i tipi)) e selezionare il servoazionamento desiderato.

Nella stessa scheda, selezionare la Unit (Unità) preferita.

In base all'unità selezionata, regolare il Scaling Factor (Fattore di scala) per l'encoder dell'asse tramite il menu [NC-Configu-
ration → NC-Task 1 SAF → Axes → Axis 1 → Axis 1_Enc] nella scheda Parameter (Parametro). Esempio: quando è seleziona-
ta l'unità Degrees (Gradi), il fattore di scala è 360°/220 = 0,00034332275390625.

Impostare Reference Velocity (Velocità di riferimento) nella scheda Parameter (Parametro) tramite il menu [NC-Configuration
→ NC-Task 1 SAF → Axes → Axis 1 → Axis 1_Enc].

Impostare Output Scaling Factor (Fattore di scala di uscita) (Velocità) su 125.

Testare la funzionalità e la configurazione nella scheda Online dell'asse.

6.11.16 Collegamento al PLC
Le informazioni su come collegarsi al PLC sono riportate nel dettaglio nel sistema informativo Beckhoff .

Aprire il sistema informativo e passare a [TwinCAT 2 → TwinCAT System Manager → Operation → Controls → Choose Target Sys-
tem].
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6.12 Linee guida alla programmazione di Automation Studio™ e TwinCAT®
Raccomandazioni per l'implementazione:

Inizializzare una sola volta all'inizio del programma i parametri che di solito non cambiano. In Automation Studioô  usare la se-
zione _INIT.

Richiamare i blocchi funzioni che forniscono informazioni di stato o di errore con Enable input (Abilita input) all'inizio del pro-
gramma.

Utilizzare un'istanza del blocco funzioni MC_Power_DDS per ciascun asse al fine di controllarne lo stadio di potenza. Richiamare
questo blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_PSM per ogni PSM 510 per controllare la tensione del collegamento CC sull'usci-
ta. Richiamare questo blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_DAM per ogni DAM 510 per controllare la tensione del collegamento CC sull'us-
cita. Richiamare questo blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_ACM per ogni ACM 510 per controllare la connessione tra il collegamento CC e
l'ACM 510. Richiamare questo blocco funzioni in ciascun ciclo PLC.

Richiamare i blocchi funzioni che eseguono i comandi (di movimento) alla fine del programma.

Non utilizzare le POU della libreria (cartella) DDS_Intern.

Non modificare il riferimento per l'asse su un blocco funzioni mentre è occupato.

N O T A

L'elenco completo dei parametri si trova nella Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510,
MSD 510 (VLT® Flexmotionô ).

6.13 Programmazione con SIMOTION SCOUT®

6.13.1 Requisiti per la programmazione con SIMOTION SCOUT®
I seguenti file sono necessari per integrare i moduli del servosistema in un progettoÆ SIMOTION SCOUT. Nel nome file, 2.xx rappre-

senta il numero di versione e yyyymmdd rappresenta la data.

Tabella 26: File richiesti

Modulo di sistema File richiesto

Intero servosistema Pacchetto di librerie per il servosistema ISD 510: Danfoss_VLT_ServoMo-
tion_V_x_y_z.zip

File di guida online (.chm): programmazione con SIMOTION SCOUTÆ

Modulo di servoazionamento SDM 511/
SDM 512

File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-SDM-yyyymmdd.xml

Servoazionamento ISD 510 integrato File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

Servoazionamento DSD 510 decentraliz-
zato

File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

Modulo di alimentazione PSM 510 File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Modulo di accesso decentralizzato DAM
510

File GSDML (descrizione stazione generale):
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Modulo di sistema File richiesto

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

Modulo di condensatori ausiliari ACM
510

File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.13.2 Collegamento al PLC
Le informazioni su come collegarsi al PLC sono riportate in dettaglio nella guidaÆ SIMOTION SCOUT.

Aprire SIMOTION SCOUT® e passare a [Help → Help Topics → Getting Started with SIMOTION SCOUT → Download the project to the
target system → Connect to selected target devices → Go online].

6.13.3 Creazione di un progetto SIMOTION SCOUT®
Le informazioni su come installare SIMOTION SCOUT®Æ sono disponibili nel Manuale di configurazione SIMOTION SCOUTÆ.

N O T A

Per creare un progetto installare SIMATIC STEP 7 V5.5 o superiore con HF11.

Le informazioni su come creare un progetto in SIMOTION SCOUTÆ sono disponibili in modo dettagliato nella guida online SIMOTION
SCOUTÆ. Aprire SIMOTION SCOUTÆ e passare a [Help → Help Topics → Getting started with SIMOTION SCOUT → Create SIMOTION
device and configure PG/PC communication connection].

6.13.4 Inclusione delle librerie di servoazionamenti in un progetto SIMOTION SCOUT®
La cartella LIBRARIES (LIBRERIE) nella scheda Project (Progetto) contiene le seguenti librerie:

DDS_Drive

Contiene unità organizzative del programma (POU) definite da PLCopenÆ (nome che inizia con MC_) e POU definite da
Danfoss (nome che inizia con DD_). Le POU Danfoss forniscono funzionalità aggiuntive per il servoazionamento.

È possibile combinare POU definite da PLCopenÆ con POU definite da Danfoss.

I nomi delle POU destinate al servoazionamento finiscono tutti con _DDS.

DDS_PSM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di alimentazione (PSM
510).

I nomi delle POU destinate al PSM 510 terminano tutti con _PSM.

DDS_DAM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di accesso decentraliz-
zato (DAM 510).

I nomi delle POU destinate al DAM 510 terminano tutti con _DAM.

DDS_ACM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per l'Auxiliary Capacitors Module
(ACM 510).

I nomi delle POU destinate all'ACM 510 terminano tutti con _ACM.

DDS_BasCam

Contiene POU per la creazione di CAM di base.

DDS_LabCam

Contiene POU per la creazione di CAM di etichettatura.

DDS_Intern

Contiene POU che sono necessarie internamente per le librerie.

Non utilizzare queste POU nelle applicazioni.
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Quando si integra il pacchetto DDS_Drive, alcune librerie standard vengono integrate automaticamente, a meno che non facciano
già parte del progetto.
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Illustrazione 75: Albero del progetto dopo l'inclusione delle librerie del servoazionamento Danfoss

N O T A

Non rimuovere né rinominare queste librerie.

Procedura

Estrarre i file dal file Danfoss_VLT_ServoMotion_V_x_y_z.zip (in base alla posizione sul disco rigido).

Per importare la libreria il file DDS_Xxxx.xml e la cartella XML_DDS_Xxxx devono trovarsi insieme nella stessa cartella.
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Nella scheda Project (Progetto), fare clic con il tasto destro su LIBRARIES (LIBRERIE) e selezionare [Export/import → Import
folders/objects].

e
3
0
b
g
3
5
8
.1

0

Illustrazione 76: Importazione della libreria

Selezionare il file DDS_Intern.xml in base alla posizione sul disco rigido.

Fare clic su OK. A questo punto la libreria è integrata nel progetto SIMOTION SCOUTÆ.

Ripetere i passaggi 2-4 per DDS_BasCam.xml, DDS_Drive.xml, DDS_LabCam.xml, DDS_PSM.xml, DDS_DAM.xml e
DDS_ACM.xml.

6.13.5 Importazione dei dispositivi in SIMOTION SCOUT®

N O T A

Per ogni servoazionamento fisico, PSM 510, DAM 510 o ACM 510, aggiungere una voce alla rete Ethernet PROFINETÆ nello

strumento HW Config (Config.HW).

Procedura

Aprire lo strumento HW Config (Config. HW).

Selezionare [Options → Install GSD File...].

Per aggiungere un servoazionamento, selezionare il file xml (in base alla posizione sul disco rigido) e fare clic su Install

(Installa). Nel nome file, 2.xx rappresenta il numero di versione e yyyymmdd rappresenta la data.

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

Ripetere i passaggi 2 e 3 per:

Modulo di alimentazione (PSM 510): GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Modulo di accesso decentralizzato (DAM 510):

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

Modulo di condensatori ausiliari ACM 510: GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml
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Trascinare il dispositivo Danfoss Drive Servo IRT su una rete Ethernet PROFINETÆ esistente.

Trovare il dispositivo di servoazionamento denominato Danfoss Drive Servo IRT espandendo la voce PROFINET IO (IO

PROFINET) nel catalogo hardware sul lato destro dello schermo e selezionando [Additional Field Devices → Drives
→ VLTÆ FlexMotion]. Se il dispositivo non è visibile, aggiornare il catalogo hardware selezionando [Options → Up-
date catalog).

Espandere Drive Object 1 (Oggetto del convertitore di frequenza 1) e la cartella Profile (Profilo) nel catalogo hardware sul
lato destro dello schermo e trascinare Danfoss Telegram (Telegramma Danfoss) nello slot libero di Drive Object 1 (Oggetto
del convertitore di frequenza 1) in fondo allo schermo.
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Illustrazione 77: Trascinamento di un telegramma Danfoss in uno slot libero

Per impostare i parametri di comunicazione, fare doppio clic sull'icona che rappresenta il servoazionamento nella finestra
principale che mostra la rete Ethernet.

Nella scheda General (Generale), inserire il nome nel campo Device name (Nome del dispositivo).

Nella scheda General (Generale), fare clic sul pulsante Ethernet... per impostare l'indirizzo IP del servoazionamento, quindi
fare clic su OK.

Ripetere i passaggi 6-9 per:

Modulo di alimentazione (PSM 510): VLT PSM IRT

Modulo di accesso decentralizzato (DAM 510): VLT DAM IRT

Modulo di condensatori ausiliari ACM 510: VLT ACM IRT

6.13.6 Configurazione dell'assegnazione IP e del nome del dispositivo

N O T A

Se viene usato più di un servoazionamento nella stessa rete PROFINETÆ, ciascun servoazionamento deve avere un nome e un
indirizzo IP diversi.

L'assegnazione dell'indirizzo IP è necessaria anche quando si utilizza la comunicazione indiretta tramite il softwareÆ VLT Ser-

vo Toolbox (per maggiori informazioni vedere la Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510,
MSD 510 (VLT® Flexmotionô )).

Procedura

Aprire il menu [PLC → Ethernet → Edit Ethernet Node].
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Nella finestra successiva, fare clic su Browse (Esplora).
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Illustrazione 78: Modifica del nodo Ethernet

Tutti i nodi Ethernet accessibili sono mostrati in questa finestra.

I servoazionamenti ISD 510 sono elencati nel tipo di dispositivo VLT® ISD 510.

I servoazionamenti DSD 510 sono elencati nel tipo di dispositivo VLT® DSD 510.

Selezionare il servoazionamento desiderato e fare clic su OK (utilizzare il pulsante Flash per identificare il servoazionamento
specifico).
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Illustrazione 79: Selezione del servoazionamento

Nella finestra Edit Ethernet Node (Modifica nodo Ethernet), selezionare l'opzione Use IP parameters (Usa i parametri IP).
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Inserire l'IP address (Indirizzo IP) e la Subnet mask (Subnet mask) e fare clic su Assign IP configuration (Assegna configura-
zione IP).
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Illustrazione 80: Inserimento dell'indirizzo IP e assegnazione della configurazione IP
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Inserire il nome del dispositivo precedentemente selezionato e fare clic su Assign Name (Assegna nome), quindi su Close

(Chiudi).
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Illustrazione 81: Assegnazione del nome del dispositivo

6.13.7 Creazione di un dominio di sincronizzazione
Il dominio di sincronizzazione è un gruppo di dispositivi PROFINETÆ sincronizzati con un normale orologio ciclico. Un dispositivo
funge da master di sincronizzazione (generatore dell'orologio). Tutti gli altri dispositivi sono slave di sincronizzazione.

N O T A

Tutti i dispositivi che si scambiano dati tramite Isochronous Real-Time (IRT) devono appartenere allo stesso dominio di sin-
cronizzazione.

Procedura

Aprire lo strumento HW Config (Config. HW).

Selezionare la stazione con i dispositivi PROFINETÆ da utilizzare nella comunicazione IRT.

Selezionare l'interfaccia I/O PROFINETÆ nella sezione Station/IO system (Stazione/sistema IO).
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Selezionare il menu [Edit → PROFINET IO → Domain management].
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Illustrazione 82: Gestione di dominio

Nella scheda Sync Domain (Dominio di sincronizzazione), selezionare la stazione nel campo superiore della sezione Nodes

(Nodi).

Nel campo inferiore della sezione Nodes (Nodi), fare doppio clic sul dispositivo che dovrebbe essere configurato come mas-
ter di sincronizzazione.

Quando si apre la finestra Device properties (Proprietà del dispositivo), selezionare Sync master (Master di sincronizzazione)
come Synchronization role (Ruolo di sincronizzazione) e fare clic su OK.
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Illustrazione 83: Proprietà del dispositivo: master di sincronizzazione

Nella finestra Domain management (Gestione del dominio), selezionare tutti i dispositivi da configurare come slave di sin-
cronizzazione nella sezione Nodes (Nodi), (tenere premuto il tasto CTRL per selezionare più di un dispositivo).

Fare clic sul pulsante Device Properties (Proprietà del dispositivo).
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16.

Nella finestra Device Properties (Proprietà del dispositivo), selezionare Sync slave (Slave di sincronizzazione) come Synchroni-

zation role (Ruolo di sincronizzazione), quindi fare clic su OK.
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Illustrazione 84: Proprietà del dispositivo: slave di sincronizzazione

Nella finestra Domain management (Gestione del dominio), fare clic su OK.

Selezionare la stazione con i dispositivi PROFINETÆ.

Selezionare il menu [Edit → Object Properties].

Nella finestra successiva, aprire la scheda Isochronous Tasks (Attività isocrone), selezionare la modalità isocrona per la mod-
ifica dei dati I/O e fare clic su OK.
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Illustrazione 85: Utilizzare i dati di I/O in modalità isocrona per il servoazionamento

Fare clic sul dispositivo VLT® ISD 510 IRT.

Fare doppio clic su PN-IRT-Inteface (Interfaccia PN-IRT-) in Module (Modulo).
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Nella finestra successiva, aprire la scheda IO Cycle (Ciclo IO) e impostare il campo Assign IO device in isochronous mode (Asse-
gna il dispositivo IO in modalità isocrona) su Servo.
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Illustrazione 86: Assegnare il dispositivo IO in modalità isocrona

6.13.8 Configurazione di una topologia
È necessario configurare e parametrizzare la topologia.
Procedura

Aprire lo strumento HW Config (Config. HW).

Selezionare il percorso per il sistema I/O PROFINETÆ o il modulo PROFINETÆ, ad esempio una serie DanfossISD 510.

Selezionare il menu [Edit → PROFINET IO → Topology].

Nella finestra successiva, selezionare la scheda Graphic view (Vista grafica).
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Illustrazione 87: Scheda Vista Grafica nell'editor della topologia

Collegare il dispositivo PROFINETÆ con la stazione. Stabilire le connessioni tra le porte tenendo premuto il tasto sinistro del
mouse e tracciando una linea tra le due porte.

Una volta effettuate tutte le connessioni, fare clic su OK.
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6.13.9 Definizione di Send Clock Time (Tempo di invio orologio) e di Update Time (Tempo di ag-
giornamento)

6.13.9.1 Configurazione del Send Clock Time (Tempo di invio orologio)
Procedura

Aprire lo strumento HW Config (Config. HW).

Selezionare la stazione con i dispositivi PROFINETÆ da utilizzare nella comunicazione IRT, ad esempio PNxIO.

Selezionare il menu [Edit → PROFINET IO → Domain management].

Nella finestra successiva, aprire la scheda Sync Domain (Dominio di sincronizzazione) e nel campo Send clock time [ms]

(Tempo di invio orologio [ms]), selezionare un tempo adeguato per il processo, ad esempio 1.000 ms, quindi fare clic su OK.
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Illustrazione 88: Configurazione di Send Clock (Invio orologio) per PROFINETÆ IRT

6.13.9.2 Configurazione di Update Time (Tempo di aggiornamento)
Procedura

Aprire lo strumento HW Config (Config. HW).

Selezionare il percorso per il sistema I/O PROFINETÆ.

Selezionare il menu [Edit → Object properties].

Nella finestra successiva, aprire la scheda Update Time (Tempo di aggiornamento), evidenziare il dispositivo I/O e fare clic
sul pulsante Edit (Modifica).

Nella finestra successiva (Edit Update Time/Mode) (Modifica Tempo/Modalità di aggiornamento), selezionare Update Time

(Tempo di aggiornamento) e fare clic su OK.
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Illustrazione 89: Impostare Update Time (Tempo di aggiornamento)
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N O T A

Gli orologi del ciclo di sistema del programma PLC devono essere uguali a quelli di send clock (invio orologio) PRO-
FINETÆ; in caso contrario, i dati possono andare persi e le prestazioni possono risultare compromesse.

6.13.10 Accesso agli ingressi e alle uscite
SIMOTION SCOUTÆ consente l'accesso agli ingressi e alle uscite del dispositivo SIMOTION attraverso l'immagine di processo delle
operazioni cicliche che utilizzano variabili I/O.
Procedura

Aprire la scheda Project (Progetto) e fare doppio clic sull'elemento ADDRESS LIST (ELENCO INDIRIZZI) nella sottostruttura del
dispositivo, ad esempio C240 [C240 PN].
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Illustrazione 90: Elenco degli indirizzi nel sistema di navigazione del progetto

Nella finestra successiva (vista dettagliata), creare una variabile per i dati PPO in entrata e in uscita per ogni dispositivo.
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Illustrazione 91: Vista dettagliata dell'elenco degli indirizzi

Impostare le seguenti proprietà per ciascuna variabile:

Name (della variabile I/O)

I/O address

Data type: ARRAY OF BYTE

Array length: 36

Process image: IPOsynchronousTask

N O T A

L'indirizzo I/O deve corrispondere alla configurazione del dispositivo nello strumento HW Config (Config. HW).

Le variabili I/O possono essere create solamente in modalità offline.
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6.13.11 Programmazione con Danfoss VLT® Servo Motion Library
Prima di utilizzare i tipi di dati, le funzioni o i blocchi funzioni delle librerie, nella sezione dell'interfaccia deve essere utilizzata la
seguente struttura:

USELIB DDS_BasCam, DDS_Drive, DDS_LabCam, DDS_PSM, DDS_DAM, DDS_ACM;

Ulteriori informazioni su come utilizzare i tipi di dati, le funzioni e i blocchi funzioni delle librerie sono disponibili in dettaglio nella
guida online di SIMOTION SCOUTÆ. Aprire SIMOTION SCOUT® e andare su [Help → Help Topics → Programming → Integration of ST
in SIMOTION → Using libraries → Using data types, functions and function blocks from libraries].

N O T A

Nelle applicazioni non utilizzare le POU, le costanti e i tipi di dati definiti dall'utente (UDT) che iniziano con iDD_.

6.13.12 Creazione di un'istanza AXIS_REF_DDS in SIMOTION SCOUT®
Creare un'istanza di AXIS_REF_DDS (situato nella cartella DDS_Drive) per ogni servoazionamento da controllare o monitorare. Cias-
cuna istanza di AXIS_REF_DDS è la rappresentazione logica di un servoazionamento fisico.

N O T A

L'istanza della struttura AXIS_REF_DDS deve essere creata come variabile globale (variabile nella sezione di interfaccia di
un'unità dichiarata con VAR_GLOBAL).

Nella struttura AXIS_REF_DDS, assegnare la variabile InputLogAddress (Inserisci l'indirizzo del log) solamente una volta all'inizio del
programma di applicazione per ogni asse. In questo modo si specifica l'indirizzo logico di base di ingresso del modulo I/O dal HW
Config. Per questa inizializzazione, utilizzare la funzione di sistema _getLogicalAddressOfIoVariable(). Assegnare la variabile InputLo-

gAddress (Inserisci l'indirizzo del log) solamente una volta nel primo ciclo PLC per l'inizializzazione.

Nella struttura AXIS_REF_DDS, assegnare la variabile Quality (Qualità) all'inizio del programma di applicazione per ogni asse in tutti i
cicli. Utilizzare la funzione di sistema _quality.<I/Ovariable>, dove <I/Ovariable> è la variabile contenente i dati ciclici che è stata
assegnata in ADDRESS LIST (ELENCO INDIRIZZI). Eseguire questa assegnazione in tutti i cicli PLC.

Richiedere la funzione DD_UpdateProcessInput_DDS all'inizio del programma di applicazione per ogni dispositivo in tutti i cicli. Ri-
chiedere la funzione DD_UpdateProcessInput_DDS alla fine del programma di applicazione per ogni dispositivo in tutti i cicli.

N O T A

Creare istruzioni e altre parti del programma soltanto tra le richieste di DD_UpdateProcessInput e DD_UpdateProcessOutput.

6.13.13 Creazione di un'istanza PSM_REF in SIMOTION SCOUT®
Creare un'istanza di PSM_REF (situato nella cartella DDS_PSM) per ogni modulo di alimentazione (PMS 510) da controllare o moni-
torare. Ciascuna istanza di PSM_REF è la rappresentazione logica di un servoazionamento fisico.

N O T A

L'istanza della struttura PSM_REF deve essere creata come variabile globale (variabile nella sezione di interfaccia di un'unità
dichiarata con VAR_GLOBAL).

Nella struttura PSM_REF, assegnare la variabile Quality (Qualità) all'inizio del programma di applicazione per ogni modulo di alimen-
tazione in tutti i cicli. Utilizzare la funzione di sistema _quality.<I/Ovariable>, dove <I/Ovariable> è la variabile contenente i dati ciclici
che è stata assegnata in ADDRESS LIST (ELENCO INDIRIZZI). Eseguire questa assegnazione in tutti i cicli PLC.

Richiamare la funzione DD_UpdateProcessInput_PSM all'inizio del programma di applicazione per ogni dispositivo in tutti i cicli. Ri-
chiamare la funzione DD_UpdateProcessOutput_PSM alla fine del programma di applicazione per ogni dispositivo in tutti i cicli.

N O T A

Creare istruzioni e altre parti del programma soltanto tra le richieste di DD_UpdateProcessInput e DD_UpdateProcessOutput.
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6.13.14 Creazione di un'istanza DAM_REF in SIMOTION SCOUT®
Creare un'istanza di DAM_REF (situato nella cartella DDS_DAM) per ogni modulo di accesso decentralizzato (DAM 510) da controllare
o monitorare. Ciascuna istanza di DAM_REF è la rappresentazione logica di un DAM fisico.

N O T A

L'istanza della struttura DAM_REF deve essere creata come variabile globale (variabile nella sezione di interfaccia di un'unità
dichiarata con VAR_GLOBAL).

Nella struttura DAM_REF, assegnare la variabile Quality (Qualità) all'inizio del programma di applicazione per ogni modulo di accesso
decentralizzato in tutti i cicli. Utilizzare la funzione di sistema _quality.<I/Ovariable>, dove <I/Ovariable> è la variabile contenente i
dati ciclici che è stata assegnata in ADDRESS LIST (ELENCO INDIRIZZI). Eseguire questa assegnazione in tutti i cicli PLC.

Richiamare la funzione DD_UpdateProcessInput_DAM all'inizio del programma di applicazione per ogni dispositivo in tutti i cicli. Ri-
chiamare la funzione DD_UpdateProcessOutput_DAM alla fine del programma di applicazione per ogni dispositivo in tutti i cicli.

N O T A

Creare istruzioni e altre parti del programma soltanto tra le richieste di DD_UpdateProcessInput e DD_UpdateProcessOutput.

6.13.15 Creazione di un'istanza ACM_REF in SIMOTION SCOUT®
Creare un'istanza di ACM_REF (situato nella cartella DDS_ACM) per ogni modulo di condensatori ausiliari (ACM 510) da controllare o
monitorare. Ciascuna istanza di ACM_REF è la rappresentazione logica di un ACM fisico.

N O T A

L'istanza della struttura ACM_REF deve essere creata come variabile globale (variabile nella sezione di interfaccia di un'unità
dichiarata con VAR_GLOBAL).

Nella struttura ACM_REF, assegnare la variabile Quality (Qualità) all'inizio del programma di applicazione per ogni modulo di con-
densatori ausiliari in tutti i cicli. Utilizzare la funzione di sistema _quality.<I/Ovariable>, dove <I/Ovariable> è la variabile contenente i
dati ciclici che è stata assegnata in ADDRESS LIST (ELENCO INDIRIZZI). Eseguire questa assegnazione in tutti i cicli PLC.

Richiamare la funzione DD_UpdateProcessInput_ACM all'inizio del programma di applicazione per ogni dispositivo in tutti i cicli. Ri-
chiamare la funzione DD_UpdateProcessOutput_ACM alla fine del programma di applicazione per ogni dispositivo in tutti i cicli.

N O T A

Creare istruzioni e altre parti del programma soltanto tra le richieste di DD_UpdateProcessInput e DD_UpdateProcessOutput.

6.13.16 Impostazioni globali del compilatore
Attivare le impostazioni globali del compilatore Permit language extensions (Consenti l'estensione della lingua).
Procedura

Aprire il menu [Options → Settings].

Nella finestra successiva, selezionare la scheda Compiler (Compilatore).
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Attivare la casella Permit language extensions (Consenti le estensioni della lingua) quindi fare clic su OK.
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Illustrazione 92: Impostazioni globali del compilatore

6.13.17 Assegnazione delle attività
Per garantire il funzionamento sincrono, l'applicazione deve utilizzare una Synchronous Task (Attività sincrona) e una Peripheral Fault

Task (Attività per guasti periferici) per valutare gli allarmi.
Procedura

Aprire la scheda Project (Progetto).

Fare doppio clic su EXECUTION SYSTEM (SISTEMA DI ESECUZIONE) nella sottostruttura del dispositivo.
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Illustrazione 93: Sistema di esecuzione nel sistema di navigazione del progetto

Nella finestra successiva, espandere la voce Execution levels (Livelli di esecuzione), quindi selezionare OperationLevels (Livelli
operativi) e SynchronousTask (Attività sincrona) nella struttura ad albero.

Nella finestra SynchronousTask (Attività sincrona) attivare la casella Use task in execution system (Utilizza l'attività nel sistema
di esecuzione).

Fare clic sulla nuova voce IPOsynchronousTask (Attività sincrona IPO) nella struttura ad albero.
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Nell'area Program assignment (Assegnazione del programma) a sinistra della finestra Synchronous Task (Attività sincrona),
assegnare il programma selezionandolo e facendo clic sul pulsante [>>]. Il programma verrà quindi spostato nella sezione
Programs used (Programmi utilizzati) sul lato destro.
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Illustrazione 94: IPOsynchronousTask in Execution System

Nella scheda Task configuration, (Configurazione dell'attività) impostare Number of level overflows in the IPO cycle clock (Nu-
mero di superamenti di livello nel clock del ciclo IPO) su 1 e IPOsynchronousTask / IPO cycle clock (Attività sincrona IPO/clock
del ciclo IPO) su 50%.
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Illustrazione 95: Configurazione di IPOsynchronousTasks

Espandere la voce SystemInterruptTasks (Attività di interruzione del sistema) nella struttura ad albero e selezionare la nuova
voce PeripheralFaultTask (Attività per guasti periferici).

Nella finestra PeripheralFaultTask (Attività per guasti periferici), attivare la casella Use task in execution system (Utilizza l'attivi-
tà nel sistema di esecuzione).

Nell'area Program assignment (Assegnazione del programma) a sinistra della finestra PeripheralFaultTask (Attività per guasti
periferici), assegnare il programma selezionandolo e facendo clic sul pulsante [>>]. Il programma verrà quindi spostato nel-
la sezione Programs used (Programmi utilizzati) sul lato destro.

Fare clic su Close (Chiudi) per salvare e compilare le impostazioni.
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6.14 Linee guida alla programmazione per SIMOTION SCOUT®
Raccomandazioni per l'implementazione:

Assegnare soltanto la variabile InputLogAddress (Inserisci l'indirizzo del log) nella struttura AXIS_REF_DDS una volta per ogni asse
all'inizio del programma. Utilizzare la funzione del sistema _getLogicalAddressOfIoVariable per ottenere questo indirizzo dalla
variabile I/O dell'elenco di indirizzi. Utilizzare l'indirizzo di ingresso del modulo come variabile I/O. Assegnare questa variabile
nel primo ciclo PLC per l'inizializzazione.

Inizializzare una sola volta all'inizio del programma i parametri che di solito non cambiano.

Assegnare soltanto la variabile Quality (Qualità) nella struttura AXIS_REF_DDS una volta per ogni asse all'inizio del programma.
Utilizzare la funzione di sistema _quality.var-name. Eseguire questo controllo in tutti i cicli PLC.

Richiamare i blocchi funzioni DD_UpdateProcessInput_DDS e DD_UpdateProcessOutput_DDS per ogni asse per aggiornare la par-
tizione dell'immagine di processo degli ingressi e delle uscite. Richiamare questi blocchi funzioni in ogni ciclo PLC.

Creare istruzioni e altre parti del programma soltanto tra le richieste dei blocchi funzioni DD_UpdateProcessInput_DDS e DD_Up-

dateProcessOutput_DDS.

Richiamare i blocchi funzioni che forniscono informazioni di stato o di errore con Enable input (Abilita input) all'inizio del pro-
gramma.

Utilizzare un'istanza del blocco funzioni MC_Power_DDS per ciascun asse per controllarne lo stadio di potenza. Richiamare ques-
to blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_PSM per ogni PSM 510 per controllare la tensione del collegamento CC sulle
linee di uscita. Richiamare questo blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_DAM per ogni DAM 510 per controllare la tensione del collegamento CC sulle
linee di uscita. Richiamare questo blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_ACM per ogni ACM 510 per controllare la tensione del collegamento CC sulle
linee di uscita. Richiamare questo blocco funzioni in ogni ciclo PLC.

Richiamare i blocchi funzioni che eseguono i comandi (di movimento) alla fine del programma.

Non utilizzare UDT, POU, elenchi né costanti che iniziano con il prefisso iDD_.

Non modificare il riferimento per l'asse su un blocco funzioni mentre è occupato.

6.15 Programmazione con TIA

6.15.1 Requisiti per la programmazione con TIA
I seguenti file sono necessari per integrare i moduli del servosistema in un progetto TIA. Nel nome file, 2.xx rappresenta il numero di
versione e yyyymmdd rappresenta la data.

Tabella 27: File richiesti

Modulo di sistema File richiesto

Intero servosistema Pacchetto di librerie per il servosistema ISD 510: Danfoss_VLT_ServoMo-
tion_V_x_y_z.zalxx.

Servoazionamento ISD 510 File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

Servoazionamento DSD 510 File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml

Modulo di alimentazione PSM 510 File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Modulo di accesso decentralizzato
DAM 510

File GSDML (descrizione stazione generale):
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Modulo di sistema File richiesto

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

Modulo di condensatori ausiliari
ACM 510

File GSDML (descrizione stazione generale):

GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.15.2 Creazione di un progetto TIA

N O T A

Per creare un progetto installare TIA V15 o superiore.

Le informazioni su come creare un progetto in TIA sono disponibili in modo dettagliato nella guida online TIA. Aprire TIA e passare a
[Help → Information System → Editing projects → Creating and managing projects].

6.15.3 Inclusione delle librerie di servoazionamenti in un progetto TIA
La cartella LIBRARIES (LIBRERIE) nella scheda Project (Progetto) contiene le seguenti librerie:

DDS_Drive

Contiene unità organizzative del programma (POU) definite da PLCopenÆ (nome che inizia con MC_) e POU definite da
Danfoss (nome che inizia con DD_). Le POU Danfoss forniscono funzionalità aggiuntive per il servoazionamento.

È possibile combinare POU definite da PLCopenÆ con POU definite da Danfoss.

I nomi delle POU destinate al servoazionamento finiscono tutti con _DDS.

DDS_PSM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di alimentazione (PSM
510).

I nomi delle POU destinate al PSM 510 terminano tutti con _PSM.

DDS_DAM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di accesso decentraliz-
zato (DAM 510).

I nomi delle POU destinate al DAM 510 terminano tutti con _DAM.

DDS_ACM

Contiene POU definite da Danfoss (nome che inizia con DD_) e assicura la funzionalità per il modulo di condensatori ausiliari
(ACM 510).

I nomi delle POU destinate all'ACM 510 terminano tutti con _ACM.

DDS_BasCam

Contiene POU per la creazione di CAM di base.

DDS_LabCam

Contiene POU per la creazione di CAM di etichettatura.

DDS_Intern

Contiene POU che sono necessarie internamente per le librerie.

Non utilizzare queste POU nelle applicazioni.

Quando si integra il pacchetto DDS_Drive, alcune librerie standard vengono integrate automaticamente, a meno che non facciano
già parte del progetto.

N O T A

Non rimuovere né rinominare queste librerie.
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Illustrazione 96: Inclusione delle librerie di servoazionamenti

Procedura

Espandere la finestra Libraries (Librerie) [1], quindi selezionare ed espandere la sezione Global libraries (Librerie globali) [2].

Fare clic con il tasto destro del mouse sull'area vuota [3], quindi selezionare la voce di menu Retrieve library... (Recupera
libreria...) [4].

Selezionare il file Danfoss_VLT_ServoMotion_V_x_y_z.zal1x (in base alla posizione nel disco rigido).

6.15.4 Importazione dei dispositivi in TIA

N O T A

Per ogni servoazionamento fisico, PSM 510, DAM 510 o ACM 510, aggiungere una voce alla rete EthernetÆ PROFINET

nell'Hardware Catalog (Catalogo Hardware).

Procedura
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Aprire l'Hardware Catalog (Catalogo Hardware).

Selezionare [Options → Manage general station description files]

Nella scheda Installed GSDs (GSD installati) [1], selezionare il percorso sorgente [2] dove si trovano i file.

Per aggiungere un servoazionamento, selezionare uno dei file xml [3] e fare clic su Install (Installa). Nel nome file, 2.xx rap-
presenta il numero di versione e yyyymmdd rappresenta la data.

GSDML-V2.xx-Danfoss-ISD-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DSD-yyyymmdd.xml
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Ripetere i passaggi 2 e 3 per:

Modulo di alimentazione (PSM 510): GSDML-V2.xx-Danfoss-PSM-yyyymmdd.xml

Modulo di accesso decentralizzato (DAM 510):

GSDML-V2.xx-Danfoss-DAM-2Port-IRT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-3Port-RT-yyyymmdd.xml

GSDML-V2.xx-Danfoss-DAM-yyyymmdd.xml

Modulo di condensatori ausiliari ACM 510: GSDML-V2.xx-Danfoss-ACM-yyyymmdd.xml

6.15.5 Creazione di una rete
Procedura
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Nella finestra Devices (Dispositivi), selezionare Device configuration (Configurazione dispositivo) [1] e aggiungere un PSM.

Assegnare il PSM al PLC_1 trascinando il quadrato centrale nell'icona del PLC [2] sul quadrato in alto a sinistra dell'icona del
PSM [3]. Viene creata automaticamente la rete PN/IE_1.

Assegnare al PSM il nome del dispositivo PROFINET, l'indirizzo IP e la subnet mask:

Fare clic con il tasto destro del mouse sull'icona PSM.

Selezionare la scheda General (Generale).

Selezionare PROFINET interface [X1] (Interfaccia PROFINET [X1]) e poi Ethernet addresses (Indirizzi Ethernet).

Immettere l'indirizzo IP 192.168.101.1 [4].

Immettere la Subnet mask 255.255.255.0 [5].

Ripetere i passaggi 1-3 per aggiungere un DAM 510, ACM 510, ISD 510 o DSD 510.

Nella finestra Devices & networks (Dispositivi e reti), selezionare Topology view (Vista topologica) [1] e collegare i dispositivi
trascinando e rilasciando le icone.
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Rimuovere i blocchi di funzionamento MAIN [OB1] (PRINCIPALE [OB1]) esistenti.

In Project Tree (Albero del progetto), espandere la voce Program blocks (Blocchi di programma).

Fare clic con il tasto destro del mouse sul blocco funzioni Main [OB1] (Principale [OB1]) [2], quindi selezionare Delete

(Elimina) nel menu a tendina.

Aggiungere un nuovo blocco funzioni MAIN [OB1] (PRINCIPALE [OB1]) e creare blocchi di funzionamento per Startup

[OB100] (Avviamento [OB100]) [3] e Synchronous Cycle [OB61] (Ciclo sincrono [OB61]) [4]:

In Project Tree (Albero del progetto), espandere la voce Program blocks (Blocchi di programma).

Fare doppio clic su Add new block (Aggiungi nuovo blocco).

Nella finestra Add new block (Aggiungi nuovo blocco), selezionare Organization block (Blocco di organizzazione).

Selezionare un blocco di organizzazione MAIN [OB1] (PRINCIPALE [OB1]) dall'elenco.

Impostare la lingua su SCL e attivare il pulsante radio Automatic (Automatico).

Fare clic su OK.

Ripetere per Startup [OB100] (Avviamento [OB100]) e Synchronous Cycle [OB61] (Ciclo sincrono [OB61]).

Verificare SyncDomain:

Aprire Network view (Vista rete) [1] e selezionare la sottorete Ethernet [2] in cui è impostato il dominio di sincronizza-
zione.

Aprire le proprietà della sottorete Ethernet.

Nella navigazione locale [4], selezionare la voce [Domain management → Sync domains → Sync-Domain_1].

Nel campo Sync Domain (Dominio di sincronizzazione) [5], cambiare il nome come desiderato.

Nel campo Send clock (Invia orologio) [6], selezionare il valore desiderato dal menu a tendina.

Attivare la casella Default domain (Dominio predefinito) [7] per rendere questo dominio di sincronizzazione predefinito.
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Verificare che tutti i componenti del sistema abbiano il ruolo Sync slave (Slave di sincronizzazione):
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Aprire Network view (Vista rete) [1] e selezionare la sottorete Ethernet in cui è impostato il dominio di sincronizzazione.

Aprire le proprietà della sottorete Ethernet [2].

Nella navigazione locale [3], selezionare la voce [Domain management → Sync domains → Sync-Domain_1 → Device].

Selezionare i dispositivi IO.

Verificare che tutti i componenti del sistema siano presenti e impostati su Sync slave (Slave di sincronizzazione).

Selezionare le proprietà del telegramma di ciascun componente del sistema:
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Aprire Device view (Vista dispositivo) [1].

Selezionare Danfoss Telegram (Telegramma Danfoss) [2].

Nella finestra Properties (Proprietà) [3], selezionare la scheda General (Generale) [4] e poi la voce I/O addresses (Indirizzi
I/O) [5].

Nella sezione Input addresses (Indirizzi di ingresso), attivare la casella di controllo per il modo isocrono [6], quindi impos-
tare il campo Organization block (Blocco di organizzazione) [7] su Synchronous Cycle (Ciclo sincrono) e il campo Process

image (Immagine di processo) [8] su PIP 1.

Ripetere queste impostazioni nella sezione Output addresses (Indirizzi di uscita) [9].

Ripetere questa procedura per ogni componente del sistema.
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Attivare il modo isocrono per ogni componente del sistema:
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Aprire Device view (Vista dispositivo) [1].

Nella sezione Device overview (Panoramica del dispositivo) [2], fare clic su danfoss-psm-01 [3].

Nella finestra Properties (Proprietà) [4], selezionare la scheda General (Generale) [5] e le voci di menu [PROFINET inter-
face [X1] → Advanced options → Isochronous mode].

Attivare la casella per Isochronous mode (Modo isocrono) [6].

Ripetere queste impostazioni per ogni componente del sistema.

Creare il blocco globalData FlexMotion_Data in cui verrà assegnata una struttura a ogni componente del sistema.
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Nel blocco funzioni Startup [OB100] (Avviamento [OB100]), verificare che i punti di accesso ai moduli siano stati assegnati
correttamente:

Espandere i Program blocks (Blocchi programma) nella scheda Devices (Dispositivi).

Fare doppio clic su Startup [OB100] (Avviamento [OB100]).

Digitare le impostazioni nello screenshot accertandosi che i nomi dei punti di accesso al modulo corrispondano al
nome assegnato automaticamente da TIA. Queste informazioni sono disponibili aprendo il menu [PLC tags → Show all
tags] e selezionando la scheda System constants (Costanti di sistema).
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Definire l'indirizzo del telegramma di ingresso e di uscita per ogni componente del sistema creando una tabella di tag:

Selezionare il menu [PLC tags → FlexMotion] per aprire la finestra FlexMotion_Telegram.

Definire l'indirizzo del telegramma in ingresso e in uscita per ogni componente del sistema.
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Nel blocco funzioni Synchronous Cycle [OB61] (Ciclo sincrono [OB61]), inserire le istruzioni di lettura del telegramma come
nell'esempio seguente.
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Nel blocco funzioni Synchronous Cycle [OB61] (Ciclo sincrono [OB61]), inserire le istruzioni di scrittura del telegramma come
nell'esempio seguente.
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6.16 Linee guida alla programmazione per TIA
Raccomandazioni per l'implementazione:
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Assegnare solo la variabile HwIdSubmodule nella struttura appropriata di ciascun dispositivo presente all'inizio del programma.
Usare la costante che viene creata automaticamente da TIA nel menu [PLC tags → Show all tags → System Constants], per
esempio, danfoss-isd-01~Device_object_1~Module_access_point. Assegnare questa variabile nel primo ciclo PLC per l'inizializza-
zione. Le strutture da utilizzare per ogni tipo di dispositivo sono:

ISD 510: AXIS_REF_DDS

DSD 510: AXIS_REF_DDS

PSM 510: PSM_REF

DAM 510: DAM_REF

ACM 510: ACM_REF

Inizializzare una sola volta all'inizio del programma i parametri che di solito non cambiano.

Richiamare le funzioni appropriate per ogni dispositivo presente in ogni ciclo PLC:

ISD 510: DD_UpdateProcessInput_DDS e DD_UpdateProcessOutput_DDS

DSD 510: DD_UpdateProcessInput_DDS e DD_UpdateProcessOutput_DDS

SDM 511/SDM 512: DD_UpdateProcessInput_DDS e DD_UpdateProcessOutput_DDS

PSM 510: DD_UpdateProcessInput_PSM e DD_UpdateProcessOutput_PSM

DAM 510: DD_UpdateProcessInput_DAM e DD_UpdateProcessOutput_DAM

ACM 510: DD_UpdateProcessInput_ACM e DD_UpdateProcessOutput_ACM

Creare istruzioni e altre parti del programma soltanto tra le richieste dei blocchi funzioni DD_UpdateProcessInput_xxx e DD_Up-

dateProcessOutput_xxx.

Richiamare i blocchi funzioni che forniscono informazioni di stato o di errore con Enable input (Abilita input) all'inizio del pro-
gramma.

Utilizzare un'istanza del blocco funzioni MC_Power_DDS per ciascun asse per controllarne lo stadio di potenza. Richiamare ques-
to blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_PSM per ogni PSM 510 per controllare la tensione del collegamento CC sulle
linee di uscita. Richiamare questo blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_DAM per ogni DAM 510 per controllare la tensione del collegamento CC sulle
linee di uscita. Richiamare questo blocco funzioni in ciascun ciclo PLC.

Usare un'istanza del blocco funzioni DD_Power_ACM per ogni ACM 510 per controllare la tensione del collegamento CC sulle
linee di uscita. Richiamare questo blocco funzioni in ogni ciclo PLC.

Richiamare i blocchi funzioni che eseguono i comandi (di movimento) alla fine del programma.

Non utilizzare UDT, POU, elenchi né costanti che iniziano con il prefisso iDD_.

Non modificare il riferimento per l'asse su un blocco funzioni mentre è occupato.

6.17 VLT® Servo Toolbox Software

6.17.1 Panoramica
VLTÆ Servo Toolbox è un software per PC standalone progettato da Danfoss. Viene utilizzato per la parametrizzazione e la diagnosti-
ca dei moduli di sistema. È inoltre possibile far funzionare i dispositivi in un ambiente non produttivo.

N O T A

Il software VLT® Servo Toolbox deve essere autorizzato per ogni profilo firewall (privato/pubblico/dominio).

Il VLTÆ Servo Toolbox contiene alcuni sottostrumenti, che offrono varie funzionalità.
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Tabella 28: Importanti sottostrumenti

Sottostrumento Descrizione

Oscilloscopio Per la visualizzazione della funzionalità di tracciamento dei servoazionamenti, del modulo di
alimentazione (PSM 510), del modulo di accesso decentralizzato (DAM 510) e del modulo di
condensatori ausiliari (ACM 510).

Elenco dei parametri Per parametri di lettura/scrittura.

Aggiornamento firmware Per l'aggiornamento del firmware dei dispositivi.

Comando del convertitore di
frequenza

Per il funzionamento dei servoazionamenti a scopo di test.

Comando PSM Per il funzionamento del modulo di alimentazione (PSM 510) a scopo di test.

Comando DAM Per il funzionamento del modulo di accesso decentralizzato (DAM 510) a scopo di test.

Comando ACM Per il funzionamento del modulo di condensatori ausiliari (ACM 510) a scopo di test.

Editor CAM Per la progettazione di profili CAM per i servoazionamenti.

Parametro di configurazione Per l'impostazione dei parametri del motore e della retroazione e delle impostazioni PID.

Messa in funzione del converti-
tore di frequenza

Per la regolazione della retroazione del motore e la misurazione dell'inerzia.

La descrizione dettagliata della funzionalità di VLTÆ Servo Toolbox e l'elenco completo di parametri sono disponibili nella Guida alla

programmazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

6.17.2 Requisiti del sistema
Per installare il software VLTÆ Servo Toolbox, il PC deve soddisfare i seguenti requisiti:

Piattaforme hardware supportate: 32-bit, 64-bit.

Sistemi operativi supportati: Windows 7, Windows 8.1, Windows 10.

Versione del framework .NET: 4.7.

Requisiti hardware minimi: RAM da 512 MB, Intel Pentium 4 con 2,6 GHz o equivalente, spazio su disco rigido da 20 MB.

Requisiti hardware consigliati: minimo 1 GB di RAM, Intel Core i5/i7 o compatibile.

6.17.3 Installazione del software VLT® Servo Toolbox
Per installare il software con il sistema operativo Windows è necessario disporre dei diritti di amministratore. All'occorrenza, contat-
tare l'amministratore di sistema.
Procedura

Verificare che il proprio sistema soddisfi i requisiti di sistema specificati in 6.17.2 Requisiti del sistema

Scaricare il file di installazione VLTÆ Servo Toolbox dal sito web Danfoss.

Fare clic con il tasto destro del mouse e selezionare Run as administrator (Esegui come amministratore).

Seguire le istruzioni sullo schermo per completare il processo di installazione.

6.17.4 VLT® Servo Toolbox Communication

6.17.4.1 Panoramica
Questo capitolo descrive le impostazioni dell'interfaccia di rete specifiche di Ethernet necessarie per VLTÆ Servo Toolbox. Esistono
due metodi di comunicazione di base: comunicazione diretta e comunicazione indiretta. Le impostazioni di rete specifiche sono
descritte nei rispettivi sottocapitoli.

Leggere ed eseguire attentamente i passaggi. Configurazioni di rete non corrette possono comportare la perdita di connettività di
un'interfaccia di rete.
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6.17.4.2 Firewall
A seconda delle impostazioni del firewall e del bus di campo utilizzate, i messaggi inviati e ricevuti dal VLTÆ Servo Toolbox possono
essere bloccati dal firewall sul sistema host VLTÆ Servo Toolbox, comportando una perdita di comunicazione e l'impossibilità di co-
municare con i dispositivi sul bus di campo. Pertanto, assicurarsi che VLTÆ Servo Toolbox sia autorizzato a comunicare attraverso il
firewall sul sistema host VLTÆ Servo Toolbox. Modifiche inappropriate alle impostazioni del firewall possono causare problemi di
sicurezza.

N O T A

Quando si utilizza un'interfaccia di rete dedicata, VLTÆ Servo Toolbox deve essere autorizzato a comunicare in maniera spe-
cifica attraverso questa interfaccia di rete.

6.17.4.3 Comunicazione indiretta

6.17.4.3.1 Panoramica
La comunicazione tra i dispositivi ISD 510/DSD 510 e il VLTÆ Servo Toolbox tramite un PLC è chiamata comunicazione indiretta. La
comunicazione su bus di campo basata su Ethernet (contrassegnata con A nel grafico) avviene tra il PLC e i dispositivi ISD 510/DSD
510. Tuttavia, esiste una comunicazione non basata su bus di campo tra il PLC e il sistema host VLTÆ Servo Toolbox.

Nello scenario mostrato, il PLC ha la funzione di master e utilizza la comunicazione ciclica con i dispositivi. Pertanto, non possono
essere utilizzate tutte le funzionalità di VLTÆ Servo Toolbox, come ad esempio il comando del convertitore di frequenza.

Le restrizioni nell'uso della comunicazione indiretta sono descritte nel dettaglio nella Guida alla programmazione VLT® Servo Drive
System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).
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Illustrazione 97: Vista logica della comunicazione indiretta su bus di campo basata su Ethernet (comunicazione tramite PLC)

A Bus di campo

B Sistema host VLTÆ Servo Toolbox

N O T A

La vista logica mostra la connettività soltanto da una prospettiva software di alto livello e non riflette l'effettiva topologia
fisica della rete.

6.17.4.3.2 Impostazioni di rete per la comunicazione indiretta
È possibile utilizzare qualsiasi interfaccia di rete per comunicare attraverso un PLC. Non è necessaria un'interfaccia di rete dedicata.

Quando si stabilisce la comunicazione attraverso un PLC, il VLTÆ Servo Toolbox configura una tabella di routing utilizzando la Net-
work Address Translation (Traduzione degli indirizzi di rete) (NAT) selezionata. L'aggiunta di un percorso alla tabella di routing di
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Windows richiede privilegi di amministratore. Pertanto, al momento dell'inizializzazione della connessione possono essere richieste
le credenziali di amministratore.

6.17.4.3.3 Abilitazione della comunicazione indiretta
Per consentire la comunicazione indiretta eseguire le seguenti operazioni.

N O T A
Quando si esaminano i pacchetti di rete tramite WiresharkÆ lo scaricamento del checksum causa spesso confusione, in quanto i

pacchetti di rete da trasmettere vengono consegnati a WiresharkÆ prima del calcolo del checksum. WiresharkÆ mostra questi

checksum vuoti come non validi, anche se i pacchetti contengono checksum validi quando lasciano l'hardware di rete in un sec-

ondo momento. Utilizzare uno di questi due metodi per evitare questo problema di scaricamento del checksum:

Se possibile, disattivare lo scaricamento del checksum nell'unità di rete.

Disattivare la convalida del checksum del protocollo specifico nelle preferenze WiresharkÆ.

Disattivare l'IPv6 sulle interfacce di rete utilizzate per la comunicazione sul PC:
Procedura

Aprire Network and Sharing Center (Centro di rete e condivisione).

Selezionare Change adapter settings (Modifica le impostazioni dell'adattatore).

Fare doppio clic sull'interfaccia di rete utilizzata per la comunicazione bus di campo e selezionare Properties (Proprietà).

Se il TCP/IPv6 è disponibile per l'interfaccia di rete, disattivarlo.

6.17.4.3.4 Impostazioni supplementari per la comunicazione indiretta con EtherCAT®
Impostare l'indirizzo IP del Master EtherCATÆ:

Procedura

Aprire TwinCATÆ System Manager.

Selezionare [I/O-Configuration → I/O Devices → Device1 (EtherCATÆ)] e controllare l'indirizzo IP nella scheda Adapter (Adat-
tatore). L'indirizzo IP dell'adattatore di rete del PLC potrebbe non essere un indirizzo link local (quindi potrebbe non rien-
trare nell'intervallo da 169.254.0.1 a 169.254.255.254).

Se necessario, modificare l'indirizzo IP all'interno delle proprietà del protocollo IPv4 in base al sistema operativo dato. Tale
operazione può essere effettuata sul controllore localmente o tramite Remote Desktop (Desktop remoto).

6.17.4.3.5 Attivazione del routing IP nel master EtherCAT®
La procedura descritta può variare a seconda del tipo di PLC e del sistema operativo installato.
Procedura

Aprire TwinCATÆ System Manager.

Fare clic su Advanced Settings... (Impostazioni avanzate...) mediante il menu [I/O-Configuration → I/O Devices → Device1
(EtherCAT)] nella scheda EtherCAT.

Selezionare EoE Support (Supporto EoE) nella finestra Advanced Settings (Impostazioni avanzate).

Abilitare Connect to TCP/IP Stack (Connettiti al TCP/IP Stack) nella sezione Windows Network (Rete Windows).

Abilitare IP Enable Router (Router di abilitazione IP) nella sezione Windows IP Routing (Indirizzamento IP di Windows).

Riavviare il PLC perché le modifiche diventino effettive.

6.17.4.3.6 Impostazione dell'indirizzo IP nello slave EtherCAT®
La procedura per l'impostazione dell'indirizzo IP dello slave EtherCATÆ è valida per:

I servoazionamenti ISD 510/DSD 510

Il modulo di alimentazione (PSM 510)

Il modulo di accesso decentralizzato (DAM 510)

Il modulo di condensatori ausiliari (ACM 510)

N O T A

L'ultimo numero dell'indirizzo IP corrisponde all'ID che viene utilizzato nel VLTÆ Servo Toolbox per identificare il dispositivo.
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Procedura

Aprire TwinCATÆ System Manager.

Fare clic su Advanced Settings... (Impostazioni avanzate...) in [I/O-Configuration → I/O Devices → Device1 (EtherCAT) →
Box 1 (VLTÆ Decentral Access Module → Drive 2 (VLTÆ Integrated Servo Drive ISD 510)] nella scheda EtherCATÆ.

Selezionare [Mailbox → EoE] nella finestra Advanced Settings (Impostazioni avanzate).

Abilitare Virtual Ethernet Port (Porta Ethernet virtuale) e inserire un indirizzo IP valido.

Ogni slave nella configurazione richiede un indirizzo IP. Questo indirizzo viene riassegnato a ogni passaggio dallo stato INIT

(INIZ.) allo stato Pre-Operational (Pre-operativo) della macchina di stato slave. La comunicazione IP degli slave è disattivata
per impostazione predefinita.

6.17.4.3.7 Impostazioni supplementari per la comunicazione indiretta con PROFINET®

6.17.4.3.7.1 Panoramica
Ciascun dispositivo PROFINET℠ ha bisogno di un nome di dispositivo e un indirizzo IP. L'indirizzo IP e il nome del dispositivo sono
assegnati dal controllore I/O quando viene stabilita la connessione con il dispositivo I/O.

Per il rilevamento automatico di nodi accessibili tramite un'interfaccia PG/PC con TCP/IP, collegare i nodi alla stessa sottorete Ether-
net fisica del PG/PC. Se un nodo si trova in una sottorete Ethernet fisica diversa, è possibile specificare l'indirizzo IP del nodo cercato.

Per raggiungere altri nodi, i nodi accessibili consentono di aggiungere indirizzi IP e sottoreti all'interfaccia PG/PC. I nuovi indirizzi IP
e le sottoreti vengono quindi aggiunti all'interfaccia Ethernet del PG/PC.

6.17.4.3.7.2 Aggiunta di indirizzi IP e sottoreti
Procedura

Aprire SIMOTION SCOUTÆ.

Selezionare il menu [Project → Accessible nodes].

Se i nodi accessibili si trovano in un'altra sottorete, viene visualizzata la finestra Add IP addresses / subnet masks (Aggiungi
indirizzi IP/subnet mask) che li riporta.
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Illustrazione 98: Nodi accessibili

Fare clic su Yes (Sì) per accettare gli indirizzi.
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A questo punto vengono aggiunti l'indirizzo IP/la subnet mask.

N O T A

Se viene usato più di un servoazionamento Danfoss nella stessa reteÆ PROFINET, ciascun servoazionamento deve avere un
nome e un indirizzo IP diversi.

L'ultimo numero dell'indirizzo IP corrisponde all'ID utilizzato nel software VLTÆ Servo Toolbox per identificare il dispositivo.

Quando la scheda Accessible nodes (Nodi accessibili) è chiusa, gli indirizzi vengono mantenuti. Gli indirizzi appena aggiunti
sono eliminati soltanto quando SIMOTION SCOUTÆ viene chiuso.

N O T A

Gli indirizzi IP e le sottoreti possono essere anche aggiunti utilizzando PRONETA.

6.17.4.4 Comunicazione diretta

6.17.4.4.1 Panoramica
Per la comunicazione su bus di campo basata su Ethernet (comunicazione diretta), VLTÆ Servo Toolbox deve usare un'interfaccia di
rete dedicata sul sistema host VLTÆ Servo Toolbox. Non utilizzare questa interfaccia di rete contemporaneamente per altre comuni-
cazioni.
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Illustrazione 99: Vista logica della comunicazione diretta su bus di campo basata su Ethernet

A Comunicazione diretta su bus di campo basata su Ethernet

B Sistema host VLTÆ Servo Toolbox

A V V I S O

La vista logica mostra la connettività soltanto da una prospettiva software di alto livello e non riflette l'effettiva topologia
fisica della rete.

6.17.4.4.2 Impostazioni di rete per la comunicazione diretta con Ethernet POWERLINK®
Disabilitare tutti i protocolli di rete eccetto TCP/IPv4 sull'interfaccia di rete utilizzata per la comunicazione diretta Ethernet POWER-
LINKÆ. In questo modo si evita che altri software per PC o il sistema operativo utilizzino questa interfaccia di rete per altre attività,
come la condivisione di file e stampanti e il rilevamento in rete. La disabilitazione di questi protocolli riduce il numero di pacchetti
non pertinenti inviati mediante l'interfaccia di rete e, quindi, riduce il carico complessivo della rete.

6.17.4.4.3 Disabilitazione dei protocolli inutilizzati sull'interfaccia di rete del PC
Procedura

Aprire Network and Sharing Center (Centro di rete e condivisione).
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A sinistra, fare clic su Change adapter settings (Modifica le impostazioni dell'adattatore).

Fare doppio clic sull'interfaccia di rete utilizzata per la comunicazione bus di campo e selezionare Properties (Proprietà).

Deselezionare tutte le caselle tranne quella per Internet Protocol Version 4 (TCP/IPv4) (Protocollo Internet versione 4 (TCP/
IPv4)).

Disabilitare l'IPv4 Checksum offload (Scaricamento del checksum IPv4) sulle interfacce di rete come descritto in 6.17.4.3.3
Abilitazione della comunicazione indiretta.
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Illustrazione 100: Proprietà della connessione locale 2

6.17.4.4.4 Impostazione dell'indirizzo IP master Ethernet POWERLINK® corretto
Procedura

Aprire Network and Sharing Center (Centro di rete e condivisione).

A sinistra, fare clic su Change adapter settings (Modifica le impostazioni dell'adattatore).

Fare doppio clic sull'interfaccia di rete utilizzata per la comunicazione bus di campo e selezionare Properties (Proprietà).

Fare clic su Internet Protocol Version 4 (TCP/IPv4) (Protocollo Internet versione 4 (TCP/IPv4)) (la casella di controllo deve es-
sere selezionata), quindi fare clic su Properties (Proprietà).
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5. Selezionare Use the following IP address (Utilizza il seguente indirizzo IP) e utilizzare 192.168.100.240 come indirizzo IP e
255.255.255.0 come subnet mask. Lasciare vuoti gli altri campi.
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Illustrazione 101: Proprietà del protocollo Internet versione 4 (TCP/IPv4)

6.17.4.4.5 Impostazioni di rete per la comunicazione diretta con EtherCAT®
Disabilitare tutti i protocolli di rete eccetto TCP/IPv4 sull'interfaccia di rete utilizzata per la comunicazione diretta EtherCAT®. In
questo modo si evita che altri software per PC o il sistema operativo utilizzino questa interfaccia di rete per altre attività, come la
condivisione di file e stampanti e il rilevamento in rete. La disabilitazione di questi protocolli riduce il numero di pacchetti non perti-
nenti inviati mediante l'interfaccia di rete e, quindi, riduce il carico complessivo della rete.

6.17.5 Messa in funzione di VLT® Servo Toolbox

6.17.5.1 Fase 1: apertura della finestra principale
La Main Window (Finestra principale) è la base per le funzionalità di tutti i VLTÆ Servo Toolbox. È composta dai seguenti componenti:
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Illustrazione 102: Finestra principale

Tabella 29: Descrizione della finestra principale

Nu-
mero
legen-
da

Nome Descrizione

1 Barra del
menu

Contiene le funzionalità generali per il salvataggio e il caricamento dei progetti, la gestione delle con-
nessioni, la visualizzazione e la modifica delle impostazioni, la gestione dei sotto-strumenti aperti e la
visualizzazione dei contenuti della guida.

2 Barra degli
strumenti

Contiene collegamenti per il salvataggio e il caricamento dei progetti, la connessione e la disconnes-
sione dalle reti, la ricerca automatica dei dispositivi online e l'aggiunta manuale dei dispositivi.

3 Stato online e
informazioni
sullo stato

I dispositivi online sono indicati da una lampadina accesa accanto all'ID del dispositivo.

Un dispositivo online è un dispositivo logico per il quale esiste un dispositivo fisico, a cui è colle-
gato il VLTÆ Servo Toolbox.

Il colore indica lo stato del dispositivo ed è specifico dello stesso.

Stato offline e
informazioni
sullo stato

I dispositivi offline sono indicati da una lampadina grigia accanto all'ID del dispositivo.

Un dispositivo offline è un dispositivo logico senza un corrispondente dispositivo fisico. Può rap-
presentare una configurazione o uno stato del dispositivo salvato, ad esempio per l'analisi offline
o la ricerca guasti. Contiene inoltre valori di parametri preconfigurati da scrivere su un dispositivo
fisico.
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Nu-
mero
legen-
da

Nome Descrizione

4 Sottostrumen-
ti disponibili

Il sottostrumento si apre facendo doppio clic con il tasto sinistro del mouse sul suo nome in Device

Environment (Ambiente del dispositivo) o selezionando la voce e premendo il tasto Enter (Invio) sulla
tastiera.

5 Ambiente del
dispositivo

La sezione Device Environment (Ambiente del dispositivo) della Main Window (Finestra principale)
elenca tutti i dispositivi logici gestiti in VLTÆ Servo Toolbox, ne visualizza lo stato e funge da interfac-
cia utente per accedere alle funzionalità del dispositivo.

La finestra Device Environment (Ambiente del dispositivo) elenca tutti i sottostrumenti disponibili per
ciascun dispositivo aggiunto.

Per maggiori informazioni sui sottostrumenti vedere la Guida alla programmazione VLT® Servo Drive
System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

6 Spazio di lav-
oro

Questo è lo spazio per contenere i sottostrumenti; la sua dimensione dipende dalla dimensione della
Main Window (Finestra principale). I sottostrumenti possono essere massimizzati, minimizzati, allinea-
ti orizzontalmente o verticalmente oppure in cascata.

7 Finestra della
lista di control-
lo

Valuta i valori dei parametri di uno o più dispositivi leggendoli ciclicamente dai dispositivi. Permette
di registrare i valori dei parametri e di salvarli in un file di testo. È anche possibile modificare/scrivere i
valori nella lista di controllo.

8 Finestra dei ri-
sultati

Mostra informazioni operative, avvisi ed errori. A seconda delle impostazioni dell'utente, mostra mes-
saggi fino a tre diversi livelli di registro (alto, medio e basso). Viene utilizzata per mostrare informazio-
ni avanzate di errore e di avviso.

9 Barra di stato Mostra lo stato della comunicazione di VLTÆ Servo Toolbox. Se collegato a una rete, mostra l'interfac-
cia hardware utilizzata (ad esempio, adattatore di rete) e il nome della rete.

6.17.5.2 Fase 2: collegamento alla rete
Pre-configurare le impostazioni di comunicazione appropriate per il collegamento a una rete (vedere 6.17.4.1 Panoramica).
Procedura

Nella barra degli strumenti Main Window (Finestra principale), fare clic sull'icona Connect to bus (Collegati al bus) per aprire
la finestra Connect to Network (Collegati alla rete).

Selezionare il tipo di bus di campo e l'interfaccia di rete a cui collegarsi.

Fare clic su OK per collegarsi.

Verificare che la connessione sia avvenuta correttamente controllando la barra di stato in fondo a Main Window (Finestra
principale).
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Illustrazione 103: Collegarsi alla finestra di rete (Ethernet POWERLINKÆ)
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6.17.5.3 Passaggio 3: scansione dei dispositivi
Procedura

N O T A

Se collegato a una rete Ethernet POWERLINKÆ in modalità ciclica, selezionare l'intervallo di scansione (ID minimo e massimo)
nella finestra successiva per ridurre il tempo di scansione necessario. In tutti gli altri casi, viene scansionato l'intero intervallo
ID.

Dopo aver verificato che VLTÆ Servo Toolbox è collegato alla rete selezionata, fare clic sull'icona Scan for Devices (Cerca dis-
positivi) nella barra degli strumenti per attivare la procedura di scansione del dispositivo.

Quando la scansione è completa, viene mostrato un elenco dei dispositivi disponibili nella finestra Select Devices (Seleziona
dispositivi). Selezionare i dispositivi da aggiungere a Device Environment (Ambiente del dispositivo) e fare clic su OK.

Tutti i dispositivi selezionati appaiono nella finestra Device Environment (Ambiente del dispositivo) e passano automatica-
mente online (stato indicato da una lampadina accesa accanto al nome di ogni dispositivo).

6.18 Libreria dei movimenti

6.18.1 Blocchi funzioni
La libreria PLC contiene blocchi funzioni che supportano la funzionalità del servosistema e sono conformi al seguente standard:

Blocchi funzioni di specifiche tecniche PLCopenÆ per il controllo del movimento (ex Parte 1 e Parte 2) versione 2.0 17 marzo 2011.

Oltre alla funzionalità PLCopenÆ, Danfoss offre altre funzioni per il servosistema.

Le seguenti caratteristiche PLCopenÆ si applicano a tutti i blocchi funzioni:

Comando (utilizzando gli ingressi)

Segnalazione (utilizzando le uscite)

Convenzioni generali di richiesta

N O T A

Vedere la Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ) per ulteri-
ori informazioni sui blocchi funzioni disponibili e sul loro comportamento.

6.18.2 Modello di programmazione semplice
TwinCATÆ:

Viene fornita un'applicazione PLC campione di base per l'avvio del servosistema con un modulo di alimentazione (PSM 510), un
modulo di accesso decentralizzato (DAM 510) e due assi. Il progetto DDS_ServoMotion_SampleProject può essere scaricato dal sito
web Danfoss.

Automation Studioô :

Le informazioni dettagliate su come aprire il progetto campione all'interno del pacchetto ISD in Automation Studioô  sono disponi-
bili nella Guida di Automation Studioô . Aprire B&R Help Explorer e passare a [Programming → Examples → Adding sample pro-
grams] e seguire le istruzioni per i campioni di libreria.

PROFINETÆ

Il progetto DDS_ServoMotion_SampleProject è un'applicazione PLC campione di base (C240PN) per l'avvio del servosistema con un
modulo di alimentazione (PSM 510), un modulo di accesso decentralizzato (DAM 510) e due assi.
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7 Funzionamento

7.1 Modi di funzionamento
I servoazionamenti ISD 510/DSD 510 implementano diversi modi di funzionamento. Il comportamento del servoazionamento di-
pende dal modo di funzionamento attivato. È possibile cambiare modo mentre il servoazionamento è abilitato. I modi di funziona-
mento supportati sono conformi a CANopenÆ CiA DS 402 e ne esistono anche alcuni specifici per l'ISD. Tutti i modi di funzionamen-
to supportati sono disponibili per EtherCATÆ, Ethernet POWERLINKÆ e PROFINETÆ. I vari modi di funzionamento sono descritti detta-

gliatamente nella Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

Modo misura-
zione dell'iner-
zia

Questo modo misura l'inerzia di un asse. Viene utilizzato per misurare l'inerzia del servoazionamento e del cari-
co esterno e per ottimizzare le impostazioni dell'anello di controllo. Gli effetti di attrito vengono eliminati au-
tomaticamente.

Modo velocità
del profilo

Nel modo velocità del profilo il servoazionamento viene azionato in condizioni di controllo della velocità ed
esegue un movimento a velocità costante. È possibile parametrizzare ulteriori parametri, come l'accelerazione
e la decelerazione.

Modo posi-
zione del profi-
lo

Nel modo posizione del profilo il servoazionamento viene azionato in condizioni di controllo della posizione
ed esegue movimenti assoluti e relativi. È possibile parametrizzare ulteriori parametri, come la velocità, l'acce-
lerazione e la decelerazione.

Modo coppia
del profilo

Nel modo coppia del profilo il servoazionamento viene azionato in condizioni di controllo di coppia ed esegue
un movimento con coppia costante. Vengono utilizzate rampe lineari. È possibile parametrizzare ulteriori para-
metri, come la rampa della coppia e la velocità massima.

Modo homing Nel modo homing è possibile impostare la posizione di riferimento dell'applicazione del servoazionamento.
Sono disponibili diversi metodi di homing, come l'homing sulla posizione effettiva, l'homing sul blocco, l'inter-
ruttore di finecorsa o l'interruttore home.

Modo CAM Nel modo CAM il servoazionamento esegue un movimento sincronizzato basato su un asse master. La sincro-
nizzazione avviene da un profilo CAM che contiene posizioni slave corrispondenti alle posizioni master. I CAM
possono essere progettati graficamente con il software ISD Toolbox o possono essere parametrizzati tramite il
PLC. Il valore guida può essere fornito da un encoder esterno, da un asse virtuale o dalla posizione di un altro
asse.

Modo trasmis-
sione

Nel modo trasmissione il servoazionamento esegue un movimento sincronizzato in base a un asse master uti-
lizzando un rapporto di trasmissione tra la posizione master e la posizione slave. Il valore guida può essere
fornito da un encoder esterno, da un asse virtuale o dalla posizione di un altro asse.

Modo posi-
zione sincrona
ciclica

Nel modo posizione sincrona ciclica il generatore di profilo della posizione è posizionato nel dispositivo di
controllo e non nel servoazionamento.

Modo velocità
sincrona ciclica

Nel modo velocità sincrona ciclica il generatore di profilo della velocità è posizionato nel dispositivo di control-
lo e non nel servoazionamento.

AC1 Nel modo classe di applicazione 1 (AC1) viene utilizzato un setpoint principale (ad es. il setpoint della velocità)
per il controllo del servoazionamento in PROFINETÆ IO. Il controllo di velocità è gestito interamente nel servoa-
zionamento.

AC4 La classe di applicazione 4 (AC4) definisce un'interfaccia fra l'interfaccia del setpoint di velocità e quella del
valore effettivo della posizione, dove il controllo di velocità viene eseguito sul servoazionamento e il controllo
della posizione sul controllore. Il Controllo del movimento per più assi viene eseguito centralmente, ad esem-
pio tramite controllo numerico (NC). Il circuito di controllo della posizione viene chiuso dal bus di campo. La
sincronizzazione dell'orologio è necessaria per sincronizzare gli orologi per il controllo della posizione nel con-
trollore e per il controllo di velocità nei convertitori di frequenza (PROFINETÆ con IRT).

7.1.1 Funzioni di movimento

Funzione Descrizione

Interruttore
CAM digitale

Questa funzionalità controlla se l'uscita digitale è abilitata o disabilitata, a seconda della posizione dell'asse.
Svolge una funzione paragonabile a quella degli interruttori sull'albero motore. Sono consentiti movimenti in

AQ262449648484it-000201 / 175R1135144 | Danfoss A/S © 2020.10

Funzionamento

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



Funzione Descrizione

avanti e indietro della posizione dell'asse. Inoltre, è possibile parametrizzare la compensazione di accensione e
di spegnimento e l'isteresi.

Sonda di con-
tatto

Questa funzionalità memorizza il valore effettivo della posizione su un fronte di salita o di discesa sull'ingresso
digitale configurato.

Valore guida Il valore guida viene utilizzato in tutti i modi operativi sincroni (modo CAM e Trasmissione). Viene utilizzato
come posizione master all'interno dei modi sincroni.

7.2 Indicatori di stato operativo
Lo stato operativo del servoazionamento ISD 510/DSD 510, di PSM 510, DAM 510 e ACM 510 viene indicato tramite i LED di ogni
dispositivo.

7.2.1 LED di funzionamento sul servoazionamento ISD 510/DSD 510

DEV STAT X1

X2

X3

NET STAT

LINK/ACT

Advanced

e3
0b

e6
77

.1
1

Illustrazione 104: LED di funzionamento sul servoazionamento ISD 510/DSD 510

Tabella 30: LED di funzionamento sul servoazionamento ISD 510/DSD 510

LED Colore Stato del lampeg-
giamento

Descrizione

DEV STAT Verde Acceso Il servoazionamento si trova nello stato Operation enabled (Funzionamento
abilitato)

Lampeggiante Viene applicata la tensione ausiliaria.

Rosso Acceso Il servoazionamento si trova nello stato Fault (Guasto) o Fault reaction ac-

tive (Reazione al guasto attiva).

Lampeggiante La tensione del collegamento CC non è applicata.

NET STAT Rosso/
verde

In funzione del bus
di campo

Stato di rete del dispositivo (vedere lo standard del bus di campo corris-
pondente)

LINK/ACT X1 Verde – Stato collegamento/attività di Hybrid In (Ingresso ibrido) (X1)
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LED Colore Stato del lampeg-
giamento

Descrizione

Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

LINK/ACT X2 Verde – Stato collegamento/attività di Hybrid Out (Uscita ibrida) (X2)

Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

LINK/ACT X3
(1)

Verde – Stato collegamento/attività della porta Ethernet (X3).

Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

1 Solo per servoazionamento avanzato con POWERLINKÆ o EtherCATÆ.

7.2.2 LED di funzionamento sul PSM 510

STATUS PSM

LINK/ACT

DEV

SVS ST

NET ST

X1

X2

e3
0b

g5
76

.1
1

Illustrazione 105: LED di funzionamento su PSM 510

Tabella 31: LED di funzionamento su PSM 510

LED Colore Stato del lampeg-
giamento

Descrizione

DEV Verde Acceso Il dispositivo si trova nello stato Operation enabled (Fun-
zionamento abilitato).

Lampeggiante Il dispositivo si trova nello stato Standby (Standby) o
Power-up (Accensione).
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LED Colore Stato del lampeg-
giamento

Descrizione

Rosso Acceso Il dispositivo si trova nello stato Fault (Guasto) o Fault

reaction active (Reazione al guasto attiva).

Lampeggiante La rete in ingresso non viene applicata.

SVS ST Verde Acceso Viene applicata un'alimentazione di sicurezza da 24 V.

Spento Non viene applicata un'alimentazione di sicurezza da 24
V.

NET ST Verde Acceso Collegato.

Arancione Acceso Online.

Rosso Lampeggiante Inizializzazione.

Acceso Inizializzazione non riuscita o altro errore.

LINK/ACT X1

(Stato collegamento/attività di In
(Ingresso))

Verde Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

LINK/ACT X2

(Stato collegamento/attività di Out

(Uscita))

Verde Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

7.2.3 LED di funzionamento sul DAM 510

STATUS DAM

LINK/ACT

DEV

SVS ST

NET ST

AUX

X1

X2

X3

e3
0b

g5
77

.1
1

Illustrazione 106: LED di funzionamento su DAM 510
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Tabella 32: LED di funzionamento su DAM 510

LED Colore Stato del lamp-
eggiamento

Descrizione

DEV Verde Acceso Il dispositivo si trova nello stato Operation enabled

(Funzionamento abilitato).

Lampeggiante Il dispositivo si trova nello stato Standby (Standby) o
Power-up (Accensione).

Rosso Acceso Il dispositivo si trova nello stato Fault (Guasto) o Fault

reaction active (Reazione al guasto attiva).

Lampeggiante Il collegamento CC non è applicato all'ingresso.

SVS ST Verde Acceso Viene applicata un'alimentazione di sicurezza da 24 V.

Spento Non viene applicata un'alimentazione di sicurezza da
24 V.

NET ST Verde Acceso Collegato.

Arancione Acceso Online.

Rosso Lampeggiante Inizializzazione.

Acceso Inizializzazione non riuscita o altro errore.

AUX

(Stato della tensione ausiliaria)

Verde Acceso Al connettore di uscita viene applicata una tensione
ausiliaria.

Spento Al connettore di uscita non viene applicata una ten-
sione ausiliaria.

Rosso Acceso Sottotensione della tensione ausiliaria rilevata
nell'hardware.

LINK/ACT X1

(Collegamento/attività di In (Ingresso))

Verde Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

LINK/ACT X2

(Stato collegamento/attività di Hybrid

Out (Uscita ibrida))

Verde Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

LINK/ACT X3

(Stato collegamento/attività di Out (Us-
cita))

Verde Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.
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7.2.4 LED di funzionamento sull'ACM 510

STATUS ACM

LINK/ACT

DEV

CAP ST

NET ST

X1

X2

e
3

0
b

g
5

7
8

.1
0

Illustrazione 107: LED di funzionamento sull'ACM 510

Tabella 33: LED di funzionamento sull'ACM 510

LED Colore Stato del lampeg-
giamento

Descrizione

DEV Verde Acceso Il dispositivo si trova nello stato Operation enabled (Fun-
zionamento abilitato).

Lampeggiante Il dispositivo si trova nello stato Standby (Standby) o
Power-up (Accensione).

Rosso Acceso Il dispositivo si trova nello stato Fault (Guasto) o Fault

reaction active (Reazione al guasto attiva).

Lampeggiante Il collegamento CC non è applicato all'ingresso.

CAP ST Verde Acceso Condensatori completamente carichi.

Lampeggiante Ricarica/scarica dei condensatori.

Spento Condensatori scarichi.

NET ST Verde Acceso Collegato.

Arancione Acceso Online.

Rosso Lampeggiante Inizializzazione.

Acceso Inizializzazione non riuscita o altro errore.

LINK/ACT X1

(Collegamento/attività di In (In-
gresso))

Verde Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.

Spento Nessun collegamento.

LINK/ACT X2 Verde Acceso Collegamento Ethernet stabilito.

Lampeggiante Collegamento Ethernet stabilito e attivo.
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LED Colore Stato del lampeg-
giamento

Descrizione

(Stato collegamento/attività di Out

(Uscita)) Spento Nessun collegamento.
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8 Sistema di sicurezza funzionale

8.1 Descrizione funzionale
Il servosistema integra la funzione di sicurezza Safe Torque Off (STO). La funzione di sicurezza è disponibile in formato daisy-chain,
possibile tra tutti i componenti del sistema ad eccezione dell'ACM 510 (i cavi non sono inclusi). Il cavo ibrido passa il segnale STO dal
modulo di accesso decentralizzato (DAM 510) a tutti i servoazionamenti ISD 510/DSD 510 della configurazione. Una volta attivata la
funzione STO (stato sicuro), non viene generata alcuna coppia sui servoazionamenti ISD 510 né sui motori collegati al DSD 510. Il
ripristino della funzione di sicurezza e la diagnostica possono essere effettuati tramite il PLC.

N O T A

Quando si esegue un lavoro meccanico sul servosistema o sulla zona della macchina collegata utilizzare la funzione STO per
evitare pericoli meccanici. Tuttavia, la funzione STO non garantisce la sicurezza elettrica.

8.2 Precauzioni di sicurezza

A V V I S O
MOVIMENTO INCONTROLLATO

Le forze esterne sul motore potrebbero causare un movimento incontrollato e pericoloso che può provocare morte o lesioni

gravi.

Dotare il motore di misure supplementari, ad esempio freni meccanici, per evitare movimenti incontrollati e pericolosi.

A V V I S O
RISCHIO DI SCOSSA ELETTRICA

La funzione STO non isola la tensione di rete dal servosistema né dai circuiti ausiliari. Il mancato isolamento della tensione di rete

e la mancata attesa del tempo di scarica specificato potrebbero provocare morte o lesioni gravi.

Eseguire i lavori su parti elettriche del servosistema o dei servoazionamenti ISD 510/DSD 510 solamente dopo aver isolato la
tensione di rete e aver atteso la fine del tempo di scarica.

A V V I S O
RISCHIO DI ROTAZIONE RESIDUA

In caso di guasto del semiconduttore di potenza del convertitore di frequenza, può verificarsi una rotazione residua dovuta a un

guasto che può causare morte o lesioni gravi. La rotazione può essere calcolata come angolo = 360°/(numero di poli).

Tenere conto di questa rotazione residua e assicurarsi che non rappresenti un rischio per la sicurezza.

A V V I S O
AFFIDABILITÀ DELLO STATO DEI LED

Gli indicatori di stato (LED) non sono affidabili per le funzioni di sicurezza.

Utilizzare gli indicatori di stato solamente per le diagnostiche generali durante la messa in funzione e la ricerca guasti.

N O T A

Dopo aver installato la funzione STO, eseguire un test di messa in funzione. Dopo la prima installazione occorre superare un
test di messa in funzione, che va ripetuto dopo ogni modifica apportata all'impianto di sicurezza (vedere 8.8 Test di messa in
funzione).
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N O T A

Se necessario, implementare una funzione di ripristino manuale secondo la norma EN ISO 13849-1. Per il riavvio automatico
senza ripristino manuale, osservare i requisiti descritti nel paragrafo 6.3.3.2.5 della norma EN ISO 12100:2010 o equivalente.

N O T A

Eseguire una valutazione dei rischi per selezionare la corretta categoria di arresto per ogni funzione di arresto in conformità
alla norma EN 60204-1.

Durante la progettazione dell'applicazione della macchina, considerare tempo e distanza per l'arresto a ruota libera (catego-
ria di arresto 0 oppure STO). Per ulteriori informazioni consultare la norma EN 60204-1.

Tutti i segnali collegati alla funzione STO devono essere alimentati da un'alimentazione PELV.

8.3 Personale qualificato per lavorare con la sicurezza funzionale
La funzione STO può essere installata, programmata, messa in funzione, manutenuta e disattivata esclusivamente da personale
qualificato. Il personale qualificato per il sistema di sicurezza funzionale comprende ingegneri elettrici qualificati o persone formate
da ingegneri elettrici qualificati e che abbiano un'esperienza adeguata nel far funzionare dispositivi, sistemi, impianti e macchinari
in conformità agli standard e alle linee guida generali relativi alle tecnologie per la sicurezza.

Inoltre, deve:

Avere familiarità con le norme di base riguardanti la protezione dai rischi e la prevenzione degli infortuni.

Avere letto e compreso le linee guida alla sicurezza riportate nel presente manuale.

Possedere una buona conoscenza delle norme generiche e specifiche valide per l'applicazione specifica.

Gli utenti di sistemi motorizzati (legati alla sicurezza) (PDS(SR)) sono responsabili di:

Analisi dei rischi dell'applicazione.

La sicurezza complessiva dell'applicazione.

Individuare le funzioni di sicurezza richieste e assegnare SIL o PL a ciascuna delle funzioni, agli altri sottosistemi e alla validità dei
segnali e dei comandi provenienti dagli stessi.

Progettare sistemi di controllo per la sicurezza quali hardware, software e parametrizzazione.

8.4 Norme applicate e conformità
L'uso della funzione STO richiede che siano soddisfatte tutte le norme di sicurezza, inclusi le leggi, i regolamenti e le direttive vigen-
ti.

La funzione STO integrata è conforme alle seguenti norme:

IEC 60204-1: 2016 Arresto categoria 0 – arresto non controllato

EN 60204-1: 2018 Arresto categoria 0 – arresto non controllato

IEC/EN 61508: 2010 SIL 2

IEC 61800-5-2: 2016 SIL 2

EN 61800-5-2: 2017 SIL 2

IEC 62061: 2005 e A1: 2012 e A2: 2015

EN 62061: 2005 e Cor.:2010 e A1: 2013 e A2: 2015

IEC/EN 62061: 2015 SIL CL2

EN ISO 13849-1: 2015 Categoria 3, PL d

EN ISO 13849-2: 2014
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8.5 Abbreviazioni e convenzioni

Tabella 34: Abbreviazioni e convenzioni relative alla sicurezza

Abbrevia-
zione

Riferimento Min-
Max

Descrizione

Cat. EN ISO 13849-1 Categoria B, 1–4

DC – Copertura diagnostica

FIT – Guasto nel tempo

Numero di guasti: 1E-9/ora

HFT EN IEC 61508 Tolleranza ai guasti hardware

HFT = n indica che n + 1 guasti possono causare una perdita della funzione di sicurezza.

MTTFD EN ISO 13849-1 Tempo medio al guasto pericoloso

Unità: anni

PFH EN IEC 61508 Probabilità di guasti pericolosi per ora

Tenere conto di questo valore se il dispositivo di sicurezza viene fatto funzionare nel modo ad
alta richiesta o nel modo di funzionamento continuo, dove la frequenza delle richieste di fun-
zionamento di un sistema di sicurezza si verifica più di una volta all'anno.

PL EN ISO 13849-1 Livello di prestazioni

Un livello discreto utilizzato per specificare la capacità dei componenti collegati alla sicurezza
facenti parte di un sistema per eseguire funzioni di sicurezza in tutte le condizioni prevedibili.
Livelli: a–e.

SFF EN IEC 61508 Frazione di guasti sicuri [%]

Proporzione dei guasti di sicurezza e dei guasti pericolosi rilevati di una funzione di sicurezza
o di un sottosistema come percentuale di tutti i possibili guasti.

SIL EN IEC 61508

EN IEC 62061

Livello di integrità di sicurezza

STO EN IEC 61800-5-2 Safe Torque Off

8.6 Installazione
Per l'installazione del servosistema utilizzare solamente cavi Danfoss; tuttavia, possono essere utilizzati cavi di altri fornitori per il
collegamento utente al morsetto STO STO DAM (poli 1 e 2) sul modulo di accesso decentralizzato (DAM 510).

N O T A

Se l'applicazione non richiede la funzionalità Safe Torque Off (STO), realizzare un ponte collegando +24 V dal connettore STO
1 IN: da +24 V a STO 1 IN: +STO e da STO 1 IN: da –24 V a STO 1 IN: –STO.

I relè di sicurezza che presentano un segnale di uscita di commutazione positivo e negativo possono essere collegati direttamente
al servosistema per attivare la funzione STO.

L'esempio riportato in Illustrazione 108 mostra il collegamento di base da realizzare per la funzione STO. Danfoss non fornisce un
adeguato dispositivo di sicurezza per disattivarlo. La funzione STO si attiva aprendo STO+ e STO-.
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Tabella 35: Attivazione della funzione STO

STO+ STO– Funzione STO

24 V GND STO disattivato

Aperto GND STO attivato

24 V Aperto STO attivato

Aperto Aperto STO attivato

N O T A

Non superare i 30 V negli ingressi STO.

La funzione STO si attiva se l'ingresso "più" è compreso tra -3 V e +3 V.

La funzione STO si disattiva se l'ingresso "più" è compreso tra +21,6 V e +26,4 V.

Illustrazione 108: Relè di sicurezza con uscita di commutazione positiva e negativa

I segnali con impulsi di prova non devono avere impulsi di prova per più di 1 ms, in quanto impulsi più lunghi possono comportare
una ridotta disponibilità del servosistema.

8.6.1 Misure di protezione
Installare i componenti del sistema ISD 510/DSD 510 con un grado di protezione inferiore a IP54 in un armadio IP54 secondo la
norma IEC 60529 o in un ambiente equivalente. In caso di applicazioni particolari potrebbe essere necessario un grado di prote-
zione IP maggiore.

Se influenze esterne, come ad esempio carichi sospesi, possono compromettere l'asse motore, eliminare i rischi adottando mis-
ure supplementari, quali un freno di mantenimento di sicurezza.

8.7 Esempio applicativo
Un esempio applicativo che può essere messo in modalità Safe Torque Off da un circuito di sicurezza è mostrato in Illustrazione 109.

I circuiti di sicurezza possono essere distanti l'uno dall'altro e non sono alimentati dal servosistema VLTÆ Servo Drive System
ISD 510/DSD 510.

Selezionare i dispositivi di commutazione di sicurezza in base ai requisiti dell'applicazione.

+24 VDC

GND

e
3
0
b
g
2
7
3
.1

0

8a

8b

53

42

1

X1

X2

X1

X2

9

7

6

Illustrazione 109: Esempio applicativo: funzione Safe Torque Off
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1 Alimentazione a 24 V CC

2 Dispositivo di sicurezza

3 Pulsante di arresto di emergenza

4 Contatti del dispositivo di sicurezza

5 Il modulo di accesso decentralizzato (DAM 510)

6 Cavo ibrido

7 Cavo di alimentazione

8a Servoazionamento

8b Servoazionamento

9 Cavo di loop

8.8 Test di messa in funzione

N O T A

Eseguire un test di messa in funzione per l'intero servosistema dopo l'installazione della funzione STO, dopo ogni modifica
della funzione installata o dopo un guasto relativo alla sicurezza.

Esistono due modi per implementare il test di messa in funzione a seconda del metodo utilizzato per programmare il PLC; tuttavia,
le fasi del test sono le stesse:

Utilizzando la libreria Danfoss o la libreria TwinCATÆ.

Visualizzazione dello stato bit per bit.

8.8.1 Test di messa in funzione con le librerie
A seconda dell'applicazione, per programmare il test di messa in funzione sono necessarie una o entrambe le seguenti librerie:

Libreria Danfoss

MC_ReadAxisInfo_DDS

MC_ReadStatus_DDS

MC_ReadAxisError_DDS

MC_Reset_DDS

Libreria TwinCATÆ

MC_ReadStatus

MC_ReadAxisError

MC_Reset

Tabella 36: Test di messa in funzione con le librerie

Fasi del test Motivo della fase di
test

Risultato previsto per la libreria Dan-
foss

Risultato previsto per la li-
breria TwinCATÆ

1 Eseguire l'applicazione
(tutti i servoazionamenti
sono abilitati).

Verificare che l'appli-
cazione funzioni.

L'applicazione funziona come previsto. L'applicazione funziona
come previsto.

2 Arrestare l'applicazione. – Tutti i servoazionamenti si trovano a
una velocità di 0 giri/min.

Tutti i servoazionamenti si
trovano a una velocità di 0
giri/min.

3 Disabilitare tutti i ser-
voazionamenti.

– Tutti i servoazionamento sono disabili-
tati.

Tutti i servoazionamento so-
no disabilitati.

4 Abilitare STO. Verificare che STO
possa essere attivato
senza errori.

MC_ReadAxisInfo_DDS output SafeTor-

queOff = Vero per tutti i servoaziona-
menti sulla linea corrispondente.

–

5 Disabilitare STO. Verificare che STO
possa essere disatti-
vato senza errori. Non

MC_ReadAxisInfo_DDS output SafeTor-

queOff = Falso per tutti i servoaziona-
menti sulla linea corrispondente.

–
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Fasi del test Motivo della fase di
test

Risultato previsto per la libreria Dan-
foss

Risultato previsto per la li-
breria TwinCATÆ

è necessario alcun
ripristino.

6 Eseguire l'applicazione
(tutti i servoazionamenti
sono abilitati).

– L'applicazione funziona come previsto. L'applicazione funziona
come previsto.

7 Abilitare STO. Controllare che gli er-
rori siano generati
correttamente quan-
do STO è attivato
mentre i servoaziona-
menti sono in fun-
zione.

I motori sono privi di coppia. I motori
girano a ruota libera e si fermano dopo
un determinato lasso di tempo.

MC_ReadAxisInfo_DDS output SafeTor-

queOff = Vero

e

MC_ReadStatus_DDS output ErrorStop

(Arresto per errore) = Vero

e

MC_ReadAxisError_DDS output AxisEr-

rorID (ID errore asse) = 0xFF80 su tutti i
servoazionamenti abilitati.

I motori sono privi di coppia.
I motori girano a ruota libera
e si fermano dopo un deter-
minato lasso di tempo.

Per i motori abilitati:

MC_ReadStatus output Error-

Stop = Vero

e

MC_ReadAxisError output Axi-

sErrorID = 0xFF80 su tutti i
servoazionamenti abilitati.

8 Provare a eseguire l'ap-
plicazione (abilitare uno
o più servoazionamen-
ti).

Controlla che la fun-
zione STO funzioni
correttamente.

L'applicazione non funziona. L'applicazione non funziona.

9 Disabilitare STO. Controllare che l'av-
vio di STO sia ancora
inibito dal segnale di
errore.

MC_ReadAxisInfo_DDS output SafeTor-

queOff = Falso

e

MC_ReadStatus_DDS output ErrorStop

(Arresto per errore) = Vero

MC_ReadStatus output Error-

Stop = Vero

10 Provare a eseguire l'ap-
plicazione (abilitare uno
o più servoazionamen-
ti).

Verificare se è neces-
sario un ripristino.

L'applicazione non funziona. L'applicazione non funziona.

11 Inviare un segnale di
ripristino tramite
MC_Reset(_DDS).

– MC_ReadAxisInfo_DDS output SafeTor-

queOff = Falso

e

MC_ReadStatus_DDS output ErrorStop

(Arresto per errore) = Falso

MC_ReadStatus output Error-

Stop = Falso

12 Provare a eseguire l'ap-
plicazione (tutti i ser-
voazionamenti sono
abilitati).

– L'applicazione funziona come previsto. L'applicazione funziona
come previsto.
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8.8.2 Test di messa in funzione con dispositivi PROFINET®

Tabella 37: Test di messa in funzione con dispositivi PROFINET®

Fasi del test Motivo della fase di test Risultato previsto

1 Eseguire l'applicazione (tutti i
servoazionamenti sono abilitati).

Verificare che l'applicazione fun-
zioni.

L'applicazione funziona come previsto.

2 Arrestare l'applicazione. – Tutti i servoazionamenti si trovano a una velocità
di 0 giri/min.

3 Disabilitare tutti i servoaziona-
menti.

– Tutti i servoazionamento sono disabilitati.

4 Abilitare STO. Verificare che STO possa essere at-
tivato senza errori.

Non sono presenti errori. È possibile verificare l'av-
venuta attivazione di STO sui LED dei dispositivi.

5 Disabilitare STO. Verificare che STO possa essere
disattivato senza errori. Non è nec-
essario alcun ripristino.

Non sono presenti errori. È possibile controllare lo
stato STO sui LED dei dispositivi.

6 Eseguire l'applicazione (tutti i
servoazionamenti sono abilitati).

– L'applicazione funziona come previsto.

7 Abilitare STO. Controllare che gli errori siano
generati correttamente quando
STO è attivato mentre i servoazio-
namenti sono in funzione.

I motori sono privi di coppia. I motori girano a ruo-
ta libera e si fermano dopo un determinato lasso
di tempo.

L'errore 0x11E viene visualizzato nell'oggetto
0x603F su tutti i servoazionamenti.

8 Provare a eseguire l'applicazione
(abilitare uno o più servoaziona-
menti).

Controlla che la funzione STO fun-
zioni correttamente.

L'applicazione non funziona.

9 Disabilitare STO. Controllare che l'avvio di STO sia
ancora inibito dal segnale di er-
rore.

L'errore 0x11E viene visualizzato nell'oggetto
0x603F su tutti i servoazionamenti.

10 Provare a eseguire l'applicazione
(abilitare uno o più servoaziona-
menti).

Verificare se è necessario un ripris-
tino.

L'applicazione non funziona.

11 Inviare un segnale di ripristino
tramite il PLC.

– L'errore STO 0x11E viene cancellato in tutti i ser-
voazionamenti.

12 Provare a eseguire l'applicazione
(tutti i servoazionamenti sono
abilitati).

– L'applicazione funziona come previsto.

8.9 Funzionamento della funzione STO
La funzione STO non richiede parametrizzazioni ed è sempre abilitata.

Il servoazionamento ISD 510/DSD 510 fornisce i segnali di stato STO attraverso il bus di campo.

Tutti i segnali trasmessi attraverso il bus di campo non fanno parte della funzione di sicurezza e possono essere utilizzati solamente
per scopi operativi.

Vedere la Guida alla programmazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

Informazioni generali su come accedere agli oggetti dei dati e come mapparli.

Informazioni su una libreria fornite per semplificare l'uso delle funzioni del bus di campo.
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Se STO è attivato quando il servoazionamento è disabilitato e non si tenta di abilitarlo mentre STO è attivo, non è necessario ripristi-
nare la funzione STO dopo aver riapplicato l'alimentazione ai relativi morsetti.

Se STO è attivato quando il servoazionamento è abilitato, viene emesso un codice di errore.

8.9.1 Codici di errore
Se è impostato il bit 3 della parola di stato, significa che si sono verificati errori sul servoazionamento. Se l'errore si è verificato a
causa del circuito STO, la causa si trova nell'oggetto 0x603F.

Tabella 38: Codici di errore

Codice di
errore

Codice di
erroreÆ

PROFINET

Classificazione Descrizione Ripristino

0xFF80 0x11E Guasto STO è stato attivato mentre il servoazionamento era
abilitato, o si è tentato di abilitare il servoazionamento
mentre STO era attivato.

Ripristino tramite il
PLC

0xFF81 0x11F Errore di sicurez-
za

Errore diagnostico interno del servoazionamento. Spegnere e riaccen-
dere.

0xFF85 0x120 Errore di sicurez-
za

L'alimentazione interna STO sulla scheda di potenza
non rientra nei limiti.

Spegnere e riaccen-
dere.

Il codice di errore 0xFF80/0x11E può costituire un normale stato dell'applicazione. In questo caso, il servoazionamento richiede un
segnale di ripristino da parte del PLC. Per utilizzare la funzione STO in un'applicazione che richiede una protezione di controllo (per
maggiori dettagli vedere la norma ISO 12100), questa informazione di ripristino può essere fornita automaticamente dal PLC. Tutti i
servoazionamenti sulla stessa linea visualizzano questo guasto contemporaneamente. Eseguire un controllo sul PLC per confrontare
il guasto di tutti i servoazionamenti su una linea.

Il codice di errore 0xFF81/0x11F significa che è presente un guasto sul servoazionamento che può essere ripristinato soltanto tra-
mite lo spegnimento e la riaccensione e con il successivo completamento della prova di messa in funzione. Il funzionamento del
servosistema può essere ripreso solamente se la prova viene completata correttamente. Se vengono emessi nuovamente i codici di
errore 0xFF81/0x11F oppure 0xFF85/0x120, contattare l'Assistenza Danfoss.

8.9.2 Ripristino del guasto
Per ripristinare i guasti, cambiare il bit 7 della parola di controllo da 0 a 1. Per maggiori informazioni vedere la Guida alla program-
mazione VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

8.10 Dati caratteristici di sicurezza funzionale

Tabella 39: Dati caratteristici di sicurezza funzionale

Dati ISD 510/DSD 510 PSM 510 DAM 510

Informazioni generali

Tempo di risposta (dall'accensione dell'ingresso fino alla disattivazione della genera-
zione della coppia)

<100 ms

Durata 20 anni

Dati per EN/ISO 13849-1

Livello di prestazioni (PL) d – –

Categoria 3 – –

Tempo medio per guasto pericoloso (MTTFD) >5000 anni – –

Copertura diagnostica (DC) 60% – –

Dati per le norme EN/ISO 61508 ed EN/IEC 62061
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Dati ISD 510/DSD 510 PSM 510 DAM 510

Livello di integrità di sicurezza (SIL) 2 – –

Probabilità di guasto per ora (PFH) <4 x 10-9/h 0/h 0/h

Frazione di guasti sicuri (SFF) >95% 100% 100%

Classificazione sottosistema Tipo A

Intervallo del test di funzionamento 1 anno

N O T A

Il PSM 510, il DAM 510 e l'ACM 510 non contribuiscono alla percentuale di guasti pericolosi del sistema Danfoss e possono
pertanto essere esclusi dai calcoli relativi alla sicurezza.

8.11 Manutenzione, sicurezza e accessibilità utente
Manutenzione: testare la funzione di sicurezza STO almeno una volta all'anno come segue:

Rimuovere la tensione di ingresso STO.

Verificare che i motori si arrestino.

Verificare che non compaiano codici di errore imprevisti.

Sicurezza: se esistono rischi per la sicurezza, adottare misure adeguate per prevenirli.

Accessibilità utente: limitare l'accesso ai servoazionamenti ISD 510/DSD 510 e ad altri componenti del sistema se l'accesso agli stessi
può comportare rischi per la sicurezza.
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9 Diagnostica

9.1 Guasti
Se durante il funzionamento del sistema ISD 510/DSD 510 si verificano dei guasti, controllare:

I LED sui servoazionamenti per problemi generali relativi alla comunicazione o allo stato del dispositivo.

I LED su PSM 510 e DAM 510 per problemi generali di comunicazione, alimentazione ausiliaria o tensione STO.

I codici di errore.

È possibile leggere i codici di errore usando il software VLTÆ Servo Toolbox, l'LCP o il PLC. L'LCP mostra soltanto i guasti relativi al
dispositivo a cui è collegato.

N O T A

Se il guasto non può essere eliminato con una delle misure elencate nelle tabelle di ricerca guasti, informare l'assistenza
Danfoss.

Tenere a portata di mano le seguenti informazioni per permettere a Danfoss di fornire supporto in modo rapido ed efficace:

Numero tipo

Codice di errore

Versione firmware

Configurazione del sistema (ad esempio, numero di servoazionamenti, moduli di sistema e linee).

Stato del sistema al momento del guasto.

Condizioni ambientali.

9.2 Ricerca guasti

9.2.1 Ricerca guasti per i servoazionamenti ISD 510/DSD 510

9.2.1.1 Il convertitore di frequenza non funziona/si avvia lentamente
Causa possibile

Usura del cuscinetto.

Impostazioni parametri errate.

Parametri del circuito di controllo errati.

Impostazioni coppia errate.

Ricerca guasti

Controllare i cuscinetti e l'albero.

Controllare le impostazioni parametri.

9.2.1.2 Ronzii del convertitore di frequenza e il convertitore assorbe una corrente elevata
Causa possibile

Convertitore di frequenza difettoso.

Ricerca guasti

Contattare Danfoss.

9.2.1.3 Il convertitore di frequenza si arresta all'improvviso e il riavvio non è possibile
Causa possibile

Nessuna comunicazione con il convertitore di frequenza.

Servoazionamento in modalità errore.

Ricerca guasti

Controllare il collegamento del bus di campo e i LED sul servoazionamento.
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9.2.1.4 Motore che ruota nella direzione sbagliata
Causa possibile

Modalità Mirror attivata.

Ricerca guasti

Controllare le impostazioni parametri.

9.2.1.5 Motore non genera la coppia prevista
Causa possibile

Convertitore di frequenza difettoso.

Errore parametro.

Ricerca guasti

Controllare le impostazioni parametri.

Contattare Danfoss.

9.2.1.6 Rumorosità del convertitore di frequenza
Causa possibile

Taratura errata.

Misurazione della corrente difettosa.

Parametri del circuito di controllo errati.

Ricerca guasti

Controllare le impostazioni parametri.

Contattare Danfoss.

9.2.1.7 Funzionamento irregolare
Causa possibile

Cuscinetto difettoso.

Ricerca guasti

Controllare l'albero.

9.2.1.8 Vibrazioni
Causa possibile

Cuscinetto difettoso.

Parametri del circuito di controllo errati.

Ricerca guasti

Controllare l'albero.

Controllare le impostazioni parametri.

9.2.1.9 Rumori di funzionamento insoliti
Causa possibile

Cuscinetto difettoso.

Difetti della meccanica collegata.

Parametri del circuito di controllo errati.

Ricerca guasti

Controllare l'albero.

Controllare che non siano presenti componenti meccanici allentati nella meccanica collegata.

Controllare le impostazioni parametri.
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9.2.1.10 La velocità del convertitore di frequenza diminuisce bruscamente in presenza di un carico
Causa possibile

Il convertitore di frequenza funziona al limite di corrente.

Il convertitore di frequenza funziona con parametri errati.

Ricerca guasti

Controllare l'applicazione.

Controllare le impostazioni parametri.

9.2.1.11 Il freno non viene rilasciato
Causa possibile

Controllo del freno difettoso.

Parametri del freno meccanico errati.

Ricerca guasti

Controllare le impostazioni parametri.

Contattare Danfoss.

9.2.1.12 Il freno di stazionamento non mantiene il servoazionamento
Causa possibile

Freno meccanico difettoso.

Il carico sull'albero supera la coppia di mantenimento del freno.

Ricerca guasti

Contattare Danfoss.

9.2.1.13 Innesto freno ritardato
Causa possibile

Errore software.

Ricerca guasti

Contattare Danfoss.

9.2.1.14 Rumori quando il freno di arresto è innestato
Causa possibile

Freno meccanico danneggiato.

Ricerca guasti

Contattare Danfoss.

9.2.1.15 I LED non si accendono
Causa possibile

Assenza di alimentazione elettrica.

Ricerca guasti

Controllare l'alimentazione elettrica.

9.2.1.16 La protezione del convertitore di frequenza scatta immediatamente
Causa possibile

Cortocircuito.

Parametri del circuito di controllo errati.

Ricerca guasti

Controllare il cablaggio.

Contattare Danfoss.
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9.2.2 Ricerca guasti per il servosistema

9.2.2.1 Il display LCP è spento/non funziona
Questo errore vale per i servoazionamenti ISD 510/DSD 510, per PSM 510, DAM 510 e ACM 510.

Possibili cause

Alimentazione di ingresso mancante.

Fusibili bruciati o mancanti o scatto dell'interruttore automatico

Nessuna alimentazione all'LCP.

Impostazione del contrasto non corretta.

Il display è difettoso.

Ricerca guasti
Tabella 40: Errore, il display LCP è spento/non funziona

Possibile causa Possibile soluzione

Alimentazione di ingresso mancante. Controllare la sorgente di alimentazione di ingresso.

Fusibili bruciati o mancanti o scatto dell'interrut-
tore automatico

Controllare i fusibili e l'interruttore.

Nessuna alimentazione all'LCP. Controllare il corretto collegamento del cavo e l'assenza di danni all'LCP.

Sostituire gli LCP o i cavi di collegamento guasti.

Impostazione del contrasto non corretta. Premere [Status] + [▵]/[▿] per regolare il contrasto.

Il display è difettoso. Sostituire l'LCP o il cavo di collegamento guasto.

9.2.2.2 Fusibili aperti o scatto interruttore
Questo errore vale per PSM 510 e DAM 510.

Possibili cause

Corto tra due fasi.

Corto su backlink.

Corto su cavo ibrido

Corto su connettore o cavo EXM 510

Corto su connettore ISD 510/DSD 510

Ricerca guasti

Controllare il cablaggio

Controllare se sono presenti collegamenti allentati.

9.2.2.3 Tensione del collegamento CC troppo bassa (errore 0x3220/0x104)
Questo errore vale per tutti i moduli di sistema.

Causa possibile

Alimentazione di ingresso di rete non corretta.

Ricerca guasti

Controllare che la tensione di alimentazione corrisponda alle specifiche consentite.

9.2.2.4 Scatto per sovraccarico di corrente (errore 0x2396/0x15C)
Questo errore vale per PSM 510 e DAM 510.
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Possibili cause

La somma della corrente del servoazionamento supera il grado massimo di DAM 510.

La somma della corrente dei moduli di sistema supera il grado massimo di PSM 510.

Corto su backlink.

Ricerca guasti

Controllare il consumo di corrente del servoazionamento.

Evitare l'accelerazione simultanea di più servoazionamenti.

Diminuire il valore di accelerazione.

9.2.2.5 Sovraccarico cont. ad alta potenza (errore 0x2313/0x161)
Questo errore vale per il PSM 510.

Possibili cause

Il PSM 510 è rimasto in funzione per un periodo di tempo prolungato a un valore superiore al 140% della potenza nominale.

Ricerca guasti

Controllare il consumo di corrente.

9.2.2.6 Sovraccarico potenza continuo (errore 0x2314/0x162)
Questo errore vale per il PSM 510.

Possibili cause

Il PSM 510 è rimasto in funzione per un periodo di tempo prolungato a un valore superiore al 100-140% della potenza nominale.

Ricerca guasti

Controllare il consumo di corrente.

9.2.2.7 Sovracorrente AUX (errore 0x2391/0x125)
Questo errore vale per DAM 510.

Possibili cause

I servoazionamenti consumano maggiore corrente sulla linea UAUX di quella consentita.

Ricerca guasti

Controllare il numero di servoazionamenti collegati con gli schemi a chiocciola nella Guida alla Progettazione VLT® Servo Drive
System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

Evitare il sollevamento simultaneo dei freni del servoazionamento.

9.2.2.8 Sovratensione AUX (errore 0x3292/0x133)
Questo errore vale per DAM 510.

Possibili cause

Alimentazione UAUX non corretta.

Ricerca guasti

Controllare che l'alimentazione corrisponda ai requisiti dell'alimentazione ausiliaria.

9.2.2.9 Sottotensione AUX (errore 0x3294/0x135)
Questo errore vale per PSM 510, DAM 510 e ACM 510.

Possibili cause

Alimentazione UAUX non corretta.

Dimensionamento errato della corrente di alimentazione.

Ricerca guasti

Controllare che l'alimentazione corrisponda ai requisiti dell'alimentazione ausiliaria.

Controllare che la potenza di uscita dell'alimentazione sia sufficiente.
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9.2.2.10 Perdita di fase di rete (errore 0x3130/0x12F)
Questo errore vale per il PSM 510.

Possibili cause

Manca una fase sul lato dell'alimentazione.

Lo sbilanciamento della tensione è troppo elevato.

Ricerca guasti

Controllare le tensioni e le correnti di alimentazione al dispositivo.

9.2.2.11 Errore generico di applicazione (Errore 0x1000/0x100)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Possibili cause

Si è verificato un errore generico nell'applicazione.

Ricerca guasti

Contattare Danfoss.

9.2.2.12 Guasto di messa a terra
Questo errore vale per PSM 510, DAM 510 e ACM 510.

Possibili cause

Guasto di messa a terra

Quando due moduli PSM510 sono montati in parallelo e viene superato il tempo di ritardo massimo per l'accensione (vedere 6.6
Tempo di accensione).

Ricerca guasti

Controllare la corretta messa a terra ed eventuali collegamenti allentati.

Controllare i cavi ibridi per verificare eventuali cortocircuiti o correnti di dispersione.

Controllare il collegamento e il cavo EXM 510.

9.2.2.13 Errore di resistenza di frenatura
Questo errore vale per il PSM 510.

Possibili cause

Resistenza di frenatura guasta.

Resistenza di frenatura interna/esterna non collegata.

Ricerca guasti

Disinserire l'alimentazione al dispositivo, attendere la fine del tempo di scarica, quindi sostituire la resistenza di frenatura.

9.2.2.14 Errore chopper di frenatura
Questo errore vale per il PSM 510.

Possibili cause

Chopper di frenatura guasto.

La potenza del chopper di frenatura supera il limite di spegnimento e riaccensione.

Parametrizzazione errata.

Ricerca guasti

Controllare la parametrizzazione del chopper di frenatura.

Controllare il collegamento del chopper di frenatura.

Misurare la resistenza del chopper di frenatura e confrontarla con le impostazioni parametri.

9.2.2.15 Errore ventola interna
Questo errore vale per PSM 510.
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Possibili cause

La ventola non è montata.

La ventola è bloccata.

Ricerca guasti

Controllare se la ventola è bloccata.

Controllare che i cavi della ventola siano collegati correttamente o che non siano danneggiati.

9.3 Codici di errore per il servosistema ISD 510/DSD 510

9.3.1 Nessun errore (0x0000/0x0)
Questo codice di errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 41: Nessun errore (0x0000/0x0)

Codice Codice PROFINETÆ Nome Gravità (avviso/errore/scatto bloccato) Descrizione Nome LCP

0x0000 0x0 Nessun errore Errore Nessun errore. –

9.3.2 Errore generico di applicazione (0x1000/0x100)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 42: Errore generico (0x1000/0x100)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scat-
to bloccato)

Descrizione Nome LCP

0x1000 0x100 Errore generico di appli-
cazione

Errore Errore generico di applica-
zione.

generic err

9.3.3 Scatto sovracorrente (0x2310/0x101)
Questo errore è valido per ISD 510/DSD 510.

Tabella 43: Sovracorrente su uscita (0x2310/0x101)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x2310 0x101 Scatto sovracor-
rente

Errore Scatto sovracorrente su us-
cita.

overcurr trip

9.3.4 Sovraccarico di corrente cont. elevato (0x2311/0x15F)
Questo errore è valido per DAM 510 e ISD 510/DSD 510.

Tabella 44: Sovraccarico di corrente elevato (0x2311/0x15F)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x2311 0x15F Sovraccarico di cor-
rente cont. elevato

Errore Errore di sovraccarico di cor-
rente continua elevato.

High curr
ovld

9.3.5 Sovraccarico corrente continua (0x2312/0x160)
Questo errore è valido per DAM 510 e ISD 510/DSD 510.
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Tabella 45: Sovraccarico corrente continua (0x2312/0x160)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x2312 0x160 Sovraccarico corrente
continua

Errore Errore di sovraccarico di cor-
rente continua.

cont curr ovld

9.3.6 Sovraccarico continuo ad alta potenza (0x2313/0x161)
Questo errore è valido per PSM 510.

Tabella 46: Sovraccarico continuo ad alta potenza (0x2313/0x161)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x2313 0x161 Sovraccarico continuo
ad alta potenza

Avviso, errore Errore di sovraccarico contin-
uo ad alta potenza.

high pwr
ovld

9.3.7 Sovraccarico potenza continuo (0x2314/0x162)
Questo errore è valido per PSM 510.

Tabella 47: Sovraccarico potenza continuo (0x2314/0x162)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x2314 0x162 Sovraccarico potenza
continuo

Avviso, errore Errore di sovraccarico po-
tenza continuo.

cont pwr
ovld

9.3.8 Cortocircuito da sovracorrente (0x2320/0x163)
Questo errore è valido per PSM 510 e DAM 510.

Tabella 48: Cortocircuito da sovracorrente (0x2320/0x163)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x2320 0x163 Cortocircuito da sov-
racorrente

Scatto bloccato Errore di cortocircuito da
sovracorrente.

over curr
short

9.3.9 Guasto verso terra (0x2330/0x151)
Questo errore è valido per PSM 510, DAM 510 e ISD 510/DSD 510.

Tabella 49: Guasto verso terra (0x2330/0x151)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x2330 0x151 Guasto verso ter-
ra

Avviso, errore Scarica dalle fasi in uscita ver-
so terra.

ground fault

9.3.10 Sovracorrente AUX (0x2391/0x125)
Questo errore è valido per DAM 510.
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Tabella 50: Sovracorrente AUX (0x2391/0x125)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x2391 0x125 Sovracorrente
AUX

Errore La corrente sulla linea AUX ha raggiun-
to il limite di sovracorrente.

AUX overcurr

9.3.11 Limite corrente utente AUX (0x2393/0x127)
Questo errore è valido per DAM 510.

Tabella 51: Limite corrente utente AUX (0x2393/0x127)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/
errore/scatto blocca-
to)

Descrizione Nome LCP

0x2393 0x127 Limite corrente
utente AUX

Errore La corrente sulla linea AUX ha raggiunto il
limite di errore definito dall'utente.

AUX curr lim-
it

9.3.12 Avviso limite corrente utente AUX (0x2394/0x128)
Questo errore è valido per PSM 510 e DAM 510.

Tabella 52: Avviso limite corrente utente AUX (0x2394/0x128)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/
errore/scatto blocca-
to)

Descrizione Nome LCP

0x2394 0x128 Avviso limite cor-
rente utente AUX

Avviso La corrente sulla linea AUX ha raggiunto
il limite di avviso definito dall'utente.

AUX curr
warn

9.3.13 Guasto alimentazione AUX (0x2395/0x129)
Questo errore è valido per DAM 510.

Tabella 53: Guasto alimentazione AUX (0x2395/0x129)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x2395 0x129 Guasto alimenta-
zione AUX

Errore Guasto dell'alimentazione AUX in-
dicato dal circuito hardware.

AUX supply
fail

9.3.14 Scatto per sovraccarico di corrente (0x2396/0x15C)
Questo errore è valido per DAM 510 e ISD 510/DSD 510.

Tabella 54: Scatto per sovraccarico di corrente (0x2396/0x15C)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x2396 0x15C Scatto per sovraccarico
di corrente

Errore Errore scatto per sovraccari-
co di corrente.

curr ovld trip

9.3.15 Scatto per sovraccarico potenza (0x2397/0x12B)
Questo errore è valido per PSM 510.
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Tabella 55: Scatto per sovraccarico potenza (0x2397/0x12B)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x2397 0x12B Scatto per sovraccari-
co potenza

Errore Errore di scatto per sovraccar-
ico potenza.

pwr ovld trip

9.3.16 Sovraccarico termico motore (0x239B/0x102)
Questo errore è valido per ISD 510/DSD 510.

Tabella 56: Sovraccarico termico motore (0x239B/0x102)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x239B 0x102 Sovraccarico termico
motore

Avviso, errore Errore Sovraccarico termi-
co motore.

therm ovld
motor

9.3.17 Perdita di fase di rete (0x3130/0x12F)
Questo errore è valido per PSM 510.

Tabella 57: Perdita di fase di rete (0x3130/0x12F)

Codice Codice
PROFINETô

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome
LCP

0x3130 0x12F Perdita di fase
di rete

Errore Rilevata perdita di fase di rete.

Si verifica quando manca una fase sulla rete
elettrica o quando la rete è sbilanciata.

phase loss

9.3.18 Sovratensione del collegamento CC (0x3210/0x103)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 58: Sovratensione del collegamento CC (0x3210/0x103)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x3210 0x103 Sovratensione del
collegamento CC

Errore Tensione del collegamento CC
superiore al limite.

UDC overvolt

9.3.19 Sottotensione del collegamento CC (0x3220/0x104)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 59: Sottotensione del collegamento CC (0x3220/0x104)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0x3220 0x104 Sottotensione
collegamento CC

Errore Tensione del collegamento CC al di sotto del
limite nello stato Operation enabled (Funzio-
namento abilitato).

UDC under-
volt

9.3.20 Errore carica del collegamento CC (0x3230/0x152)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.
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Tabella 60: Errore carica del collegamento CC (0x3230/0x152)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0x3230 0x152 Errore carica del
collegamento CC

Errore Errore carica del collegamento CC. Il limite di
tempo massimo per caricare il collegamento
CC è stato superato.

UDC charg-
ing

9.3.21 Collegamento CC sbilanciato (0x3280/0x153)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 61: Collegamento CC sbilanciato (0x3280/0x153)

Codice Codice
PROFI-
NETô

Nome Gravità (avviso/
errore/scatto blocca-
to)

Descrizione Nome LCP

0x3280 0x153 Collegamento
CC sbilanciato

Scatto bloccato La tensione del collegamento CC è sbilancia-
ta. Questo guasto indica un malfunziona-
mento interno del collegamento CC.

UDC unbal-
ance

9.3.22 Alta tensione UAUX (0x3291/0x132)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 62: Alta tensione UAUX (0x3291/0x132)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x3291 0x132 Alta tensione
UAUX

Avviso UAUX al di sopra del limite di av-
viso.

UAUX high
volt

9.3.23 Sovratensione UAUX (0x3292/0x133)
Questo errore è valido per DAM 510.

Tabella 63: Sovratensione UAUX (0x3292/0x133)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scat-
to bloccato)

Descrizione Nome LCP

0x3292 0x133 Sovratensione
UAUX

Errore UAUX al di sopra del limite di sov-
ratensione.

UAUX over-
volt

9.3.24 Bassa tensione UAUX (0x3293/0x134)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 64: Bassa tensione UAUX (0x3293/0x134)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x3293 0x134 Bassa tensione
UAUX

Avviso UAUX al di sotto del limite di av-
viso.

UAUX low
volt

9.3.25 Sottotensione UAUX (0x3294/0x135)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.
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Tabella 65: Sottotensione UAUX (0x3294/0x135)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x3294 0x135 Sottotensione
UAUX

Errore UAUX al di sotto di limite di sotto-
tensione.

UAUX under-
volt

9.3.26 Alta tensione del collegamento CC (0x3295/0x136)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 66: Alta tensione del collegamento CC (0x3295/0x136)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x3295 0x136 Alta tensione del
collegamento CC

Avviso La tensione del collegamento CC è su-
periore al limite di avviso alta tensione.

UDC high
volt

9.3.27 Bassa tensione del collegamento CC (0x3296/0x137)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 67: Bassa tensione UDC (0x3296/0x137)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x3296 0x137 Bassa tensione del
collegamento CC

Avviso La tensione del collegamento CC è in-
feriore al limite di avviso bassa ten-
sione.

UDC low
volt

9.3.28 Errore di carica UAUX (0x3297/0x154)
Questo errore è valido per DAM 510.

Tabella 68: Errore di carica UAUX (0x3297/0x154)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0x3297 0x154 Errore di cari-
ca UAUX

Errore Errore di carico quando UAUX è in carica. Il limite
di tempo massimo per caricare la linea AUX è
stato superato.

UAUX
charg err

9.3.29 Errore arresto del collegamento CC (0x3298/0x165)
Questo errore è valido per DAM 510.

Tabella 69: Errore arresto del collegamento CC (0x3298/0x165)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x3298 0x165 Errore arresto del colle-
gamento CC

Errore Errore quando UDC è in
fase di arresto.

UDC shutdwn
err

9.3.30 Errore di arresto UAUX (0x3299/0x155)
Questo errore è valido per DAM 510.
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Tabella 70: Errore di arresto UAUX (0x3299/0x155)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x3299 0x155 Errore di arresto
UAUX

Errore Errore quando UAUX è in fase di
arresto.

UAUX shtdwn
err

9.3.31 Hardware di sottotensione UAUX (0x329A/0x156)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 71: Hardware di sottotensione UAUX (0x329A/0x156)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x329A 0x156 Hardware di sotto-
tensione UAUX

Errore Sottotensione UAUX rilevata dal
circuito hardware.

AUX undervol
HW

9.3.32 Sovratemperatura del dispositivo (0x4210/0x157)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 72: Sovratemperatura del dispositivo (0x4210/0x157)

Codice Codice
PROFI-
NETÆ

Nome Gravità (avviso/
errore/scatto
bloccato)

Descrizione Nome
LCP

0x4210 0x157 Sovratem-
peratura del
dispositivo

Avviso, errore Attivato quando viene superata la temperatura massi-
ma del componente principale del dispositivo.

PSM: modulo raddrizzatore a tiristore.

DAM: temperatura massima degli IGBT sia sul lato supe-
riore sia su quello inferiore.

overtemp
device

9.3.33 Sottotemperatura del dispositivo (0x4220/0x138)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 73: Sottotemperatura del dispositivo (0x4220/0x138)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x4220 0x138 Sottotemperatura del
dispositivo

Errore Il dispositivo è troppo freddo
per funzionare.

undertemp de-
vice

9.3.34 Sovratemperatura: scheda di controllo (0x4291/0x106)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 74: Sovratemperatura: scheda di controllo (0x4291/0x106)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x4291 0x106 Sovratemperatura:
scheda di controllo

Errore La temperatura massima della
scheda di controllo è stata superata.

overtemp
CC

9.3.35 Sovratemperatura: scheda di potenza (0x4292/0x107)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.
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Tabella 75: Sovratemperatura: scheda di potenza (0x4292/0x107)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x4292 0x107 Sovratemperatura:
scheda di potenza

Avviso, errore La temperatura massima della
scheda di potenza è stata superata.

overtemp
PC

9.3.36 Sovratemperatura di accensione del collegamento CC (0x4293/013C)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 76: Sovratemperatura di accensione del collegamento CC (0x4293/0x13C)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto
bloccato)

Descrizione Nome LCP

0x4293 0x13C Sovratemperatura
di accensione: col-
legamento CC

Errore Guasto di accensione.

Troppi passaggi nello stato Operation enabled

(Funzionamento abilitato) in un breve inter-
vallo di tempo.

UDC in-
rush

9.3.37 Sovratemperatura di accensione della linea AUX (0x4294/0x13D)
Questo errore è valido per DAM 510.

Tabella 77: Sovratemperatura di accensione della linea AUX (0x4294/0x13D)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto
bloccato)

Descrizione Nome LCP

0x4294 0x13D Sovratemperatura
di accensione della
linea AUX

Errore Guasto di accensione.

Sono state effettuate troppe accensioni della
tensione AUX in un intervallo di tempo ecces-
sivamente breve.

UAUX in-
rush

9.3.38 Sovratemperatura: motore (0x4310/0x108)
Questo errore è valido per ISD 510/DSD 510.

Tabella 78: Sovratemperatura: motore (0x4310/0x108)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x4310 0x108 Sovratemperatura:
Motore

Errore Sovratemperatura sul
motore.

overtemp motor

9.3.39 Tensione di guasto dell'interruttore di carica (0x5121/0x158)
Questo errore è valido per PSM 510.

Tabella 79: Tensione di guasto dell'interruttore di carica (0x5121/0x158)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x5121 0x158 Tensione di guasto
dell'interruttore di car-
ica

Scatto bloccato Indica un malfunzionamento del
circuito di carica interno.

Chg switch
fail
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9.3.40 Errore Checksum EE (parametro mancante) (0x5530/0x10A)
Questo errore è valido per ISD 510/DSD 510.

Tabella 80: Errore Checksum EE (parametro mancante) (0x5530/0x10A)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x5530 0x10A Errore Checksum EE
(parametro man-
cante)

Scatto bloccato Errore checksum EEPROM o par-
ametro del dispositivo man-
cante.

err eeprom

9.3.41 Errore parametro (0x6320/0x10B)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 81: Errore parametro (0x6320/0x10B)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x6320 0x10B Errore parame-
tro

Scatto bloccato Un parametro presenta un val-
ore non valido.

param err

9.3.42 Versione parametri di configurazione (0x6382/0x15D)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 82: Errore versione parametri di configurazione (0x6382/0x15D)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0x6382 0x15D Errore versione
parametri di con-
figurazione

Scatto bloccato Mancata corrispondenza della versione del
set di parametri di configurazione: il set di
parametri non è valido per questo dispositi-
vo.

conf par
ver

9.3.43 Errore per limiti dei parametri di configurazione (0x6383/0x164)
Questo errore è valido per PSM 510, DAM 510 e ACM 510.

Tabella 83: Errore per limiti dei parametri di configurazione (0x6383/0x164)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0x6383 0x164 Errore per limiti dei
parametri di config-
urazione

Scatto bloccato Uno o più parametri nel set di parametri di
configurazione non rientrano nei limiti: il set
di parametri non è valido per questo disposi-
tivo.

conf par
lim

9.3.44 Errore di configurazione dell'EEprom della scheda di potenza (0x6384/0x166)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

AQ262449648484it-000201 / 175R1135174 | Danfoss A/S © 2020.10

Diagnostica

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



Tabella 84: Errore di configurazione dell'EEprom della scheda di potenza (0x6384/0x166)

Codice Nome Gravità (avviso/
errore/scatto blocca-
to)

Descrizione Nome LCP

0x6384 0x166 Errore di configurazione
dell'EEprom della scheda
di potenza

Scatto bloccato Il dispositivo di alimentazione Eeprom è
corrotto o incompatibile con questo
quadro di comando.

conf par EE-
PROM

9.3.45 Guasto al chopper di frenatura (0x7111/0x141)
Questo errore è valido per PSM 510.

Tabella 85: Guasto al chopper di frenatura (0x7111/0x141)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto blocca-
to)

Descrizione Nome LCP

0x7111 0x141 Guasto al chop-
per di frenatura

Avviso, errore Il chopper di frenatura viene monitorato du-
rante il funzionamento.

La funzione di controllo del freno ha rilevato un
guasto al freno.

brake ch
fail

9.3.46 Sovraccorrente del chopper di frenatura (0x7112/0x167)
Questo errore è valido per PSM 510.

Tabella 86: Sovraccorrente del chopper di frenatura (0x7112/0x167)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x7112 0x167 Sovraccorrente del
chopper di frenatura

Scatto bloccato La corrente del chopper di
frenatura supera i limiti.

brake ch
overcurr

9.3.47 Sovraccarico del modulo del chopper di frenatura (0x7181/0x142)
Questo errore è valido per PSM 510.

Tabella 87: Limite di potenza massima del resistore di frenatura (0x7181/0x142)

Codice Codice
PROFI-
NETÆ

Nome Gravità (avviso/
errore/scatto
bloccato)

Descrizione Nome
LCP

0x7181 0x142 Sovraccarico del
modulo del
chopper di frena-
tura

Avviso, errore Il carico di potenza del chopper di frenatura viene
monitorato durante il funzionamento. Questo er-
rore appare quando viene raggiunto il limite massi-
mo di potenza del modulo del chopper di frenatura.

mod ovl

9.3.48 Sovraccarico del chopper di frenatura esterno (0x7182/0x143)
Questo errore è valido per PSM 510.

Tabella 88: Sovraccarico del chopper di frenatura esterno (0x7182/0x143)

Codice Codice
PROFI-
NETÆ

Nome Gravità (avvi-
so/errore/
scatto blocca-
to)

Descrizione Nome
LCP

0x7182 0x143 Sovraccarico
del chopper

Avviso, errore Il carico di potenza del chopper di frenatura viene monitora-
to durante il funzionamento.

ext brake
ch ovl
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Codice Codice
PROFI-
NETÆ

Nome Gravità (avvi-
so/errore/
scatto blocca-
to)

Descrizione Nome
LCP

di frenatura
esterno

A seconda della configurazione di external brake chopper

power monitoring (monitoraggio della potenza del chopper
di frenatura esterno) questo avviso o guasto appare quando
viene raggiunta la potenza nominale del chopper di frena-
tura esterno.

9.3.49 Tensione di rete del freno troppo alta (0x7183/0x159)
Questo errore è valido per PSM 510.

Tabella 89: Tensione di rete del freno troppo alta (0x7183/0x159)

Codice Codice
PROFI-
NETÆ

Nome Gravità (avvi-
so/errore/scat-
to bloccato)

Descrizione Nome
LCP

0x7183 0x159 Tensione di
rete del freno
troppo alta

Avviso La tensione di rete è troppo alta, per questo motivo il
chopper di frenatura potrebbe essere attivato in modo
continuo a seconda del valore immesso nel parametro
brake chopper start level (livello di avvio del chopper di
frenatura).

brake ch
high volt

9.3.50 Errore sensore di posizione interno (0x7320/0x10C)
Questo errore è valido per ISD 510/DSD 510.

Tabella 90: Errore sensore di posizione interno (0x7320/0x10C)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x7320 0x10C Errore sensore di posi-
zione interno

Scatto bloccato Errore sensore di posi-
zione assoluto.

int sensor err

9.3.51 Errore sensore di posizione esterno (0x7380/0x10D)
Questo errore è valido per DAM 510 e ISD 510/DSD 510.

Tabella 91: Errore sensore di posizione esterno (0x7380/0x10D)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0x7380 0x10D Errore sensore di
posizione esterno

Errore Non è stato possibile leggere i dati
dell'encoder esterno.

ext sensor err

9.3.52 Errore di monitoraggio (0x8611/0x10E)
Questo errore è valido per ISD 510/DSD 510.

Tabella 92: Errore di monitoraggio (0x8611/0x10E)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x8611 0x10E Errore di monitor-
aggio

Avviso, errore Si è verificato un errore di
monitoraggio.

following err
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9.3.53 Errore di homing quando si accede alla modalità di homing (0x8693/0x10F)
Questo errore è valido per ISD 510/DSD 510.

Tabella 93: Errore di homing quando si accede alla modalità di homing (0x8693/0x10F)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0x8693 0x10F Errore di homing quando
si accede alla modalità
homing

Avviso Impossibile accedere alla modalità
homing (ad esempio velocità diver-
sa da 0).

Homing
mode fail

9.3.54 Errore di homing in fase di avvio del metodo di homing (0x8694/0x110)
Questo errore è valido per ISD 510/DSD 510.

Tabella 94: Errore di homing in fase di avvio del metodo di homing (0x8694/0x110)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0x8694 0x110 Errore di homing in fase
di avvio del metodo di
homing

Avviso Impossibile avviare il metodo di hom-
ing (ad esempio, il convertitore di fre-
quenza non è fermo).

Homing
method fail

9.3.55 Errore distanza di homing (0x8695/0x111)
Questo errore è valido per ISD 510/DSD 510.

Tabella 95: Errore distanza di homing (0x8695/0x111)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0x8695 0x111 Errore distanza di
homing

Avviso Distanza di homing rag-
giunta.

Homing dis-
tance

9.3.56 Guasto del freno meccanico (0xFF01/0x112)
Questo errore è valido per ISD 510/DSD 510.

Tabella 96: Guasto del freno meccanico (0xFF01/0x112)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0xFF01 0x112 Guasto del freno
meccanico

Scatto bloccato Freno assente o filo
guasto.

brake mech
fail

9.3.57 Cortocircuito nel controllo del freno meccanico (0xFF02/0x113)
Questo errore è valido per ISD 510/DSD 510.

Tabella 97: Cortocircuito nel controllo del freno meccanico (0xFF02/0x113)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0xFF02 0x113 Cortocircuito nel controllo
del freno meccanico

Scatto bloccato Cortocircuito nel control-
lo del freno.

brake mech
short

9.3.58 Guasto di alimentazione dell'interfaccia esterna (0xFF0A/0x114)
Questo errore è valido per ISD 510/DSD 510.
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Tabella 98: Guasto di alimentazione dell'interfaccia esterna (0xFF0A/0x114)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0xFF0A 0x114 Guasto di alimentazione
dell'interfaccia esterna

Errore Guasto di alimentazione elettr-
ica dell'interfaccia esterna.

ext IF pwr fail

9.3.59 Retroazione della ventola irregolare (0xFF21/0x145)
Questo errore è valido per PSM 510.

Tabella 99: Retroazione della ventola irregolare (0xFF21/0x145)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0xFF21 0x145 Retroazione della
ventola irregolare

Avviso Guasto della ventola interna.

Ventola interna non funzionante/non
montata.

fan feed-
back

9.3.60 Durata della ventola critica (0xFF22/0x15A)
Questo errore è valido per PSM 510.

Tabella 100: Durata della ventola critica (0xFF22/0x15A)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0xFF22 0x15A Durata della ventola
critica

Avviso La durata teorica della ventola è
stata superata.

fan lifetime

9.3.61 Violazione temporizzazione 1 (0xFF60/0x115)
Questo errore è valido per ISD 510/DSD 510.

Tabella 101: Violazione temporizzazione 1 (0xFF60/0x115)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF60 0x115 Violazione temporizza-
zione 1

Scatto bloccato Contattare Danfoss. timing err 1

9.3.62 Violazione temporizzazione 2 (0xFF61/0x116)
Questo errore è valido per ISD 510/DSD 510.

Tabella 102: Violazione temporizzazione 2 (0xFF61/0x116)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF61 0x116 Violazione temporizza-
zione 2

Scatto bloccato Contattare Danfoss. timing err 2

9.3.63 Violazione temporizzazione 3 (0xFF62/0x117)
Questo errore è valido per ISD 510/DSD 510.
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Tabella 103: Violazione temporizzazione 3 (0xFF62/0x117)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF62 0x117 Violazione temporizza-
zione 3

Scatto bloccato Contattare Danfoss. timing err 3

9.3.64 Violazione temporizzazione 4 (0xFF63/0x118)
Questo errore è valido per ISD 510/DSD 510.

Tabella 104: Violazione temporizzazione 4 (0xFF63/0x118)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF63 0x118 Violazione temporizza-
zione 4

Scatto bloccato Contattare Danfoss. timing err 4

9.3.65 Violazione temporizzazione 5 (0xFF64/0x119)
Questo errore è valido per ISD 510/DSD 510.

Tabella 105: Violazione temporizzazione 5 (0xFF64/0x119)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF64 0x119 Violazione temporizza-
zione 5

Scatto bloccato Contattare Danfoss. timing err 5

9.3.66 Violazione temporizzazione 6 (0xFF65/0x11A)
Questo errore è valido per ISD 510/DSD 510.

Tabella 106: Violazione temporizzazione 6 (0xFF65/0x11A)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF65 0x11A Violazione temporizza-
zione 6

Scatto bloccato Contattare Danfoss. timing err 6

9.3.67 Violazione temporizzazione 7 (0xFF66/0x168)
Questo errore è valido per ISD 510/DSD 510.

Tabella 107: Violazione temporizzazione 7 (0xFF66/0x168)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF66 0x168 Violazione temporizza-
zione 7

Scatto bloccato Contattare Danfoss. timing err 7

9.3.68 Violazione temporizzazione 8 (0xFF67/0x16B)
Questo errore è valido per ISD 510/DSD 510.
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Tabella 108: Violazione temporizzazione 8 (0xFF67/0x16B)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF67 0x16B Violazione temporizza-
zione 8

Scatto bloccato Contattare Danfoss. timing err 8

9.3.69 Violazione temporizzazione 9 (0xFF68/0x16C)
Questo errore è valido per ISD 510/DSD 510.

Tabella 109: Violazione temporizzazione 9 (0xFF68/0x16C)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF68 0x16C Violazione temporizza-
zione 9

Scatto bloccato Contattare Danfoss. timing err 9

9.3.70 Firmware: mancata corrispondenza della descrizione del pacchetto (0xFF70/0x11B)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 110: Firmware: mancata corrispondenza della descrizione del pacchetto (0xFF70/0x11B)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0xFF70 0x11B Firmware: Mancata corris-
pondenza della descrizione
del pacchetto

Scatto bloccato Il firmware trovato non corris-
ponde alla descrizione del pac-
chetto.

FW pack err

9.3.71 Firmware: spegnimento e riaccensione necessari (0xFF71/0x11C)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 111: Firmware: spegnimento e riaccensione necessari (0xFF71/0x11C)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF71 0x11C Firmware: spegni-
mento e riaccen-
sione necessari

Avviso, errore Il trasferimento dell'aggiornamento del firm-
ware è completato, ma è necessario spegnere
e riaccendere prima dell'attivazione del nuo-
vo firmware.

need pow-
ercycle

9.3.72 Firmware: aggiornamento avviato (0xFF72/0x11D)
Questo errore è valido per PSM 510, DAM 510, ACM 510 e ISD 510/DSD 510.

Tabella 112: Firmware: aggiornamento avviato (0xFF72/0x11D)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto blocca-
to)

Descrizione Nome LCP

0xFF72 0x11D Firmware: ag-
giornamento
avviato

Avviso, errore L'aggiornamento firmware è in corso.

L'avviso diventa errore quando si cerca di abil-
itare il dispositivo in questo stato.

FW update

9.3.73 Firmware: aggiornamento non valido (0xFF73/0x15B)
Questo errore è valido per PSM 510 e DAM 510.
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Tabella 113: Firmware: aggiornamento non valido (0xFF73/0x15B)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto bloc-
cato)

Descrizione Nome LCP

0xFF73 0x15B Firmware: ag-
giornamento
non valido

Errore Aggiornamento del pacchetto firmware non
valido o corrotto.

È stato caricato l'ultimo pacchetto firmware
valido.

FW upd inva-
lid

9.3.74 STO attivo mentre il convertitore di frequenza è abilitato (0xFF80/0x11E)
Questo errore è valido per ISD 510/DSD 510.

Tabella 114: STO attivo mentre il convertitore di frequenza è abilitato (0xFF80/0x11E)

Codice Codice
PROFINETÆ

Nome Gravità (avviso/
errore/scatto
bloccato)

Descrizione Nome LCP

0xFF80 0x11E STO attivo mentre il
convertitore di frequen-
za è abilitato

Errore STO è stato attivato mentre il convertitore di
frequenza era abilitato o si è tentato di abili-
tarlo mentre STO era attivo.

STO active

9.3.75 Mancata corrispondenza di STO (0xFF81/0x11F)
Questo errore è valido per ISD 510/DSD 510.

Tabella 115: Mancata corrispondenza di STO (0xFF81/0x11F)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0xFF81 0x11F STO mis-
match

Scatto bloccato Non è plausibile una doppia diag-
nosi di tensione STO.

STO mis-
match

9.3.76 Errore P_STO (0xFF85/0x120)
Questo errore è valido per ISD 510/DSD 510.

Tabella 116: Errore P_STO (0xFF85/0x120)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/scatto
bloccato)

Descrizione Nome LCP

0xFF85 0x120 P_STO error Scatto bloccato La tensione P_STO sulla scheda di
potenza supera i limiti.

P_STO error

9.3.77 Valore guida invertito (0xFF90/0x121)
Questo errore è valido per ISD 510/DSD 510.

Tabella 117: Valore guida invertito (0xFF90/0x121)

Codice Codice PRO-
FINETÆ

Nome Gravità (avviso/
errore/scatto blocca-
to)

Descrizione Nome LCP

0xFF90 0x121 Valore guida in-
vertito

Errore Il valore guida della posizione è stato inver-
tito mentre il servoazionamento era in
modo CAM.

guide val
rev

9.3.78 Valore guida non plausibile (0xFF91/0x122)
Questo errore è valido per ISD 510/DSD 510.
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Tabella 118: Valore guida non plausibile (0xFF91/0x122)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0xFF91 0x122 Valore guida non
plausibile

Errore Incrementi tra valori consecutivi
troppo grandi.

guide val
impl

9.3.79 Errore indicazione attività (0xFF95/0x14E)
Questo errore è valido per ISD 510/DSD 510.

Tabella 119: Errore indicazione attività (0xFF95/0x14E)

Codice Codice PROFI-
NETÆ

Nome Gravità (avviso/errore/
scatto bloccato)

Descrizione Nome LCP

0xFF95 0x14E Errore indicazione atti-
vità

Errore Errore indicazione attivitàÆ

PROFINET.
PNIO SOL error
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10 Manutenzione, disinstallazione e smaltimento

10.1 Avvisi

A V V I S O
ALTA TENSIONE

Sui connettori è presente una tensione potenzialmente letale che può provocare lesioni gravi o mortali.

Prima di lavorare sui connettori di alimentazione o di segnale (scollegando o collegando il cavo) oppure prima di eseguire
lavori di manutenzione, scollegare il modulo di alimentazione (PSM 510) dalla rete e attendere il tempo di scarica.

A V V I S O
TEMPO DI SCARICA

Il servosistema contiene condensatori del collegamento CC che rimangono carichi per un determinato lasso di tempo dopo che

l'alimentazione di rete è stata disinserita dal modulo di alimentazione (PSM 510). Il mancato rispetto del tempo di attesa indicato

dopo aver disinserito l'alimentazione prima di effettuare lavori di manutenzione o riparazione potrebbe causare lesioni gravi o

mortali.

Per evitare scosse elettriche, scollegare completamente il modulo di alimentazione (PSM 510) dalla rete elettrica e attendere
che i condensatori si scarichino completamente prima di eseguire qualsiasi lavoro di manutenzione o di riparazione sul ser-
vosistema o sui relativi componenti.

Tempo di attesa minimo (minuti)

15

10.2 Attività di manutenzione
I servoazionamenti ISD 510/DSD 510 sono pressoché esenti da manutenzione. Solo la tenuta dell'albero sull'ISD 510 (se in uso) è
soggetta a usura. Gli interventi di manutenzione devono essere eseguiti da personale qualificato. Non occorre eseguire altre attività.

Tabella 120: Panoramica delle attività di manutenzione

Componente Attività di manutenzione Intervallo di
manutenzione

Istruzioni

Servoazionamento Eseguire un'ispezione visiva. Ogni 6 mesi Verificare la presenza di eventuali anomalie sulla
superficie del servoazionamento.

Tenuta dell'albero
sull'ISD 510

Controllarne le condizioni e
verificare l'assenza di perdite.

Ogni 6 mesi(1) In caso di danni, sostituire la tenuta dell'albero.

Collegamento a flan-
gia sull'ISD 510

Misurare la resistenza. Ogni 12 mesi. Misurare la resistenza del collegamento a flangia
sull'ISD 510.

Cavo ibrido Controllare la presenza di
danni e usura.

Ogni 6 mesi Se sono presenti danni o usura sostituire il cavo
ibrido.

Freno di stazionamen-
to meccanico (in op-
zione)

Controllare il freno. Ogni 6 mesi Assicurarsi che il freno possa raggiungere la cop-
pia di mantenimento.
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•

•
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•

1.

2.

3.

4.

1.

2.

Componente Attività di manutenzione Intervallo di
manutenzione

Istruzioni

Sicurezza funzionale Spegnere e riaccendere il sis-
tema e verificare la funzione
STO.

Ogni 12 mesi Attivare la funzione STO e verificare lo stato con il
PLC.

Moduli di sistema Controllare il ventilatore. Ogni 12 mesi Controllare che il ventilatore possa girare e rimuo-
vere eventuali tracce di polvere o sporco.

Eseguire un'ispezione visiva Ogni 6 mesi Verificare la presenza di eventuali anomalie sulla
superficie del modulo.

1 Può essere necessario un intervallo più breve a seconda dell'applicazione. Contattare Danfoss per maggiori informazioni.

10.3 Ispezione durante il funzionamento

10.3.1 Servoazionamenti ISD 510/DSD 510
Svolgere regolari ispezioni durante il funzionamento. Controllare a intervalli regolari i servoazionamenti ISD 510/DSD 510 per verifi-
care che non vi siano anomalie.

Prestare particolare attenzione a:

Rumori insoliti (solo ISD 510/DSD 510).

Superfici surriscaldate (possono presentarsi temperature fino a 100 °C durante il funzionamento normale).

Funzionamento irregolare (solo ISD 510/DSD 510).

Forti vibrazioni.

Fissaggi allentati.

Condizione del cablaggio elettrico e dei cavi.

Dispersione termica insufficiente.

10.3.2 Moduli di sistema
Svolgere regolari ispezioni durante il funzionamento.

Verificare che:

Le valvole di raffreddamento non siano bloccate.

Il ventilatore non faccia rumori insoliti.

Il cablaggio elettrico e i cavi siano in buone condizioni.

10.4 Riparazione
Contattare sempre la società di vendita Danfoss locale per informazioni sulla politica di riparazione.

10.5 Sostituzione dei servoazionamenti ISD 510/DSD 510

10.5.1 Smontaggio del servoazionamento ISD 510/DSD 510
Procedura

Scollegare l'alimentazione e attendere il tempo di scarica.

Scollegare i cavi elettrici.

Smontare il servoazionamento.

Sostituire il servoazionamento con uno dello stesso tipo. Per i codici articolo vedere la Guida alla Progettazione VLT® Servo
Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

10.5.2 Installazione e messa in funzione del servoazionamento ISD 510/DSD 510
Procedura

Verificare se è necessaria la preparazione (vedere 4.6.1 Servoazionamento ISD 510/DSD 510).

Installare il servoazionamento (vedere 4.7.5.2 Serraggio del servoazionamento ISD 510).
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Collegare i cavi ibridi (vedere 5.9.3 Collegamento dei cavi ibridi).

Collegare i cavi encoder e/o I/O (vedere 5.9.5.2 Collegamento dei cavi encoder e/o I/O alla porta X3).

Configurare i parametri del servoazionamento in base al bus di campo utilizzato (vedere 6.3 Assegnazione ID EtherCAT® e
6.4 Assegnazione ID Ethernet POWERLINK®).

Eseguire un ciclo di prova.

10.6 Sostituzione dei moduli di sistema

10.6.1 Smontaggio dei moduli di sistema
Scollegare la rete elettrica e tutte le alimentazioni ausiliarie dal PSM 510 e attendere la fine del tempo di scarica.

Scollegare la piastra EMC nella parte inferiore dei moduli di sistema. Non smontare i connettori dalla piastra EMC.

1

2

3

4

e
3
0
b
g
8
1
3
.1

0

Illustrazione 110: Scollegamento della piastra EMC

Scollegare il connettore RJ45 [2] (soltanto su DAM 510).

Svitare la vite [4] sulla piastra EMC.

Premere la clip [3] per rilasciare la piastra EMC.

Svitare la vite PE [1].
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4.



Scollegare la piastra di schermatura I/O sulla parte superiore dei moduli di sistema:

1

3

2

e3
0b

g8
14

.1
0

Illustrazione 111: Scollegamento della piastra di schermatura I/O

Scollegare i connettori superiori [1].

Svitare la vite [2] sulla piastra di schermatura I/O [3].

Tirare la piastra di schermatura I/O verso l'alto per rimuoverla.

Rilasciare il pressacavo di fissaggio [1] nella parte superiore del modulo.

1

e3
0b

g8
15

.1
0

STATUS PSM

DEV

SVS ST

NET ST

LINK/ACT
X1

X2

STATUS DAM
DEV

SVS ST

NET ST

AUX

LINK/ACT
X1

X2

X3

STATUS DAM
DEV

SVS ST

NET ST

AUX

LINK/ACT
X1

X2

X3

LCP
LCP

LCP

Illustrazione 112: Rilascio del pressacavo di fissaggio
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

1.

2.

3.

4.

5.

6.

-

Inclinare il modulo in avanti e rimuoverlo dalla piastra posteriore.

X2

e3
0b

g8
16

.1
0

STATUS PSM

DEV

SVS ST

NET ST

LINK/ACT
LIN

S

X2

LCP

STATUS DAM
DEV

SVS ST
NET ST

AUX

LINK/ACT

X1

X1
X

X2

X3

X3

LCP

Illustrazione 113: Rimozione del modulo

10.6.2 Installazione e messa in funzione dei moduli di sistema
Verificare se è necessaria la preparazione (vedere 4.6.2 Moduli di sistema).

Installare i moduli di sistema (vedere 4.7.7 Istruzioni di installazione per i moduli di sistema).

Collegare i cavi elettrici (vedere il capitolo Installazione elettrica).

Accendere il sistema (vedere 6.8 Accensione del sistema ISD 510/DSD 510).

Configurare i parametri del modulo di sistema secondo il bus di campo utilizzato (vedere 6.3 Assegnazione ID EtherCAT® ,
6.4 Assegnazione ID Ethernet POWERLINK® e 6.5 Assegnazione ID PROFINET®).

Eseguire un ciclo di prova.

10.7 Sostituzione del cavo

10.7.1 Panoramica
Sostituire i cavi quando è stato raggiunto il numero nominale di cicli di piegatura o quando sono danneggiati.

N O T A

Non forzare il collegamento né il montaggio dei connettori: un collegamento errato causa danni permanenti agli stessi.

10.7.2 Sostituzione del cavo di alimentazione

10.7.2.1 Scollegamento del cavo di alimentazione
Procedura
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1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

11.

12.

1.

2.

3.

4.

5.

6.

7.

8.

9.

10.

1.

2.

3.

4.

5.

1.

2.

3.

4.

5.

Scollegare il modulo di alimentazione (PSM 510) dalla sua fonte di alimentazione elettrica (rete elettrica e tutte le alimenta-
zioni ausiliarie).

Attendere la fine del tempo di scarica necessario.

Scollegare i cavi collegati alle porte X3, X4 o X5 sui servoazionamenti ISD 510/DSD 510 per facilitare l'accesso al cavo di
alimentazione.

Scollegare il conduttore PE dalla vite PE sul modulo di accesso decentralizzato (DAM 510).

Scollegare il connettore Ethernet.

Rimuovere la piastra EMC dal DAM 510.

Aprire la fascetta serracavo che mantiene il cavo STO.

Aprire la fascetta serracavo che mantiene il cavo di alimentazione sul DAM 510.

Allentare i passacavi del cavo di alimentazione del DAM 510.

Disinserire il cavo di alimentazione dal DAM 510.

Allentare l'anello filettato del connettore sul servoazionamento.

Disinserire il cavo di alimentazione dal servoazionamento.

10.7.2.2 Sostituzione del cavo di alimentazione
Sostituire il cavo di alimentazione con un cavo di tipo e lunghezza identici. Per i codici articolo vedere la Guida alla Progettazione
VLT® Servo Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

10.7.2.3 Collegamento del cavo di alimentazione
Collegare il connettore femmina del cavo di alimentazione al connettore maschio del primo servoazionamento.

Serrare manualmente gli anelli filettati dei connettori.

Assicurarsi che non sia presente alcuna tensione meccanica sui cavi.

Inserire i fili del cavo di alimentazione nel connettore corretto sulla piastra EMC nella parte inferiore del modulo di accesso
decentralizzato (DAM 510).

Fissare il cavo di alimentazione con una fascetta serracavo.

Fissare il cavo STO con una fascetta serracavo.

Montare la piastra EMC sul DAM 510.

Collegare il connettore Ethernet al DAM 510.

Collegare il conduttore PE alla vite PE sul DAM 510.

Ricollegare tutti i cavi che sono stati collegati alle porte X3, X4 o X5.

10.7.3 Sostituzione del cavo di loop

10.7.3.1 Scollegamento del cavo di loop
Procedura

Scollegare il modulo di alimentazione (PSM 510) dalla sua fonte di alimentazione elettrica (rete elettrica) e da tutte le ali-
mentazioni ausiliarie.

Attendere la fine del tempo di scarica necessario.

Scollegare i cavi collegati alle porte X3, X4 o X5 su entrambi i servoazionamenti ISD 510/DSD 510 per facilitare l'accesso al
cavo di loop.

Allentare gli anelli filettati dei passacavi ad anello su entrambi i servoazionamenti.

Scollegare il cavo di loop dai servoazionamenti.

10.7.3.2 Sostituzione del cavo di loop
Sostituire il cavo di loop con un cavo di tipo e lunghezza identici. Per i codici articolo vedere la Guida alla Progettazione VLT® Servo
Drive System ISD 510, DSD 510, MSD 510 (VLT® Flexmotionô ).

10.7.3.3 Collegamento del cavo di loop
Collegare il connettore maschio del cavo di loop al connettore femmina del servoazionamento.

Collegare il connettore femmina del cavo di loop al connettore maschio del servoazionamento adiacente.

Serrare manualmente gli anelli filettati su entrambi i servoazionamenti.

Assicurarsi che non sia presente alcuna tensione meccanica sui cavi.

Serrare gli anelli filettati dei connettori di entrambi i servoazionamenti.
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1.



2.



3.

Ricollegare tutti i cavi che sono stati collegati alle porte X3, X4 o X5 di entrambi i servoazionamenti.

10.8 Sostituzione del fusibile nel Modulo di accesso decentralizzato (DAM 510)
Se si brucia un singolo fusibile, sostituire tutti i fusibili con fusibili dello stesso lotto (numero CAT fusibile 5012006.25, SIBA).
Procedura

Rimuovere le viti [1] , quindi rimuovere il coperchio.

1

e
3

0
b

g
8

0
0

.1
0

Illustrazione 114: Apertura del coperchio su DAM 510

Utilizzare un cacciavite per rimuovere i fusibili e sostituirli con lo stesso numero di fusibili di tipo identico (vedere 5.5.1 Fusi-
bili).

e
3
0
b
g
8
0
1
.1

0

Illustrazione 115: Rimozione del fusibile

Sostituire il coperchio e serrare le viti. La coppia di serraggio è pari a 2 Nm.
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2.

3.
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10.9 Sostituzione del ventilatore.
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Illustrazione 116: Sostituzione del ventilatore sui moduli da 50 mm
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Illustrazione 117: Sostituzione del ventilatore sui moduli da 100 mm

N O T A

Per maggiori informazioni sui tipi di ventilatore vedere la Guida alla Progettazione VLT® Servo Drive System ISD 510,
DSD 510, MSD 510 (VLT® Flexmotionô ).

Procedura

Utilizzare un cacciavite come leva per sbloccare il supporto del ventilatore.

Rimuovere il ventilatore.

Sostituire il ventilatore con uno di tipo identico.

10.10 Restituzioni dei prodotti
I prodotti Danfoss possono essere restituiti gratuitamente per lo smaltimento. Un prerequisito a tale scopo è che siano privi di depo-
siti, come olio, grasso o altri tipi di contaminanti che impediscono lo smaltimento. Inoltre, non è possibile inviare materiale estraneo
o componenti di altri fabbricanti insieme al prodotto restituito.

Spedire i prodotti franco a bordo alla società di vendita Danfoss locale.

10.11 Riciclo
Portare i metalli e la plastica ai centri di riciclaggio.
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I servoazionamenti e i moduli di sistema sono classificati come rifiuti elettronici e l'imballaggio è classificato come rifiuto da imbal-
laggio.

10.12 Smaltimento
I dispositivi contenenti componenti elettronici non possono essere smaltiti come normali rifiuti domestici.

Smaltire i servoazionamenti e i moduli di sistema come rifiuti pericolosi, rifiuti elettrici, rifiuti riciclabili e simili in conformità alle
norme locali vigenti.
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11 Specifiche

11.1 Targhe

11.1.1 Targa sul servoazionamento ISD 510/DSD 510
Controllare la targa e confrontarla con i dati dell'ordine. Utilizzare il codice articolo come riferimento. Il codice articolo identifica in
modo univoco il tipo convertitore.

Assicurarsi che la targa sia chiaramente leggibile.

I servoazionamenti possono essere identificati esternamente solo dalla targa Danfoss originale.

Sulla targa del servoazionamento sono riportati i seguenti dati:

e3
0b

g8
28

.1
0

VLT ISD 510

Input1: 560-680VDC 3.4A             Input2: 24-48VDC 0.3A

Ambient: 5... 40˚C / 41...104˚F
Enclosure: IP54      Class F

PART NO: 136X6382
SERIAL NO: 001301Q170

 00:1B:08:22:D5:E8

136X6382001301Q170
Made in Italy

Danfoss A/S 6430 
Nordborg, Denmark

SCCR: 5kA
Internal Motor Overload Protection 105%
E134261 Power Conversion Equipment

Mnom: 6.0Nm Nnom: 3000rpm Pnom: 1.9kW fout: 0...590Hz

ISD510AT06C0D6E54FM1PNSXXTF108SXN30BKXSX 
1

2

4
3

5
6

7

8
9

Mmax: 29.9Nm I0: 4.9A M0: 8.6Nm

VAI

Illustrazione 118: Esempio di targa sul servoazionamento ISD 510

1 Codice tipo

2 Tensione di alimentazione:

3 Coppia nominale

4 Coppia massima

5 Intervallo di temperatura ambiente

6 Grado di protezione

7 Tensione di ingresso ausiliario

8 Frequenza di uscita

9 Velocità nominale
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e3
0b

g8
27

.1
0VLT DSD 510

Input1: 560-680VDC 8.3A             Input2: 24-48VDC 1.0A

Ambient: 5˚... 40˚C / 41˚... 104˚F
Enclosure: IP67

PART NO: 136L3447
SERIAL NO: 018601Q050

 00:1B:08:20:E1:BF

136L3447018601Q050
Made in Italy

Danfoss A/S 6430 
Nordborg, Denmark

SSCR: 5kA
Internal Motor Overload Protection 105%
E134261 Power Conversion Equipment

Uout: 3x 0-Input1 VAC Inom: 8.0A Pnom: 4.4kW fout: 0...590Hz

DSD510AC08A8D6E67FRXPLSXXTF2S2XXXXXXXXSX
1

2

4
3

5
6

7

9
8

Umax: 3x 0-Input1 VAC Imax: 21.0A Pmax: 11.5kW

VAI

Illustrazione 119: Esempio di targa sul servoazionamento DSD 510

1 Codice tipo

2 Tensione di alimentazione:

3 Tensione di uscita

4 Tensione massima

5 Intervallo di temperatura ambiente

6 Grado di protezione

7 Frequenza di uscita

8 Potenza di picco

9 Corrente di picco

11.1.2 Targa sui moduli di sistema

11.1.2.1 Esempio di targa sul lato anteriore dei moduli di sistema
Assicurarsi che la targa sia chiaramente leggibile.

I seguenti dati sono riportati sulla targa presente sul lato anteriore dei moduli di sistema:

VLT PSM 510

DANGER

PART NO:     175G0166

SERIAL NO:  966001Q368

OUTPUT: Pnom: 30kW

Notes:

MAC PSM
X1 IN:

X2 OUT:

15 MIN

00:1B:08:15:B3:XX
00:1B:08:15:B3:XX

00:1B:08:15:B3:XX

e3
0b

g2
76

.1
01

2

3
4

5

6

7

8

9
Motor over-temperature sensing is required

Illustrazione 120: Esempio di targa sul lato anteriore dei moduli di sistema
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1 Logo Danfoss

2 Nome del modulo di sistema

3 Codice articolo

4 Numero seriale

5 Uscita

6 Matrice di dati

7 Note

8 Indirizzi MAC

9 Simboli di avviso

11.1.2.2 Esempio di targa presente sul lato dei moduli di sistema
I seguenti dati sono riportati sulla targa presente sul lato dei moduli di sistema:

Illustrazione 121: Esempio di targa presente sul lato dei moduli di sistema per PSM 510

1 Codice tipo

2 Tensione di alimentazione

3 Tensione di uscita

4 Potenza massima

5 Intervallo di temperatura ambiente

6 Grado di protezione: IP20 secondo la norma IEC/
EN 60529 (eccetto i connettori, che sono IP00).

7 Alimentazione UAUX

8 Corrente nominale di cortocircuito

9 Potenza nominale

11.2 Dati caratteristici

11.2.1 Dati caratteristici per il servoazionamento ISD 510 senza freno

Tabella 121: Dati caratteristici per il servoazionamento senza freno

Specifiche Unità Taglia 1,
1,5 Nm

Taglia 2,
2,1 Nm

Taglia 2,
2,9 Nm

Taglia 2,
3,8 Nm

Taglia 3,
5,2 Nm

Taglia 3,
6,0 Nm

Taglia 4,
11,2 Nm

Taglia
4, 13,0
Nm(1)

Velocità
nominale nN

Giri/
min.

4600 4000 2900 2400 3000 3000 2000 –

Coppia
nominale
MN

Nm 1,5 2,1 2,9 3,8 5,2 6,0 11,2 –
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Specifiche Unità Taglia 1,
1,5 Nm

Taglia 2,
2,1 Nm

Taglia 2,
2,9 Nm

Taglia 2,
3,8 Nm

Taglia 3,
5,2 Nm

Taglia 3,
6,0 Nm

Taglia 4,
11,2 Nm

Taglia
4, 13,0
Nm(1)

Corrente
nominale IN

A CC 1,4 1,7 1,8 3,6 3,4 4,7 –

Potenza
nominale PN

kW [cv] 0,72 [0,98] 0,88 [1,20] 0,94 [1,28] 1,6 [2,18] 1,9 [2,58] 2,3 [3,13] –

Coppia di
fermo (stal-
lo) M0

Nm 2,3 2,8 3,6 4,6 6,6 8,6 13,3 –

Corrente di
fermo (stal-
lo) I0

A CC 2,1 2,3 2,1 2,2 4,6 4,9 5,6 –

Coppia di
picco Mmax

Nm 6,1 7,8 10,7 12,7 21,6 29,9 38,6 –

Corrente di
picco (valore
rms) Imax

A CC 5,7 6,4 17,7 19,8 21,2 –

Tensione
nominale

V CC 565–680 ±10%

Induttanza L
fase-fase

mH 18,5 26,8 32,6 33,9 11,9 11,4 18,0 –

Resistenza R
fase-fase

Ω 9,01 7,78 8,61 8,64 2,35 2,10 2,26 –

Costante di
tensione
EMK

V/krpm 70,6 80,9 111,0 132,0 92,7 112,0 158,8 –

Coppia cos-
tante Kt

Nm/A 1,10 1,26 1,72 2,04 1,22 1,51 1,82 –

Inerzia Kgm2 0,000085 0,00015 0,00021 0,00027 0,00062 0,00091 0,0024 –

Misure di
protezione

– Protezione contro i sovraccarichi, i cortocircuiti e il guasto verso terra.

Frequenza
di uscita
massima

Hz 590

Diametro al-
bero

mm
[pollici]

14 [0,55] 19 [0,75] 24 [0,94] 32 [1,26]

Coppie di
poli

– 4 5

Dimensione
flangia

mm
[pollici]

76 [2,99] 84 [3,31] 108 [4,25] 138 [5,43]

Sicurezza
funzionale

– STO
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Specifiche Unità Taglia 1,
1,5 Nm

Taglia 2,
2,1 Nm

Taglia 2,
2,9 Nm

Taglia 2,
3,8 Nm

Taglia 3,
5,2 Nm

Taglia 3,
6,0 Nm

Taglia 4,
11,2 Nm

Taglia
4, 13,0
Nm(1)

Raffredda-
mento

– Tramite flangia

Montaggio – Tramite flangia

Peso kg [lib-
bre]

3,5 [7,7] 4,0 [8,8] 5,0 [11,0] 6,0 [13,2] 8,3 [18,3] 10,0 [22,0] 13,8
[30,4]

–

1 In fase di rilascio

11.2.2 Dati caratteristici per il servoazionamento ISD 510 con freno

Tabella 122: Dati caratteristici per il servoazionamento con freno

Specifiche Unità Taglia 1, 1,5
Nm

Taglia 2,
2,1 Nm

Taglia 2,
2,9 Nm

Taglia 2,
3,8 Nm

Taglia 3,
5,2 Nm

Taglia 3,
6,0 Nm

Taglia 4, 11,2
Nm

Taglia 4,
13,0
Nm(1)

Inerzia freno Kgm2 0,0000012 0,0000068 0,000021 0,000072 –

Peso freno kg [lib-
bre]

0,34 [0,75] 0,63 [1,39] 1,1 [2,42] 2,0 [4,41] –

1 In fase di rilascio

11.2.3 Dati caratteristici per il servoazionamento DSD 510

Tabella 123: Dati caratteristici per DSD 510

Specifiche Unità DSD 510

Ingresso

Collegamento CC V CC 565–680 ±10%

Capacità del collegamento CC μF 10

UAUX V CC 24/48 ±10%

Consumo di corrente UAUX (a 24 V CC) A CC 1

Consumo di corrente UAUX (a 48 V CC) A CC 0,5

Uscita

Numero di fasi di uscita – 3

Tensione di uscita V CA VIN PSM

Corrente nominale IN A CC 12,0 con piastra di montaggio(1), 8,0
standalone

Potenza nominale PN kW [cv] 4,4 [5,9] con piastra di montaggio

Corrente di picco (valore rms) Imax A rms 21,0

Frequenza di commutazione nominale kHz 4/5

Frequenza di commutazione possibile kHz 8/10
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Specifiche Unità DSD 510

Declassamento della corrente nominale e di picco con frequenza di com-
mutazione da 8 kHz

% 62,5

Declassamento della corrente nominale e di picco con frequenza di com-
mutazione da 10 kHz

% 55

Misure di protezione – Protezione contro i sovraccarichi, i
cortocircuiti e il guasto verso terra.

Frequenza di uscita massima Hz 590

Sicurezza funzionale – STO

Raffreddamento – Tramite superficie di montaggio

Montaggio – Montaggio a vite tramite base

Numero di connettori del motore – 1

Peso kg [libbre] 2,85 [6,28]

Dimensioni

(L x A x P)

mm 107,8 x 330,5 x 84

1 Dimensioni: 470 x 270 x 10 mm [18,5 x 10,6 x 0,4 pollici]

11.2.4 Dati caratteristici per il modulo di alimentazione (PSM 510)

Tabella 124: Dati caratteristici per PSM 510

Definizione Unità Taglia di potenza 1 Taglia di potenza 2 Taglia di potenza 3

Ingresso

Tensione di ingresso di rete V CA 400–480 ±10%, trifase (vedere 5.2 Condizioni ambientali elettriche)

Corrente di ingresso a UMIN A 20 34 50

Alimentazione di ingresso VA 12,5 22 32

Tensione di ingresso UAUX V CC 24/48 ±10%

Consumo di corrente UAUX a 24 V CC A CC 2,0

Consumo di corrente UAUX a 48 V CC A CC 1,0

Uscita

Tensione del collegamento CC V CC 565–680 ±10%

Capacità del collegamento CC µF 1800

Corrente nominale IN A 20 40 60

Potenza nominale PN kW 10 20 30

Potenza di picco (Pmax t <3,0 s) kW 20 40 60

Resistore di frenatura interno(1)

Potenza di picco Pmax kW 8
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Definizione Unità Taglia di potenza 1 Taglia di potenza 2 Taglia di potenza 3

Potenza nominale PN W 150

Resistenza nominale Ω 15

Resistore di frenatura esterno

Potenza di picco Pmax kW 60

Potenza nominale PN kW 7,5

Resistenza minima Ω 10

Generale

Misure di protezione – Protezione contro i sovraccarichi, i cortocircuiti e guasto verso terra

Filtro di linea secondo la norma EN 61800-3 – Categoria C3

Raffreddamento – Ventilatore integrato

Montaggio – Montato a parete su piastra posteriore con connettore di backlink

Peso kg 6

Dimensioni (L x A x P) mm 137,3 x 406,3 x 270

1 È possibile collegare un resistore di frenatura interno.

11.2.5 Dati caratteristici del Modulo di accesso decentralizzato (DAM 510)

Tabella 125: Dati caratteristici per DAM 510

Definizione Unità Taglia di potenza 1 Taglia di potenza 2

Ingresso

Collegamento CC V CC 565–680 ±10%

Capacità del collegamento CC µF 660

Corrente di ingresso massima A CC 15 24

UAUX V CC 24/48 ±10%

Consumo di corrente UAUX a 24 V CC A CC 0,5

Consumo di corrente UAUX a 48 V CC A CC 0,3

Uscita

Tensione di uscita V CC VOUT PSM

Corrente di uscita del collegamento CC A CC 15 25

Collegamento CC in corrente di picco (valore rms) t
<1,0 s

Arms 30 per <1 s 48 per <1 s

Corrente di uscita UAUX A CC 15

Generale

Misure di protezione – Protezione contro i sovraccarichi, i cortocircuiti e guasto verso terra

AQ262449648484it-000201 / 175R1135198 | Danfoss A/S © 2020.10

Specifiche

VLT® Servo Drive System ISD 510/DSD 510

Guida operativa



Definizione Unità Taglia di potenza 1 Taglia di potenza 2

Raffreddamento – Convezione naturale

Montaggio – Montato a parete su piastra posteriore con connettore di backlink

Peso kg 3,05

Dimensioni (L x A x P) mm 84,3 x 471 x 270

11.2.6 Dati caratteristici per il modulo di condensatori ausiliari (ACM 510)

Tabella 126: Dati caratteristici per ACM 510

Definizione Unità Valore

Collegamento CC V CC 565–680 ±10%

Capacità del collegamento CC µF 2750

UAUX V CC 24/48 ±10%

Consumo di corrente UAUX a 24 V CC A CC 0,5

Consumo di corrente UAUX a 48 V CC A CC 0,3

Raffreddamento – Convezione naturale

Montaggio – Montato a parete su piastra posteriore con connettore di backlink

Peso kg 3,54

Dimensioni (L x A x P) mm 84 x 371 x 270

11.3 Dimensioni

11.3.1 Dimensioni della flangia del servoazionamento ISD 510

Taglia Spessore della flangia [mm]

Taglia 1, 1,5 Nm 7

Taglia 2, 2,1 Nm –

Taglia 2, 2,9 Nm 8

Taglia 2, 3,8 Nm 8

Taglia 3, 5,2 Nm 10,8

Taglia 3, 6,0 Nm 10,8

Taglia 4, 11,2 Nm 13,8

Taglia 4, 13,0 Nm(1) –

1 In fase di rilascio

11.3.2 Dimensioni del servoazionamento ISD 510
Tutte le dimensioni sono in mm (pollici).
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Illustrazione 122: Dimensioni di ISD 510 Taglia 1, 1,5 Nm
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Illustrazione 124: Dimensioni di ISD 510 Taglia 2, 2,9 Nm
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108

Ø110

Ø130

 (
4
x
)

Ø
9

108

21.3

3

50

Ø
2
4

1
3
1

1
7
9

276.3

70

[7
.0

4
]

[5
.1

5
]

[0
.9

4
]

[0
.3

5
]

[10.8]

[0.83]

[0.11]

[2.75]
[4.25]

[4.25]

[4.33]

[5.11]

[1.96] e
3
0
b
g
4
2
1
.1

0

Illustrazione 126: Dimensioni di ISD 510 Taglia 3, 5,2 Nm
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Illustrazione 127: Dimensioni di ISD 510 Taglia 3, 6,0 Nm
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Illustrazione 128: Dimensioni di ISD 510 Taglia 4, 11,2 Nm

11.3.3 Dimensioni del servoazionamento DSD 510
Tutte le dimensioni sono in mm (pollici).
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Illustrazione 129: Dimensioni del servoazionamento DSD 510

11.3.4 Dimensioni del modulo di alimentazione (PSM 510)
Tutte le dimensioni sono in mm (pollici).
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Illustrazione 130: Dimensioni di PSM 510

11.3.5 Dimensioni del modulo di accesso decentralizzato (DAM 510)
Tutte le dimensioni sono in mm (pollici).
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Illustrazione 131: Dimensioni di DAM 510

11.3.6 Dimensioni del modulo di condensatori ausiliari (ACM 510)
Tutte le dimensioni sono in mm (pollici).
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Illustrazione 132: Dimensioni di ACM 510

11.3.7 Dimensioni del modulo di espansione (EXM 510)
Tutte le dimensioni sono in mm (pollici).
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Illustrazione 133: Dimensioni di EXM 510
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11.4 Protezione da sovraccarico motore

N O T A

La protezione da sovraccarico motore interno funziona al 105% della corrente a pieno carico del motore.

Fornire istruzioni al DSD 510 con corrente nominale del motore (corrente a pieno carico secondo l'etichetta tecnica del mo-
tore) per utilizzare la protezione in modo corretto.

Il DSD 510 comprende una protezione da sovraccarico interno nei seguenti multipli dell'impostazione della corrente:

Tabella 127: Multipli di impostazione della corrente

Multiplo dell'impostazione della corrente Tempo massimo di scatto

7,2 20 s

1,5 8 min.

1,2 2 ore

11.5 Protezione da sovratemperatura del motore
La protezione da sovraccarico motore interno non dispone di capacità di ritenzione della memoria termica né di sensibilità alla ve-
locità.

N O T A

La protezione da sovratemperatura motore interno non è integrata nel DSD 510, per cui è necessario un sensore di sovra-
temperatura del motore. Il DSD 510 dispone di un ingresso per quest'ultimo.

Nell'ISD 510 è integrato un sensore di temperatura.

N O T A

Utilizzare un motore con isolamento rinforzato tra il termistore e gli avvolgimenti del motore (testato con impulsi dipicco da
4300 V CC e 8000 V).

11.6 Protezione del cavo ibrido
L'AUX 24/48 V presenta tre livelli di protezione:

Software (intervallo di temporizzazione in secondi): le schede di controllo aprono l'AUX da 24/48 V se è presente un sovraccari-
co (>15 A).

Hardware (intervallo di temporizzazione in microsecondi): si apre automaticamente se è presente un cortocircuito superiore a
36 A.

Hardware: un fusibile SMD (Surface Mounted Device) non sostituibile da 20 A in caso di malfunzionamento delle prime due
misure di protezione.
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11.7 Forze consentite sull'albero del servoazionamento ISD 510
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Illustrazione 134: Forze consentite

Il carico assiale e radiale massimo durante il montaggio del motore e per qualsiasi dispositivo meccanico collegato all'albero non
deve superare i valori indicati in Tabella 128. L'albero deve essere caricato lentamente e in modo costante: evitare carichi pulsanti.

N O T A

Il cuscinetto può essere danneggiato in modo permanente in caso di superamento delle forze massime consentite.

Tabella 128: Capacità di carico massime

Dimensioni motore Forza radiale massima (Fr) in N Forza assiale massima (Fa) in N

Taglia 1 450 1050

Taglia 2 900 1700

Taglia 3 830 1740

Taglia 4 1940 2200

Le capacità di carico radiale massime si basano sulle seguenti considerazioni:

I servoazionamenti vengono azionati con la coppia di picco dell'elemento più lungo della taglia frame.

Il carico completamente invertito viene applicato all'estremità dell'estensione standard dell'albero di montaggio del diametro
più piccolo.

Durata infinita con affidabilità standard del 99%.

Fattore di sicurezza = 2

11.8 Connettori sul servoazionamento ISD 510/DSD 510

11.8.1 X1 e X2: connettore ibrido (M23)
Il cavo ibrido fornisce l'alimentazione (di rete e ausiliaria), le linee di comunicazione e l'alimentazione di sicurezza per ogni linea di
servoazionamenti. I connettori di ingresso e di uscita sono collegati all'interno del servoazionamento.
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Illustrazione 135: Piedinatura del connettore ibrido maschio X1 (M23)
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Illustrazione 136: Piedinatura del connettore ibrido femmina X2 (M23)

Tabella 129: Piedinatura dei connettori ibridi X1 e X2 (M23)

Piedinatura Descrizione Note Grado/parametro

A UDC- Alimentazione CC negativa Tensione di esercizio: 565–680 V CC, massimo 778 V

Alimentazione CC negativa (massimo -15 A/25 A)

B UDC+ Alimentazione CC positiva Tensione di esercizio: 565–680 V CC, massimo 778 V

Alimentazione CC positiva (massimo 15 A/25 A)

C AUX+ Alimentazione ausiliaria 24-48 V CC ±10%, 15 A

Assoluta massimo 55 V CC
D AUX- Messa a terra dell'alimentazione ausiliaria

PE PE Connettore PE 15 A

2 STO+ Alimentazione di sicurezza 24 V CC ±10%, 1 A

3 STO- Messa a terra dell'alimentazione di sicurezza

5 TD+ Trasmissione Ethernet positiva Secondo lo standard 100BASE-T

6 RD- Ricezione Ethernet positiva

7 TD- Trasmissione Ethernet negativa

8 RD+ Ricezione Ethernet negativa
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11.8.2 X3: terzo connettore Ethernet (M8, 4 poli)
I servoazionamenti avanzati ISD 510/DSD 510 dispongono di una porta bus di campo supplementare (X3) per il collegamento di un
dispositivo che comunica attraverso il bus di campo selezionato.
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Illustrazione 137: Piedinatura del terzo connettore Ethernet X3 (M8, 4 poli)

Tabella 130: Piedinatura del terzo connettore Ethernet X3 (M8, 4 poli)

Piedinatura Descrizione Note Grado/parametro

1 TD+ Trasmissione Ethernet positiva Secondo lo standard 100BASE-T

2 RD+ Ricezione Ethernet positiva

3 RD- Ricezione Ethernet negativa

4 TD- Trasmissione Ethernet negativa

11.8.3 X4: Connettore encoder e/o I/O (M12, 8 poli)
Il connettore X4 è disponibile sui servoazionamenti avanzati ISD 510/DSD 510 e può essere configurato come:

Uscita digitale

Ingresso digitale

Ingresso analogico

Alimentazione 24 V

Interfaccia encoder esterna (SSI o BiSS)
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Illustrazione 138: Piedinatura del connettore encoder e/o I/O X4 M12

Tabella 131: Piedinatura del connettore encoder e/o I/O X4 M12

Piedina-
tura

Descrizione Note Grado/parametro

1 Uscita digitale Commutata 24 V come uscita o alimentazione
digitale (24 V/150 mA)

Tensione nominale: 24 V ±15%

Corrente massima: 150 mA

Frequenza di commutazione massima: 100 Hz

2 Terra Terra isolata -

3 Ingresso 1 Ingresso analogico/digitale Ingresso digitale:

Tensione nominale: 0-24 V

Larghezza di banda: ≦ 100 kHz
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Piedina-
tura

Descrizione Note Grado/parametro

Ingresso analogico:

Tensione nominale: 0-10 V

Impedenza in ingresso: 5,46 kΩ

Larghezza di banda: ≦ 25 kHz

4 /SSI CLK Clock in uscita SSI/BiSS negativo SSI:

Velocità del bus: 0,5 Mbit con un cavo di 25 m

BiSS:

soddisfa le specifiche RS485.

Lunghezza massima del cavo (SSI e BiSS): 25 m

5 SSI DAT Dati in ingresso SSI/BiSS positivi

6 SSI CLK Clock in uscita SSI/BiSS positivo

7 Ingresso 2 Ingresso analogico/digitale Ingresso digitale:

Tensione nominale: 0-24 V

Larghezza di banda: ≦ 100 kHz

Ingresso analogico:

Tensione nominale: 0-10 V

Impedenza in ingresso: 5,46 kΩ

Larghezza di banda: ≦ 25 kHz

8 /SSI DAT Dati in ingresso SSI/BiSS negativi SSI:

Velocità del bus: 0,5 Mbit con un cavo di 25 m

BiSS:

soddisfa le specifiche RS485.

Lunghezza massima del cavo (SSI e BiSS): 25 m

11.8.4 X5: connettore LCP (M8, a 6 poli)
Il connettore X5 è usato per collegare l'LCP direttamente sui servoazionamenti avanzati ISD 510/DSD 510 tramite un cavo.
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Illustrazione 139: Piedinatura del connettore LCP X5 (M8, a 6 poli)

Tabella 132: Piedinatura del connettore LCP X5

Piedinatura Descrizione Note Grado/parametro

1 Non connesso – –

2 /LCP RST Ripristino Attivo a ≦0,5 V

3 LCP RS485 Segnale RS485 positivo Velocità:

38,4 kBd

I livelli soddisfano le specifiche RS485.
4 /LCP RS485 Segnale RS485 negativo

5 GND GND –

6 VCC Alimentazione di 5 V per LCP 5 V ±10% con carico massimo di 120 mA
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11.8.5 X6: connettore motore standard/HIPERFACE DSL
Il connettore motore standard/HIPERFACE DSL è un connettore femmina M23.
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Illustrazione 140: Piedinatura del connettore motore X6

Tabella 133: Piedinatura del connettore motore X6

Piedi-
natura

Descri-
zione

Note Grado/parametro

1 U Fase U del motore Tensione nominale: 400–480 V ±10% (vedere 11.2.3 Dati caratteristici
per il servoazionamento DSD 510)

Sezione trasversale del conduttore: 2,5 mm2PE PE Messa a terra di protezione

3 W Fase W del motore

4 V Fase V del motore

A Freno+ Utilizzato per collegare il fre-
no meccanico del motore (se
presente).

Tensione nominale: 24 V

Tensione massima (di picco): 48 V ±10%

Sezione trasversale del conduttore: 0,75 mm2
B Freno–

C Dati–(1) Linea negativa HIPERFACE
DSL

–

D Dati+(1) Linea positiva HIPERFACE DSL –

1 I segnali dati+/- sono presenti solo sulla variante HIPERFACE DSL, in caso contrario nessuno dei due segnali è collegato.

11.8.6 X7: connettore di retroazione del motore
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Illustrazione 141: Piedinatura del connettore di retroazione del motore X7

Tabella 134: Piedinatura del connettore di retroazione del motore X7

Piedinatura Descrizione Resolver BISS B HIPERFACE EnDat 2.1 e 2.2 Grado/parametro

1 RESSIN X – X (1) Ingresso seno positivo del resolver

2 GND – X X X GND

3 RESCOS X – X (1) Ingresso coseno positivo del resolver
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Piedinatura Descrizione Resolver BISS B HIPERFACE EnDat 2.1 e 2.2 Grado/parametro

4 VEE – X X X +5/11 V(2)

5 RXTX – X X X Segnale dati positivi dell'encoder

6 \RESSY X – – – Uscita del trasduttore negativa del resolver

7 TEMP+ X X X X Ingresso sensore temperatura del motore

8 ENC_CLK – X – – Segnale orologio positivo dell'encoder

9 \RESSIN X – X (1) Ingresso seno negativo del resolver

10 – – – – – –

11 \RESCOS X – X (1) Ingresso coseno negativo del resolver

12 – – – – – –

13 \RXTX – X X X Segnale dati negativi dell'encoder

14 TEMP– X X X X Ingresso sensore temperatura del motore

15 \ENC_CLK – X – – Segnale orologio negativo dell'encoder

16 – – – – – –

17 RESSY X – – – Uscita del trasduttore positiva del resolver

1 I segnali SENO e COSENO sono opzionali per EnDat

2 L'alimentazione è commutata automaticamente da 5 V a 11 V a seconda del tipo di retroazione selezionato.

11.9 Connettori sui moduli di sistema

11.9.1 Connettore di backlink
Il connettore di backlink si trova nella parte superiore del lato posteriore di tutti i moduli di sistema ISD 510.
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Illustrazione 142: Piedinatura del connettore di backlink

Tabella 135: Piedinatura del connettore di backlink

Piedinatura Descrizione

1 24/48 V

2 GND

3 FE: Terra funzionale

4 CC-

5 CC+
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11.9.2 Connettori del freno
I connettori del freno si trovano sul modulo di alimentazione (PSM 510).

11.9.2.1 Connettore della resistenza di frenatura su PSM 510
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Illustrazione 143: Connettore del freno su PSM 510

Tabella 136: Piedinatura sul connettore del freno su PSM 510

Poli (da
sinistra a
destra)

Descri-
zione

Note Valori nominali

1 CC+/R+ Utilizzato per il collegamento di
una resistenza di frenatura.

Tensione nominale: 560–800 V CC

Corrente frenante massima: 80 A

Intervallo della sezione trasversale del conduttore: 0,75–
16 mm2 (AWG 18–AWG 4)

2 R–

N O T A

La lunghezza massima del cavo del freno è pari a 30 m (schermato).

11.9.3 Connettori Ethernet
I connettori Ethernet si trovano su tutti i moduli di sistema.
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Illustrazione 144: Connettore Ethernet

N O T A

Solamente il potenziale PELV può essere collegato agli ingressi e alle uscite digitali.

11.9.3.1 Connettori Ethernet su PSM 510 e ACM 510

Tabella 137: Connettori Ethernet su PSM 510 e ACM 510

Nome del connettore Descrizione Piedinatura Gradi

X1 IN Ingresso Ethernet 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

Secondo lo standard 100BASE-T.

X2 OUT Uscita Ethernet 1
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Nome del connettore Descrizione Piedinatura Gradi

8: –

11.9.3.2 Connettori Ethernet su DAM 510

Tabella 138: Connettori Ethernet su DAM 510

Nome del connettore Descrizione Piedinatura Gradi

X1 IN Ingresso Ethernet 1: TX+

2: TX–

3: RX+

4: –

5: –

6: RX–

7: –

8: –

Secondo lo standard 100BASE-T.

X2 OUT Uscita Ethernet 1 (collegamento al cavo ibrido)

X3 OUT Uscita Ethernet 2

11.9.4 Connettori I/O

11.9.4.1 Connettore I/O su PSM 510/ACM 510
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Illustrazione 145: Connettore I/O su PSM 510 (I/O PSM) e ACM 510 (I/O ACM)

Tabella 139: Piedinatura del connettore I/O su PSM 510/ACM 510

Piedinatura Descrizione Note Grado/parametro

1 DIN1– Ingresso digitale Tensione di ingresso: 0–30 V CC

Alta tensione (logica "1"): 15–30 V CC

Bassa tensione (logica "0"): <5 V CC

Frequenza massima della tensione di ingresso: 50 Hz

Corrente di ingresso massima a 48 V: 11 mA

Resistenza di ingresso massima: 4,5 KΩ

2 DIN1+

3 DIG_OUT– Uscita digitale Tensione massima tra i morsetti: 24 V CC o CA

Corrente massima: 1 A

Frequenza di commutazione di uscita massima: 50 Hz
4 DIG_OUT+

L'intervallo della sezione trasversale del conduttore è di 0,2-1,5 mm2 (AWG 24–AWG 16).

N O T A

Solamente il potenziale PELV può essere collegato agli ingressi e alle uscite digitali.
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11.9.5 Connettore UAUX
Il connettore UAUX si trova sul modulo di alimentazione (PSM 510).
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Illustrazione 146: Connettore UAUX

Tabella 140: Piedinatura del connettore UAUX

Piedina-
tura

(da sinis-
tra a
destra)

Descri-
zione

Note Grado/parametro

1 24 V
AUX

Utilizzato per l'ingres-
so 24-48 V CC per il
modulo di alimenta-
zione (PSM 510).

Tensione di ingresso nominale: 24 V/48 V CC ±10%

Corrente nominale: dipende dal numero di servoazionamenti presenti nell'appli-
cazione.

Corrente massima: 50 A

Sezione trasversale massima: 16 mm2

Lunghezza massima del cavo: 3 m

Intervallo della sezione trasversale del cavo conduttore pari a 0,75–16 mm2, fisso
o flessibile (AWG 18-AWG 4)

2 GND

N O T A

Solamente il potenziale PELV può essere collegato all'ingresso UAUX.

11.9.5.1 Sezioni trasversali dei cavi da 24/48 V per PSM 510

Sezione trasversale minima dei cavi per CE (minimo 70 °C, Cu) 16 mm2

Sezione trasversale minima dei cavi per UL (minimo 60 °C, Cu) 4 AWG

11.9.6 Connettori LCP (M8, a 6 poli)
Il connettore LCP si trova sulla parte anteriore di tutti i moduli di sistema. Viene utilizzato per collegare l'LCP direttamente con un
cavo.
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Illustrazione 147: connettore LCP (M8, a 6 poli)
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Tabella 141: Piedinatura del connettore LCP

Piedinatura Descrizione Note Grado/parametro

1 Non connesso – –

2 /LCP RST Ripristino Attivo a ≦0,5 V

3 LCP RS485 Segnale RS485 positivo Velocità:

38,4 kBd

I livelli soddisfano le specifiche RS485.
4 /LCP RS485 Segnale RS485 negativo

5 GND GND –

6 VCC Alimentazione di 5 V per LCP 5 V ±10% con carico massimo di 120 mA

N O T A

Solamente il potenziale PELV può essere collegato all'ingresso LCP.

11.9.7 Connettore di rete CA
Il connettore di rete CA si trova nella parte inferiore del modulo di alimentazione (PSM 510).
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Illustrazione 148: Connettore di rete CA

Tabella 142: Piedinatura del connettore di rete CA

Piedina-
tura

(da sinis-
tra a des-
tra)

Descri-
zione

Note Grado/parametro

1 L3 Usato per colle-
gare L1/L2/L3

Tensione nominale: 400–480 V CA ±10%

Potenza nominale: 30 kW

Sezione trasversale massima: 16 mm2 (AWG 4)

Intervallo della sezione trasversale del cavo conduttore pari a 0,75–16 mm2, fisso o
flessibile (AWG 18-AWG 4)

2 L2

3 L1

11.9.7.1 Sezioni trasversali dei cavi di rete per PSM 510

Tabella 143: Sezioni trasversali dei cavi di rete per PSM 510

PSM 510 (10 kW) PSM 510 (20 kW) PSM 510 (30 kW)

Sezione trasversale dei cavi minima per CE 4 mm2

(minimo 70 °C, Cu)

16 mm2

(minimo 70 °C, Cu)

16 mm2

(minimo 90 °C, Cu)

Sezione trasversale dei cavi minima per UL AWG 10

(minimo 60 °C, Cu)

AWG 6

(minimo 60 °C, Cu)

AWG 4

(minimo 75 °C, Cu)
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11.9.8 Connettore per relè
Il connettore per relè viene utilizzato per una risposta definita dall'utente e si trova nella posizione seguente:

Modulo di alimentazione PSM 510: un connettore per relè

Modulo di condensatori ausiliari ACM 510: un connettore per relè

N O T A

Solamente il potenziale PELV può essere collegato alle uscite a relè.

11.9.8.1 Connettore per relè su PSM 510/ACM 510
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Illustrazione 149: Connettore per relè su PSM 510/ACM 510

Tabella 144: Piedinatura del connettore per relè su PSM 510 (REL PSM) e ACM 510 (REL ACM)

Poli Descri-
zione

Note Grado/parametro

11 NC Normalmente chiuso,
24 V CC

Corrente nominale: 2 A

Intervallo della sezione trasversale del conduttore: 0,2–1,5 mm2 (AWG 24–AWG 16)

12 NO Normalmente aperto,
24 V CC

13 COM Comune

11.9.9 Connettori STO

11.9.9.1 Connettori STO su PSM 510
Sul modulo di alimentazione sono presenti un connettore STO di ingresso e uno di uscita (PSM 510).
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Illustrazione 150: Connettore di uscita STO su PSM 510
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Illustrazione 151: Connettore di ingresso STO su PSM 510

Tabella 145: Piedinatura dei connettori STO su PSM 510

Nome
del con-
nettore

Piedi-
na-
tura

Descri-
zione

Note Grado/parametro

STO PSM 1 STO– Utilizzato per la tensione
di uscita STO all'ingresso
degli altri moduli di siste-
ma.

Tensione nominale: 24 V CC ±10%

Corrente nominale: dipende dal numero di servoazionamenti presen-
ti nell'applicazione.

Corrente massima: 1 A

Intervallo della sezione trasversale del conduttore: 0,2–1,5 mm2

(AWG 24–AWG 16)

2 STO+

3 STO– Utilizzato per la tensione
di ingresso STO.

4 STO+

N O T A

Solamente il potenziale PELV può essere collegato agli ingressi STO.
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11.9.9.2 Connettori STO sul DAM 510

11.9.9.2.1 Connettori STO sulla parte superiore di DAM 510
Sulla parte superiore del modulo di accesso decentralizzato (DAM 510) sono presenti un connettore STO di ingresso e un connet-
tore STO di uscita.
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Illustrazione 152: Connettore di uscita STO sulla parte superiore di DAM 510
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Illustrazione 153: Connettore di ingresso STO sulla parte superiore di DAM 510

Tabella 146: Piedinatura dei connettori STO sulla parte superiore di DAM 510

Nome
del con-
nettore

Poli Descri-
zione

Note Grado/parametro

STO
DAM

1 STO– Utilizzato per la tensione
di uscita STO all'ingresso
degli altri moduli di siste-
ma.

Tensione nominale: 24 V CC ±10%

Corrente nominale: dipende dal numero di servoazionamenti presenti
nell'applicazione.

Corrente massima: 1 A

Intervallo della sezione trasversale del conduttore: 0,2–1,5 mm2

(AWG 24–AWG 16)

2 STO+

3 STO– Utilizzato per la tensione
di ingresso STO.

4 STO+
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N O T A

Solamente il potenziale PELV può essere collegato agli ingressi STO.

11.9.9.2.2 Connettore STO sulla parte inferiore di DAM 510
Sulla parte inferiore del modulo di accesso decentralizzato (DAM 510) è presente un connettore STO di uscita. L'uscita è destinata al
cavo ibrido.

e
3

0
b

g
4

5
7

.1
0

Illustrazione 154: Connettore STO sulla parte inferiore di DAM 510

Tabella 147: Piedinatura del connettore STO sulla parte inferiore di DAM 510

Nome
del con-
nettore

Poli

(da sin-
istra a
destra)

Descri-
zione

Note Grado/parametro

STO DAM 1 STO+ Utilizzato per
l'uscita STO dal
DAM al cavo
ibrido.

Tensione nominale: 24 V CC ±10%

Corrente nominale: dipende dal numero di servoazionamenti presenti
nell'applicazione.

Corrente massima: 1 A

Intervallo della sezione trasversale del conduttore: 0,2–1,5 mm2 (AWG 24–
AWG 16)

Coppia di serraggio dei morsetti a spina: 0,22–0,25 Nm

2 STO–

11.9.10 Connettore UDC
Il connettore UDC si trova nella parte inferiore del modulo di accesso decentralizzato (DAM 510).
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Illustrazione 155: Connettore UDC

Tabella 148: Piedinatura del connettore UDC

Piedina-
tura

(da sinis-
tra a
destra)

Descri-
zione

Note Grado/parametro

1 UDC+ Utilizzato per collegare la tensione
del collegamento CC dal modulo di
accesso decentralizzato (DAM 510) al
cavo ibrido per la linea ISD.

Tensione nominale: 560–800 V CC

Corrente nominale: dipende dal numero di servoazionamenti pre-
senti nell'applicazione.

Corrente massima: 25 A

2 UDC–
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Piedina-
tura

(da sinis-
tra a
destra)

Descri-
zione

Note Grado/parametro

Intervallo della sezione trasversale del conduttore: 0,2–6 mm2

(AWG 24–AWG 10)

Coppia di serraggio dei morsetti a spina: 0,5–0,8 Nm

11.9.11 Connettore AUX
Il connettore AUX si trova nella parte inferiore del modulo di accesso decentralizzato (DAM 510).
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Illustrazione 156: Connettore AUX

Tabella 149: Piedinatura del connettore AUX

Piedina-
tura

(da sin-
istra a
destra)

Descri-
zione

Note Grado/parametro

1 AUX+

(24/48 V)

Utilizzato per collegare l'uscita
AUX dal modulo di accesso de-
centralizzato (DAM 510) al cavo
ibrido per la linea di servoaziona-
mento.

Tensione nominale: 24/48 V CC ±10%

Corrente nominale: dipende dal numero di servoazionamenti pre-
senti nell'applicazione.

Corrente massima: 15 A

Intervallo della sezione trasversale del conduttore: 0,2–2,5 mm2

(AWG 24–AWG 12)

Coppia di serraggio dei morsetti a spina: 0,5–0,6 Nm

2 AUX–
(GND)

N O T A

Solamente il potenziale PELV può essere collegato all'uscita AUX.

11.9.12 Connettori per encoder esterno
Questo connettore viene utilizzato per collegare un encoder esterno a DAM 510. Fornisce un valore guida per le modalità CAM e
Trasmissione. Il connettore dell'encoder esterno si trova sul modulo di accesso decentralizzato (DAM 510) come riportato di seguito:

DAM 510: E DAM

5 1

69 e3
0b

g4
61

.1
0

Illustrazione 157: Connettore per encoder esterno
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Tabella 150: Connettori per encoder esterno

Nome del
connettore

Descrizione Piedinatura Gradi/Note

E DAM Utilizzato per collegare
l'encoder esterno a
DAM 510.

Vedere Tabel-
la 151.

Tensione nominale: 24 V CC, isolata (vedere Tabella 151)

Corrente nominale: dipende dal numero di servoazionamenti presenti
nell'applicazione.

Corrente massima: 150 mA (vedere Tabella 151)

Attenersi alle seguenti specifiche:

BISS/SSI

Tabella 151: Piedinatura dei connettori per encoder esterno (X1/X2)

Piedina-
tura

Descrizione Note

SSI/BiSS

Note

1 24 V 24 V CC ±10% (utilizzato per alimentare
l'encoder)

Corrente massima: 150 mA

2 – – –

3 – – –

4 RS422 RXD Dati positivi Velocità del bus:

SSI: frequenza dell'orologio fino a 10 Mhz con 30 m di
cavo.

BiSS: soddisfa le specifiche RS485.

5 RS422 TXD Dati positivi

6 GX Terra isolata.

Se gli encoder sono alimentati esterna-
mente, la terra dell'alimentazione esterna
deve essere collegata a GX.

–

7 – – –

8 /RS422 RXD Dati negativi Velocità del bus:

SSI: 0,5 Mbit con un cavo di 25 m.

BiSS: soddisfa le specifiche RS485.
9 /RS422 TXD Dati negativi

N O T A

Solamente il potenziale PELV può essere collegato all'encoder esterno.

11.9.13 Connettore del modulo di espansione

e3
0b

h3
90

.1
0

DC+ DC- GND
24 V
48 V

Illustrazione 158: Connettore del modulo di espansione
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Tabella 152: Piedinatura del connettore del modulo di espansione

Piedi-
na-
tura

(da
sinis-
tra a
des-
tra)

Descri-
zione

Nota Grado/parametro

1 CC+ Schermare i
cavi CC con il
pressacavo sul-
la piastra EMC
dell'EXM 510.

Tensione nominale: 560–800 V CC

Corrente nominale: dipende dal numero di servoazionamenti presenti nell'applicazione.

Corrente massima: 62 A
(1)

Intervallo della sezione trasversale del conduttore: 0,75–16 mm2, fisso o flessibile
(AWG 18–AWG 4)

Utilizzare soltanto con ghiera senza manicotto in plastica con CRIMPFOX 16 S.

Utilizzare conduttori schermati per UDC (CC+, CC-).

Coppia di serraggio dei morsetti a spina: 1,7–1,8 Nm

2

3 CC-

4

5 FE (terra
funzio-
nale)

–

6 GND –

7 24/48 V –

1 La corrente nominale massima per una coppia di EXM è pari a 62 A. Nei sistemi con due moduli PSM 510, è possibile utilizzare due coppie di moduli
EXM 510 per ottenere una corrente nominale massima di 124 A.

11.9.13.1 Sezioni trasversali dei cavi per EXM 510

Tabella 153: Sezioni trasversali minime per cavi EXM 510

Cavo CE UL

CC+/CC– 16 mm2 (minimo 70 °C, Cu) 6 AWG (minimo 75 °C, Cu)

24 V, PE funzionale 16 mm2 (minimo 70 °C, Cu) 6 AWG (minimo 90 °C, Cu)(1)

1 Sono ammessi almeno 75 °C se sul cavo vengono misurati meno di 45 A.

11.10 Specifiche generali e dati ambientali

11.10.1 Servoazionamento ISD 510/DSD 510

Tabella 154: Specifiche generali e condizioni ambientali per ISD 510/DSD 510

Specifica Valore

Test di vibrazione Vibrazioni casuali: 7,54 g (2 h/asse in conformità alla norma EN 60068-2-64)

Vibrazione sinusoidale: 0,7 g (2h/asse in conformità alla norma EN 60068-2-6)

Umidità relativa massima Immagazzinamento/trasporto: 5–93% (senza condensa)

Uso fisso: 15–85% (senza condensa)

Temperatura ambiente Funzionamento: 5-40 °C nominale, fino a 55 °C con declassamento

Trasporto: da -25 a +70 °C

Immagazzinamento: da -25 a +55 °C
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Specifica Valore

Installazione in altitudine Nessuna limitazione fino a 1000 m sul livello del mare.

Massimo 2000 m sul livello del mare con declassamento.

Declassamento del 9% fino a 2000 m con tensione di alimentazione normale, trifase
CA 400 V.

Norme EMC per emissione e immunità EN 61800-3

Immunità EMC per la sicurezza funzionale EN 61800-5-2 Allegato E

Livello di inquinamento 2

Categoria di sovratensione III

Classi IP Vedere la 11.11.1 Gradi di protezione per servoazionamento ISD 510 e la 11.11.2 Gra-
di di protezione per il servoazionamento DSD 510.

11.10.2 Moduli di sistema

Tabella 155: Specifiche generali e condizioni ambientali per i moduli di sistema

Specifica Valore

Grado di protezione IP20 secondo la norma IEC/EN 60529 (eccetto i connettori, che sono IP00).

A V V I S O
RISCHIO DI SCOSSA ELETTRICA

Il grado IP20 dei moduli PSM 510, DAM 510 e ACM 510 non è soddisfatto se i

moduli non sono collegati alla piastra posteriore. Questo può comportare il ri-

schio di morte o lesioni gravi.

Non toccare la piastra posteriore quando un modulo viene rimosso dalla
piastra posteriore.

Test di vibrazione Vibrazioni casuali: 1,14 g (2 h/asse in conformità alla norma EN 60068-2-64)

Vibrazioni sinusoidali: 1,0 g (2 h/asse in conformità alla norma EN 60068-2-6)

Umidità relativa massima Immagazzinamento/trasporto: 5–95% (senza condensa)

Uso fisso: 5–93% (senza condensa)

Intervallo di temperatura ambiente Funzionamento: 5-40 °C nominale, fino a 55 °C con declassamento (vedere Illustra-
zione 159)

Trasporto: da -25 a +55 °C

Immagazzinamento: da -25 a +55 °C

Installazione in altitudine Corrente nominale fino a 1000 m sopra il livello del mare.

Declassamento della corrente di uscita (1%/100 m) da 1000 a 3000 m.

Non è consentito il funzionamento oltre i 3000 m.

Norme EMC per emissione e immunità EN 61800-3
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Specifica Valore

Immunità EMC per la sicurezza funzionale EN 61800-5-2 Allegato E

Grado di inquinamento secondo la norma
EN 60664-1

2

Categoria di sovratensione secondo la
norma EN/IEC 61800-5-1

III

O
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Illustrazione 159: Declassamento

11.11 Gradi di protezione

11.11.1 Gradi di protezione per servoazionamento ISD 510

e
3

0
b

e
7

2
4

.1
1

IM B5 IMV1 IMV3

Illustrazione 160: Posizioni di montaggio

Tabella 156: Gradi di protezione per servoazionamento ISD 510

Posizione di montaggio del servoazionamento (secondo la
norma DIN 42 950)

Classe IP (secondo la norma
EN 60529)

Alloggiamento Tutte le posizioni IP65/IP67

Albero senza anello di tenuta IM B5 e IM V1 IP54

IM V3 IP50

Albero con anello di tenuta IM B5 e IM V1 IP65

IM V3 IP60

N O T A

Installare e collegare i servoazionamenti ISD 510 come descritto nel presente manuale per ottenere i valori nominali descritti
nel dettaglio in Tabella 156 nell'applicazione finale.

I servoazionamenti ISD 510 sono certificati UL come componenti riconosciuti.
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11.11.2 Gradi di protezione per il servoazionamento DSD 510
Tutte le varianti DSD 510 hanno un grado di protezione IP65/IP67.

N O T A

Installare e collegare i servoazionamenti DSD 510 come descritto nel presente manuale per ottenere il grado di protezione
IP65/IP67 nell'applicazione finale.

I servoazionamenti DSD 510 sono certificati UL come componenti riconosciuti.

11.12 Cavi

N O T A

Per le dimensioni e i disegni dei cavi vedere la Guida alla Progettazione VLT® Servo Drive System ISD 510, DSD 510,
MSD 510 (VLT® Flexmotionô ).

11.12.1 Cavo ibrido PE

Tabella 157: Cavo ibrido PE

Componente Descrizione Sezione trasversale

Cavo ibrido PE Usato per collegare il cavo PE dal cavo ibrido alla vite PE sul modulo di accesso
decentralizzato (DAM 510).

Sezione trasversale massima:

2,5 mm2/4,0 mm2

11.13 Conservazione
Conservare i componenti del servosistema in un luogo asciutto, privo di polvere e con basse vibrazioni (veff ≦0,2 mm/s).

Il luogo di conservazione deve essere privo di gas corrosivi.

Evitare bruschi sbalzi di temperatura.

Conservazione a lungo termine
Per ricondizionare i condensatori elettrolitici, una volta all'anno i servoazionamenti e i componenti del sistema non in funzione van-
no collegati a una fonte di alimentazione per consentire ai condensatori di caricarsi e scaricarsi. In caso contrario, questi ultimi po-
trebbero subire danni permanenti.
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Glossario dei sistemi di servoazionamento VLT

A
ACM Modulo di condensatori ausiliari.

Albero motore Albero rotante sul lato A del servomotore, solitamente senza una scanala-
tura per linguetta.

Altitudine dell'installazione Altitudine dell'installazione sopra il livello del mare, solitamente associata a
un fattore di declassamento.

Automation Studioô Automation Studioô  è un marchio registrato di B&R. È l'ambiente di svilup-
po software integrato per i controllori B&R.

B
B&R Azienda multinazionale, specializzata in software e sistemi di automazione

di fabbrica e di processo per una vasta gamma di applicazioni industriali.

BeckhoffÆ BeckhoffÆ è un marchio registrato e concesso in licenza da Beckhoff Auto-
mation GmbH, Germania.

Blocco funzioni Le funzionalità del dispositivo sono accessibili tramite il software dell'am-
biente di progettazione.

Bus di campo Comunicazione bus tra controllore e asse servoassistito e moduli di sistema;
in generale tra il controllore e i nodi di campo.

C
CANopenÆ CANopenÆ è un marchio comunitario registrato di CAN in Automation e.V.

CE Marchio di certificazione e test europeo.

CIA DS 402 Profilo del dispositivo per i convertitori di frequenza e il controllo del movi-
mento. CIAÆ è un marchio comunitario registrato di CAN in Automation e.V.

Cavo di alimentazione Cavo di collegamento ibrido tra il modulo di accesso decentralizzato (DAM
510) e il servoazionamento ISD 510/DSD 510.

Cavo di loop Cavo di collegamento ibrido tra due servoazionamenti decentralizzati, con
due connettori M23.

Collegamento CC Ogni servoazionamento dispone di un proprio collegamento CC, costituito
da condensatori.

Connettore (M23) Connettore ibrido per servoazionamento.

Connettore M12 Connettore (X4) per il collegamento I/O e/o dell'encoder sul lato B della ver-
sione avanzata del servoazionamento ISD 510/DSD 510.

Connettori M23 Connettori (X1 e X2) per il collegamento dei cavi di alimentazione e dei cavi
di loop ibridi sul lato B della versione standard e avanzata del servoaziona-
mento ISD 510/DSD 510.

Connettori M8 Porta Ethernet in tempo reale (X3) completamente funzionale sul lato B del-
la versione avanzata del servoazionamento ISD 510/DSD 510. Connettore
(X5) per il collegamento dell'LCP al lato B della versione avanzata del ser-
voazionamento ISD 510/DSD 510.

Cuscinetti I cuscinetti a sfera del servomotore.

D
DAM Modulo di accesso decentralizzato

DSD Servoazionamento decentralizzato
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E
EPSG Ethernet POWERLINKÆ Standardization Group (Gruppo di standardizzazione

Ethernet POWERLINK).

ETG Gruppo di tecnologia EtherCATÆ

Encoder monogiro Descrive un encoder assoluto, in cui la posizione assoluta viene rilevata do-
po un giro.

Encoder multigiro Descrive un encoder assoluto, in cui la posizione assoluta viene rilevata do-
po diversi giri.

EtherCATÆ EtherCATÆ (Ethernet per Control Automation Technology) è un sistema bus
di campo aperto ad alte prestazioni basato su Ethernet. EtherCATÆ è un
marchio registrato e una tecnologia brevettata, con licenza concessa da
Beckhoff Automation GmbH, Germania.

Ethernet POWERLINKÆ Ethernet POWERLINKÆ è un protocollo deterministico in tempo reale per
Ethernet standard. Si tratta di un protocollo aperto gestito dall'Ethernet
POWERLINKÆ Standardization Group (EPSG). È stato introdotto dalla società
austriaca di automazione B&R nel 2001.

F
Fermo (servoazionamento) L'alimentazione è inserita, non sono presenti errori né comandi di movi-

mento attivi sull'asse.

Firmware Software nell'unità; funziona sulla scheda di controllo.

Flangia A Il lato A è il lato dell'albero del servomotore.

Forza assiale La forza in newton che agisce sull'asse del rotore nella direzione assiale.

Forza radiale Forza in newton che agisce a 90° sulla direzione longitudinale dell'asse ro-
tore.

Freno Freno di stazionamento meccanico sul servoazionamento.

I
IGBT Il transistor bipolare a gate isolato è un dispositivo a semiconduttore a tre

morsetti, utilizzato principalmente come interruttore elettronico per combi-
nare alta efficienza e rapida commutazione.

IRT Isochronous Real-Time (Isocrono in tempo reale)

ISD Integrated Servo Drive (Servoazionamento integrato)

L
LCP Pannello di controllo locale.

Lato B Il lato posteriore del servoazionamento con i connettori a spina e presa.

M
MSD Servoazionamento multiasse

Moduli di sistema Questo termine comprende il modulo di alimentazione (PSM 510), il modu-
lo di accesso decentralizzato (DAM 510) e il modulo opzionale di condensa-
tori ausiliari (ACM 510).

O
Oscilloscopio L'oscilloscopio fa parte del software DDS Toolbox e viene utilizzato per le

diagnosi. Consente di rappresentare i segnali interni.
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P
PELV La tensione bassissima protetta è una tensione di alimentazione elettrica in

un intervallo che comporta un basso rischio di scosse elettriche pericolose.

PLC Il controllore logico programmabile è un computer digitale utilizzato per
l'automazione di processi elettromeccanici, come il controllo dei macchinari
sulle catene di montaggio in fabbrica.

PLCopenÆ Il nome PLCopenÆ è un marchio registrato e, insieme ai loghi PLCopenÆ, è di
proprietà della società PLCopenÆ. PLCopenÆ è una società mondiale indi-
pendente dal rivenditore e dal prodotto, che definisce uno standard per la
programmazione del controllo industriale.

POU Unità organizzativa del programma (può essere un programma, un blocco
funzioni o una funzione).

PSM Modulo di alimentazione.

PWM Modulazione della larghezza degli impulsi.

R
RCCB Interruttore a corrente residua.

RT Real-time.

Raffreddamento I servoazionamenti decentralizzati sono raffreddati per convezione naturale
(senza ventilatori). Tutti i moduli di sistema, ad eccezione di DAM 510,
ACM 510 ed EXM 510, sono raffreddati da un ventilatore interno.

Resolver Il dispositivo di retroazione per servomotori, tipicamente con due tracce an-
alogiche (seno e coseno).

S
SIL 2 Sicurezza integrata di livello II.

SSI Interfaccia seriale sincrona.

STO Funzione Safe Torque Off. All'attivazione di STO, il servoazionamento ISD
510 non è più in grado di produrre coppia nel motore.

Servomotore ISD Indica il servomotore ISD (senza le parti elettriche del convertitore di fre-
quenza).

Set di serraggio Un dispositivo meccanico che, ad esempio, può essere utilizzato per fissare
gli ingranaggi su un albero motore.

Sicurezza (STO) Il circuito di sicurezza per servoazionamenti che disinserisce le tensioni dei
componenti del driver per gli IGBT.

Sistema di retroazione Il sistema di retroazione misura la posizione del rotore.

T
Temperatura ambiente La temperatura nelle immediate vicinanze del servosistema o del compo-

nente.

Tensione CC Tensione continua costante.

Tensione del collegamento CC Tensione CC condivisa da diversi servoazionamenti collegati in parallelo.

TwinCATÆ TwinCATÆ è un marchio registrato e concesso in licenza da Beckhoff Auto-
mation GmbH, Germania. È l'ambiente di sviluppo software integrato per i
controllori di Beckhoff.

U
UAUX L'alimentazione ausiliaria fornisce l'alimentazione alle parti elettriche di

controllo dei servoazionamenti ISD 510/DSD 510 e al modulo di alimenta-
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zione (PSM 510), al modulo di accesso decentralizzato (DAM 510) e al mod-
ulo di condensatori ausiliari (ACM 510).

V
VLTÆ Servo Toolbox Strumento software Danfoss per PC utilizzato per l'impostazione parametri

e la diagnostica dei sistemi VTLÆ Servo Drive

W
WiresharkÆ WiresharkÆ è un analizzatore di protocollo di rete rilasciato con licenza GNU

General Public versione 2.
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